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MOZART Overview

INSTALLATION

MOZART Client Installation

Specification Requirements
Version: 2019.116.2.0 and above

Component: MOZART Client

Domain Library: N/A

Overview
The installation tool MOZART Configurator for Client is changed to MOZART Client 
Installer. MOZART Client Installer is much easier to use for installing MOZART 
products.

Changes in folder and file structure
The installation files are now user-specific. The number of segmented package files 
are reduced and the installation process became simple by providing auto-run.

MDZ file structure
The installation files are provided for the following user groups:
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Developer : This install file for developers who use MOZART IDE, MMC, MOZART 
Studio. (i.e Developer_2019.116.2.zip)

Client.mdz : Mozart Studio + MMC

IDE.mdz : Mozart extension files

Non-Developer : This install file is for non-developer user who only requires 
MOZART Studio and MMC. (i.e Client_2019.116.2.zip)

Client.mdz : Mozart Studio + MMC

The install file is in a ZIP archive which contains an EXE extension file to initiate 
installation. To start the installation, run MozartClientExecute.exe  file as administartor 
from your PC.

Changes in the installation directory
The following table shows the installation directory of the components that are installed 
using Mozart Client Installer. (Based on x64 OS)
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Installation directory 

MDZ Installation Directory

Client(Studio,
MMC)

C:\Program Files (x86)\VMS\Client\Bin 

Client(LinqPad) %LocalAppdata%\LINQPad\Drivers\DataContext\4.6

Domain Library
C:\Program Files (x86)\VMS\Client\Bin (SeePlan DLL Files)
%ProgramData%\Mozart\FeatureExtensions (SeePlan vfe and vdz files)

IDE <Visual Studio installation folder>\Common7\IDE\Extensions\folder

How to Use
This section explains how to install/update/remove components using Mozart Client 
Installer.

Before you start
If you have MOZART product already installed to your PC, then they must be 
uninstalled first before proceeding the installation. If the following folder/file exist after 
uninstallation, please delete them manually

%APPDATA%\Mozart\IDE: Delete the folder that has vfe  as its folder name.
(Mandatory)

%ProgramData%\Mozart: Execution  folder including subdirectories, 
PackageBackups  folder

Registry: Delete all keys in 
\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\VMS\Mozart\Setup

Environment Variable: Delete MozartExe . (Mandatory)

%ProgramFiles(x86)%\VMS\Mozart: Delete Bin  and Updater  folder. Make sure 
to make backups for Targets  folder and engine DLL files before deleting Bin  
folder.

Use the following tool to clear out all install counts for MOZART DLL files. (The 
main reason DLL files are left after uninstallation). IF no data are found, then you 
are good to go.

Mozart Registry Cleaner

https://www.notion.so/Client-Studio-MMC-bfdfa396335f4f5bb35765d9604f8e65
https://www.notion.so/Client-LinqPad-d0b8af751b8c4ed1b7900f7df9ec006a
https://www.notion.so/Domain-Library-90837287490e45898742d5f9931c7209
https://www.notion.so/IDE-b37426bcd9764f5e9d67050ee75457e7
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For Developers
The reference path of the DLL in the project you are working needs to be changed. 
You can do this by removing the references and add new ones through Visual Studio. 
However, the following procedure is more convenient and faster.

1. Open notepad or any text editor. 

2. Open your project file(*.csproj) from the editor. 

3. Find <TargetFrameworkVersion> . If the value is "v4.0", then change it to "v4.6.1". 

4. Next, find <StartProgram> . If "Bin" is not a subdirectory of "Client", then add "Client" 
in front of "Bin" (i.e <StartProgram>C:\Program Files 
(x86)\VMS\Mozart\Client\Bin\APS_Studio.exe</StartProgram>) 

5. Find <HintPath> . If the path of the Mozart DLL files are either in %ProgramData%  
or "Bin" with no "Client" as parent, then change the path in all <HintPath>  to the 
new installation directory. The best way to do this is by entering Ctrl + H  from your 
keyboard in notepad and write the old path in Find what:  and the new path in 
Replace with: . Once all information is set, press [Replace All] to batch replace all 
the text. 

6. Save the changes and open the project from Visual Studio. Check the reference 
and see if Mozart references are showing properly.

Install from Auto-Run
1. Unzip Client_[Version].zip  if you are a non-developer user; otherwise, unzip 

Developer_[Version].zip  if you are a developer.

2. In case you require to install the domain library, move the domain library mdz file 
to the folder where MozartClientExecute.exe  is located. 

3. Run MozartClientExecute.exe  as administrator. If you are installing developer files, 
VSIX  installation intervents to install the Mozart extensions to Visual Studio. Click 
[Install] from VSIX  installer to proceed, then click [Close] when IDE installation 
finishes.

Once installation finishes, Mozart Client Installer opens to show the components 
installed.
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Install through Mozart Client Installer
1. Unzip Client_[Version].zip  if you are a non-developer user; otherwise, unzip 

Developer_[Version].zip  if you are a developer.

2. Go to Installer  folder and run MozartClientInstaller.Setup.msi . 

3. Click [Next] from [Welcome to the Mozart Configurator Client Setup Wizard] 
dialog to proceed to the next step.

4. Read the End-User Licens Agreement and check [I accept the terms in the 
Licens Agreement] to continue the installation. If you disagree with the terms, the 
installation will not proceed. After agreeing with the terms, click [Next] button to 
continue.

5. Configure the directory to install the update. Click [Change...] to change the 
directory from the default path. Otherwise, click [Next] button to move to the next 
step.

6. Click [Install] from [Ready to install Mozart Client Configurator] dialog to start 
the installation of MOZART Configurator for Client. 
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7. After install is complete, click [Finish] button to close the install wizard window 
and complete the installation process. If you want to run MOZART Configurator for 
Client after installation, check [Launch Configurator] before closing the wizard.

8. Run MozartClientInstaller.exe  from %mozart%\Installer to launch the installer. 

9. Click [Install] button on the top right side of the installer.

10. Select Client.[Version].mdz  file. This file should be always selected first since other 
packages cannot be selected if the components in Client.mdz is not installed. 

11. Click [Next], since the components in Client.mdz cannot be unselected. 

12. Click [Done] when installation finishes. 

13. Continue from step 9~12 to install additional mdz files. If IDE  is selected to be 
installed, VSIX  installation intervents to install the Mozart extensions to Visual 
Studio. Click [Install] from VSIX  installer to proceed, then click [Close] when IDE 
installation finishes.

If Mozart Client Installer is installed, you can skip step 8~9 by double-clicking the mdz 
file to install, which will automatically run Mozart Client Installer starting from step 11.

Uninstall
The installed components can only be uninstalled through Mozart Client Installer. 
Studio component has dependencies to rest of the components installed. Therefore, 
Studio component cannot be removed until there are no components left to be 
removed.

1. Close all running Mozart applications.  

2. Run MozartClientInstaller.exe  from %mozart%\Installer to launch the installer. 

3. Click [Install] button on the top right side of the installer. 

4. Select the component from the list to uninstall. Once selection is done, click [Next] 
to proceed with uninstallation. If IDE  is selected to uninstall, VSIX  installation 
intervents to remove Mozart extensions from Visual Studio. Click [Close] from 
VSIX  installer once IDE un installation finishes. 

5. Click [Done] when uninstallation finishes.

You can uninstall Mozart Client Installer from Control Panel>Program and Features .
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License Activation

If license of MOZART Studio or IDE wasn't certified, Mozart Product Activation 
Wizard window is activated to support the execution of license certification procedure. 
The current MOZART supports the following two methods for license activation.

1. License Activation through Activation code : User will request License 
Activation Code by sending basic information required for license issue through e-
mail. Then, VMS Solutions Co., Ltd. will issue an Activation code based on the 
license of your company. Activation code is manually entered in Activation Wizard 
for license activation. 

2. License Activation through Local License Service : If MOZART SERVER is 
installed inside of User's Organization, License of MOZART Studio can be 
automatically issued. But, MOZART IDE and MOZART SERVER can be activated 
by Activation code that is issued by VMS Solutions Co., Ltd.

License Activation through Activation code
1. When an option for Mozart product activation is selected, select "Request 

activation code by sending e-mail" and click [Next]. 

2. Enter LICENSE code of product that your company has purchased and user 
name. Then, click [Next].

3. Send the copied information to the displayed email address.

4. Activation code will be issued within a day after your request (Notice: Day will not 
count Saturday and Sunday.)

5. When you get an Activation Code, select "Enter the activation code that you 
received by e-mail" option from Mozart Product Activation Wizard and click [Next].

6. Paste the received Activation Code onto the window and click [Next].

7. If activation is normally processed, information of activation is displayed.
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8. Click [Finish] to finish.

License Activation through Local License Service
1. Select "Lease a license from Mozart License Server" option when an option for 

Mozart product activation needs to be selected. And click [Next].

2. Enter User Name.

3. Enter License Server address and click [Next]. Ask your company's manager for 
this address.

4. If activation is normally processed, information of activation is displayed.

5. Click [Finish] to finish.

GETTING STARTED

Hello World Example

n this example, you will create a MOZART project through MOZART IDE and display a 
simple string output (received by a parameter) in a log form on Console window of 
MOZART Studio that works as an environment for executing logics developed in 
MOZART. Through this process, users can learn about the composition of MOZART 
Project and MOZART Studio environment.

Create a Project
1. Select [File>New>Project ...] from the menu on Visual Studio. 

2. Select MOZART Template of Visual C# in [New Project] Dialog window. Enter a 
name and a path of the new Solution. Then, click [OK] button.
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3. Select a domain library to be used for the Project. Since no library is used in this 
example, just click [OK] button and go to the next step.
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4. Check whether MOZART Project is created in MOZART Explorer and if the same 
project is created in Solution Explorer of Visual Studio.

Configure Argument

1. Right click over project name displayed at top node of MOZART Explorer and 
select [ADD>VModel] menu. 

2. Enter “HelloModel” as a Model name and click [OK] button. Then, a VModel 
(‘HelloModel’) is created in Model Explorer.

3. Open the created VModel and double-click [Arguments>Input Args]. Then, a 
window to input argument will be activated. 

4. Enter “user-name” on Name and select ‘String’ as Type. Later this is used for 
creating an input variable which user’s name is entered during the execution.
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Writing Main function to display Log

1. Open Main Module in MOZART Explorer and expand the components in Main 
node. Then, redefine ‘Run’ function. 

2. Open pop-up menu by clicking the right-mouse-button on ‘Run’ node and select 
[Add Item].

3. Enter “HELLO_MYNAME” as the new Method name in Add FE Method window 
and click [OK] button. Then, “HELLO_MYNAME” function will be created.
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4. Write the following lines as below in the created function to display the log 
message.

Write a code for displaying a log message

public void HELLO_MYNAME(ModelContext context, ref bool handled) 
{ 
     string myname = InputMart.Instance.GlobalParameters.user_name ;  
     string msg = "Hello " + myname ; 
     Logger.MonitorInfo(msg); 
}

5. Save all written codes.

Execute Model
1. Start debugging by selecting [Debug>Debugging] from the menu of Visual Studio 

or pressing F5.

2. Wait until MOZART Studio is opened.

3. Double-click [Experiment > Experiment 1] from Experiment View pane and select 
[Argument] to input the value.

4. Input a value to the user-name column defined through Input Args and then press 
the [Run Experiment] button of the bottom left side of the window.
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5. Check if the string implemented in the Main function is displayed from the logs 
through Output pane.

Simple ETL Example

From this example, you will learn how to use Database, Input, Output, and Persist 
functions of MOZART Model in order to extract, transform, and load data from one DB 
from another. In addition, you will learn how to register/schedule a job using the 
generated DLL from the IDE and understand more about MOZART operation 
environment.
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Create a Project
1. Select [File>New>Project...] from the menu of Visual Studio. 

2. Select MOZART Template of Visual C# in [New Project] Dialog window. Enter a 
name and a path for the new Solution. Then press [OK] button.
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3. Select a domain library to be used for the Project. In this example, no library is 
used. So just click [OK] button.

4. Check whether MOZART Project is created in MOZART Explorer and if the same 
project is created in Solution Explorer of Visual Studio.

Register Database
1. Add a new VModel to develop the SimpleETL logics and registering DB. 

2. Right click over Project name displayed at the top node of MOZART Explorer and 
select [ADD>VModel] menu.
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3. Enter “SimpleETL” for the name of the Model and click [OK] button. Then, a 
VModel named as “SimpleETL” will be created in MOZART Explorer. 

4. Right click on top of Database node and select [New DataSource…] to include 
DB. Include two DBs, one for Source and the other for Target.
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5. A pop-up window should appear once [New DataSource...] is selected as 
mentioned through item 4. 

6. Input DB name in Name colunm and click [Add] to configure the DB connection.
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7. Enter the DB access information through Connection String or click […] button 
for the guided input.  

 
1) A new pop-up window Select database will be shown. Select database type 
and click [Create...] button to move on to the next step. 

 
2) Connection Properties will be shown. Enter the remaining information such as 
IP address, User, Password information.
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8. Repeat from step 4~7 to include Target DB.

Define Input & Output Schema
1. Right click on Inputs under the Model node and select [New DataGroup]. Name 

the DataGroup as "source" through the pop-up window. 

2. Repeat step 1 from Outputs node but name the DataGroup as "target". 

3. Once DataGroup is created, right click on the created data group and select [New 
DataItem...]. Name the Source Table(Table A) name as "ItemMaster".
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Example. Create Data Table and Data 

To follow the above procedure, the tables should be created to both Source/Target 
database. For this example the following tables are created temporarily on both 
databases. These variables could be changed at your convenience.

SOURCE DB

CREATE TABLE TBL_ITEM_MASTER 
( 
  ITEM_GROUP VARCHAR2(10) , 
  ITEM_ID   VARCHACR2(10), 
  ITEM_NAME VARCHAR2(30), 
  ITEM_PRICE NUMBER  
)

TARGET DB

CREATE TABLE TBL_ITEM_SELECTED 
( 
  ITEM_GROUP VARCHAR2(10) , 
  ITEM_ID   VARCHACR2(10), 
  ITEM_NAME VARCHAR2(30), 
  ITEM_PRICE NUMBER  
)
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4. Double-click on the created DataItem to view and edit the schema. 

5. If you click (아이콘삽입)icon, the created table's schema can be imported. Select a 
pre-registered data source and a table in order. Then you can choose columns to 
be imported. 

6. In this example, all records in ItemMaster table are required. Click [Select All] and 
[Finish] button to import all the records. Then, the same schema as the selected 
table should be created.

7. Repeat step 3 to create Target Tabl(Table B) from 'target' DataGroup. Name the 
DataItem for the target as "ItemSelected". Please note that 'target' should be 
selected from DataSource.
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8. Write a query to extract data from source data table. First, expand [ItemMaster] 
node and double-click [Default] to edit DataAction. 

9. Click the checkbox of Activate and select SourceDB as Data Source. Then, write a 
query. 

10. There are two ways to write a query. One way is typing the query directly and the 
other is by clicking [Query Builder] button to use a guide. 
 
1) If the button is clicked, a pop-up window opens. Select the query type from the 
Query Type Selection window.
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2) Once the query type is checked, click [OK]. A screen will be shown similar as 
seen through the Import process. Select the corresponding table and columns.

 
3) In this example, all columns in ItemMaster table are required. Click [Select 
All]>[Next]>[Finish] button in order to generate the query.

11. For DataItem in target table "ItemSelected", select TargetDB as DataSource and 
write Insert Query. Add a prefix "@" to input variables in the query and then click 
[Extract Parameters] to extract the input variables as parameters.
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12. Click Save All from the menu to complete Inputs/Ouputs setting.

Develop a Logic for Transforming & Loading Data
1. To open Input Persit Edit window, double-click Persist Config of Inputs node in 

Model. Refer to Input Data Persist Configuration to see how to use Input 
Persist. 

2. Expand Inputs tree and select the DataItem to add code to "On after load item" 
event. Check on the checkbox of "On after load item" and click (아이콘삽입)icon. 
Name the function through New Method window and click [OK]. 

3. Click(아이콘삽입)button to open the window to add the code for data 
transformation. 

4. First, add a code that does not show items with ITEM_PRICE less than 500,000.

Implementation of Filtering Logic

public bool OnAfterLoad_SourceItem(ItemMaster entity) 
{ 
    if (entity.ITEM_PRICE < 500000) 
        return false; 
    return true;

⚠ Warning 
If namespace error occurs from "ItemMaster"(or "ItemSelected"), add 
'using SimpleETL.Inputs(Outputs);' or 
'SimpleETL.Inputs.ItemMaster(ItemSelected)' to solve the problem.

5. To call a logic after all data is filtered, check on "Executing action" and generate 
Handler function to add code to sort the ITEM_PRICE in descending order.

 Implementation of Sorting Logic

public void OnAction_SourceItem(MOZART.Task.Execution.Persists.IPersistContext conte
xt) 
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{ 
    InputMart.Instance.ItemMaster.DefaultView.Sort = "ITEM_PRICE DESC"; 
}

6. Finally, add a code that saves the loaded data to Output (ItemSelected).

Implementation of Saving Output

public void OnAction_SourceItem(MOZART.Task.Execution.Persists.IPersistContext conte
xt) 
{ 
    InputMart.Instance.ItemMaster.DefaultView.Sort = "ITEM_PRICE DESC"; 
    foreach(ItemMaster it in InputMart.Instance.ItemMaster.DefaultView) 
    { 
        ItemSelected add = new ItemSelected() ; 
        add.ITEM_GROUP = it.ITEM_GROUP; 
        add.ITEM_ID = it.ITEM_ID; 
        add.ITEM_NAME = it.ITEM_NAME; 
        add.ITEM_PRICE = it.ITEM_PRICE; 
        OutputMart.Instance.ItemSelected.Add(add); 
    } 
}

7. Run the Model to open MOZART Studio and check if the results are shown 
properly.

Execute Model
1. Start debugging by selecting [Debug>Start Debugging] on menu of Visual Studio 

or pressing "F5". 

2. Wait until MOZART Studio is opened. 

3. To select a Model in MOZART Studio, select [File>Open Project] on MOZART 
Studio menu or click 

4. Once the Model is loaded. double click [nIput 
Data>DataGroup>DataItem(Table)]. Click [Query & Save to file] from the menu 
to load the Input Data.
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5. If Data is loaded without any problem, double-click [Experiments>Experiment 1] 
to open Experiment window. Then, click run button. 

6. During a experiment run, a log is written. At the end of the run, Result 0 folder is 
created as a node of Experiment 1. If Result 0 is expanded, Output folder (target) 
and DataItem (ItemSelected) is shown. As shown below, the data in Input Data 
have 76 results unsorted while the data in Output have 26 results and sorted in 
descending order with ITEM_PRICE below 500,000 not included.



MOZART IDE (ENG) 29

7. Check whether output data is inserted into DB without any problem by selecting 
[Project>Save Output to database...].
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8. [Additional Parameter] will window appear which allows you to add new 
Parameter Name & Value. 

9. In this example, no additional parameter is required. So just click [OK] without any 
input.
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10. While output data are inserted into the DB table, a log is shown through the pane 
at the bottom of MOZART Studio. When pop-message "Done" appears, click [OK] 
button.
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11. Check the results.

Create Server Job
Developed DLL is created into the [obj/Debug] folder with the same name as the 
project. Model is saved as "*.vModel" in [Generated] folder. In order to apply the 
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developed Model to a server, the two files (DLL & .vModel) have to be distributed to 
the target server and schedule jobs to run. But first, a shortcut to the target server 
needs to be created.

1. Start MOZART Management Console (MMC) and Click (아이콘삽입)icon to regsiter 
the server. Fill in the IP address and server admin password.

2. If access to server is successful, Tree nodes of server will be created. 

3. After Server registration is completed, the two files (DLL and *.vModel) needs to 
be distributed to the server. Create a shortcut folder to save the files to the server. 

4. Select the server and click (아이콘삽입) icon or press the right-mouse button to 
open [Add Shortcut] pop-up menu. 

5. When New Shortcut window appears, enter a Shortcut Name and select 
'workingDirectory\\' for Shortcut Directory by browsing the folder. Then, click [OK].
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6. A shortcut is created with the same name entered in the Server tree node. Double-
click the created shortcut and upload the target file into 'workkingDirectory\Bin' 
folder. If there is no 'Bin' folder, just create a new folder and name it as 'Bin'.
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7. Click on  (아이콘삽입)icon to open Upload Manager. 

8. By clikcing [Select Files] button in Upload Manager, you can select the target 
files to upload. Click [Upload] button to start uploading.

9. In the same way, upload VModel file into 'workingDirectory\Models' folders.  
 
Once the files are all uploaded, let us register the job.  
 
1. Double-click Jobs node of Server or click [Open] by pressing the right-mouse 
button on the node in Server Explorer pane of MMC. 
2. Inquire the job lists and click [Add] to include new jobs. 

+ Input Job name and type.
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+ Input Job Parameters
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Create a Server Run Schedule & Check Log
After Job registration is completed, create a trigger event to trigger the job from the 
server.

1. Double-click Triggers node of Server or click [Open] by pressing the right-mouse 
button on the node in Server Explorer pane of MMC. 

2. Inquire trigger list and click [Add] include new triggers. 
 

+ Input a name and condition for new trigger.

 
+ Configure a target for Trigger : select a pre-registered Job.
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Job parameters in the image above are automatically configured with the preset 
values of target jobs. If necessary, they can be modified. While execution, 
parameters defined in trigger have higher priority.

3. After all inputs are completed, check the server to see if there are job histories. 

4. To make a connection to a folder where logs are saved, add a shortcut to System 
Log folder [workingDirectory\Logs] in Server.
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5. app.log file in [workingDirectory/Logs/System] folder, have all the history of jobs 
registered in the server. The logs in app.log are generated in a daily basis. 

By double-clicking one of log files in the above window, the file will open. Then, 
you can check the system's processing log in the chronological order as below.
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6. Any operational logs other than app.log is created in the specified log folder, or in 
Logs folder (if not specified) whenever jobs are triggered. 
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These log files also can be read through Notepad.

MOZART IDE

OVERVIEW
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MOZART IDE Overview

MOZART IDE (Integrated Development Environment) is a development environment 
for developing and testing an executable module through MOZART library and 
operational environment. MOZART IDE is provided as an extension of MS Visual 
Studio. So this IDE requires Visual Studio 2010 Professional or higher version to be 
pre-installed. MOZART development project can access to implementation 
components and functions through MOZART Explorer. MOZART project's components 
are listed and explained as follows.

1. Model
Model is an information file that saves Input, Output data (schema), Query, and 
Configuration information, etc. Inputs & Outputs data are required to execute logic of 
MOZART development project and Query & Configuration information is used to 
transform a data into an object form used in executing a logic or to save output data to 
a file or database. Also Model includes information about arguments that can get 
values related to project's run configuration or option. Most of MOZART projects 
require various Input data from many different data sources. So these information can 
be consistently managed and modeled through a Model.

2. My Objects
As MOZART has to deal with large volume of data in a short time, it transforms data 
into Data Model and then loads the Data Model onto the memory that makes data 
more easy to be used to process logic. My Objects provides to define a new Data 
Model class or redefine Data Model in libraries if necessary for the Main Module & 
Execution Module.

3. My Methods
This function is provided to define methods processing logic used in both MOZART 
Main Module and Execution Module.

4. Main Module
Main Module provides functions to set up configuration information of each Execution 
Module developed by MOZART IDE and to run Execution Modules.
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5. Execution Module
Execution Module of MOZART IDE is included in MOZART Library. SeePlan Library 
basically provides Pegging & Simulation Modules that can compose MOZART-based 
Plan & Scheduling System. New Execution Module can be added through MOZART 
IDE, and new modules can be controlled by Main Module.

Feature Extension Concept

SEEPLAN Library has Simulation Model & Pegging Model to perform Production 
Planning & Scheduling for Manufacturing industry based on MOZART execution 
framework. Each of these Models is provided in the form of Library and consists of 
Core Layer and Control Layer.

Core Layer is a set of basic unit Models that composes Simulation and Pegging. Each 
unit Model has a designated role, so its function is defined to perform the role. The 
relationships and interaction methods among unit Models are defined for the Model's 
entire operation.

However, when a unit Model, which is a component of Core Layer, is actually 
implemented, its function can be operated in various ways and its interaction can be 
different according to its applied subject. For example, when RTD (Real Time 
Dispatcher) selects a lot out of WIPs according to the order of evaluated WIP priority, 
the equipment loads and processes the lot. Also if necessary, a setup is executed. If 
RTD or Equipment is a unit Model, its role and function will be the same. However, the 
matter of evaluating WIP priority, calculating processing time, judging setup is required 
or not, and configuring setup handling method, etc. can be different according to target 
of modeling.

By this property, MOZART Model Library provides Control Layer that can be used to 
redefine a function or interactions of main components of Core layer. As this layer is 
placed over Core Layer, Control logic can be implemented separately. So the key role 
of MOZART's Model-based development is the logic implementation on Control Layer. 
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Therefore, it is important for users to understand not only all operations of Simulation & 
Pegging but also Control Layer.

User can redefine functions or interaction at Feature Extension Action (FEAction), 
where the control points are exposed by Control Layer. FEActions are grouped 
together to compose Feature Extension Component (FEComponent) according to 
the target of Control or Similarity of logic.

The following figure explains the Structure of SEEPLAN library and concept of Module 
Project.

Developers can control components of Core Layer by implementing FEAction exposed 
by FEComponent in the library. Simulation & Pegging Model project provides not only 
a basic FE Model but also specialized Modeling components that are used to process 
Statistics or Event according to property of each Model.

Implementation of Module Based on Feature Extension
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Execution Module Library

MOZART Library provides two Execution Modules such as Pegging Module for 
Backward Planning and Simulation Module for Forward Planning. In order to build a 
Planning & Scheduling system, you can implement logic by adding MOZART’s two 
modules according to system’s purpose. Generally Factory level Planning or 
Scheduling decide a production target for each step (operation) and grasp work 
progress of each lot. Work & Production plan for each equipment are made through 
Simulation based on step production target to meet the Demand. The follwoing figure 
shows the composition and role of MOZART engine according to Planning Step.

Pegging Module
This is an executable module for implementing Pegging logics and provides Pegging 
Library and functions for editing Rules & Stages. This is triggered by Main module and 
executed before Simulation module. In other words, if both Pegging module and 
Simulation module are included in Project, Pegging module runs first.

Simulation Module
This is an execution module that provides Simulation Library and functions like 
collecting Statistics, managing Dispacthing Weight and handling user event. 
Simulation Module is also triggered by Main Module and executed after Pegging 
Module is executed.
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Add Execution Module
1. In order to add any Execution module, open a right-mouse-button menu on the 

parent node of MOZART Project. Then, click [Add > 'Pegging' Module or 
'Simulation' Module.]

2. Enter a module name and press [OK]. Then, a new module with the name is 
added in Project tree.
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3. The same module can be created multiple times.

4. If an execution module is added, a '.vxml' file with the same name as the module in 
MOZART Explorer is created in Solution Explorer. This file saves the module 
information. The module cannot be removed from MOZART Explorer. To remove a 
module from the project the '.vxml' file itself should be deleted. Once the file is 
deleted, you can see that the module no longer exists in MOZART Explorer.

User Interface

MOZART IDE is provided as a package form for Visual Studio, so MOZART IDE has 
windows layout like MS Visual Studio. Therefore, all project files, created by MOZART, 
can be checked through MS Visual Studio's Solution Explorer. However, you should 
use MOZART Project Explorer in order to use MOZART IDE's functions. To open 
MOZART Project Explorer, you may double-click .vxml file on Solution Explorer while a 
solution is open or use [MOZART/Project Explorer] on menu group at the top of IDE. 
MOZART Project Explorer also can be docked at any side of layout like other docking 
window of Visual Studio
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MOZART Project Explorer provides various functions such as Editing Model(VModel), 
Editing Custom Data class, Editing Custom Method, Developing Main Module, and 
Developing MOZART libaray-based Planning & Scheduling Module. Each function’s UI 
is shown at the pane where Code Editor of Visual Studio opens or is provided as a 
separate Dialog window

MOZART PROJECT

How to Create MOZART Project

If MOZART IDE is installed, you can create MOZART Project through Visual Studio.

1. Create new MOZART Project by selecting [File]>[New]>[Project].
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2. MOZART project is based on C#, so the templates could be found under Visual 
Studio C#>MOZART. You will see the templates available for each license.

3. Choose the template and press [OK]. Then you will see a pop-up message to 
choose the Domain Library. You may also set the prefix to be used as welll.
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4. Click [OK] to complete the project creation.

MOZART Project File Components

This section describes the types and the composition of files that are automatically 
created through MOZART IDE. Files for Modules comprsing a Project are normally 
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created in Project root folder and the files created automatically by Model 
Configuration are stored in [Root/Generated] folder.

Main module

File Name Description

./Main.vxml
This is a file for Main Module in Model Explorer. It saves configuration
contents and Main control's implementation. File Type is XML and each
item is saved as Main.vxml form.

./Generated/Main.0.cs

This file includes configuration information that is configured through
Main module and source that is automatically created for Main Control.
This is created when modified Model is saved or [Execute Tool] menu
is executed.

Model

File Name Description

./(Model Name).vxml

This is a file for MOZART Model that is included in Model Explorer.
All contents of Arguments, Input, Output, Database, and Persist
Config are saved in this file. File Type is XML and each item is saved
as Model.vxml form.

./Generated/(Model
Name).0.cs

This is a file that includes configuration of Argument and definition of
InputMart, OutputMart, and TempMart class. This file is automatically
created. When any Input, Output, or Arguments in Model is modified,
the file changes as well.

./Generated/(Model
name).Inputs.cs

This auto-created file defines the class for DataItem that is defined in
Model's Inputs. The file automatically updates when any item in
Inputs is changed.

./Generated/(Model
name).Persists.cs

This auto-created file defines the class for Persist Module. This class
reflects contents configured in Input, Output Persist Config.

./Generated/(Model
name).vModel

This file is not included in Project but saves Model information when
Model is published. This is updated when any modification of Model
is saved in Model Explorer or [Execute Tool] menu is executed.

./Logic/PersistInputs.cs

This file creates the linkage of Action events for each DataItem
declared in Input Config/Persist Config. By clicking icon, a header will
be created in PersistInputs file where users can specify the file
contents.

https://www.notion.so/Main-vxml-9bc20f64fc904fa49a8fcdcb1e316d9d
https://www.notion.so/Generated-Main-0-cs-adb95113660f458194aa4b92dfe6e140
https://www.notion.so/Model-Name-vxml-74c2bd71f6a44b838acb30fb12ce7f5d
https://www.notion.so/Generated-Model-Name-0-cs-a005eb3c6859463bb6a80d7199da565e
https://www.notion.so/Generated-Model-name-Inputs-cs-87f06d590d114e14b35956fa21675e61
https://www.notion.so/Generated-Model-name-Persists-cs-fb855723a9ae4c179cd29e57750c34c0
https://www.notion.so/Generated-Model-name-vModel-02cf499c356a4d3ab880fd894a42c74b
https://www.notion.so/Logic-PersistInputs-cs-1775ee318b1941d681790476515aa290
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File Name Description

./Logic/PersistOutputs.cs
This file creates the linkage of Action events for each DataItem
declared in Onput Config/Persist Config.

My Objects

File Name Description

./My Objects.vxml

This file saves information for My Object in MOZART Explorer. Saved
information includes not only Enums, Constants, but also Class and
View information of My Objects. File type is XML and each item is
saved as MyObject.vxml form.

./Generated/My
Objects.0.cs

This is an auto-created file for Enum, Constant, and Collection class of
My Object. These are defined in My Objects. This file is updated when a
Model is saved or [Execute Tool] menu is executed. .

./Generated/My
Objects.DataModel.cs

This is a file that Data Class defined in My Objects is automatically
saved to. This file is updated when a Model is saved or [Execute Tool]
menu is executed.

Simulation Module

File Name Description

./(Simulation module
name).vxml

This file saves information of Simulation Module in Model Explorer.
Configuration information of all items added to Simulation Module is
saved. File type is XML and each item is saved as Simulation.vxml
form.

./Generated/(Simulation
module name).0.cs

This file defines the class for Simulation execution and reflects any
modification in Simulation module. When [Simulation module
name].vxml file is saved, the file is automatically created and the file is
updated when [Execute Tool] menu is executed.

Pegging Module

File Name Description

https://www.notion.so/Logic-PersistOutputs-cs-c4060d626a2c4cd7b534806b5fc0df58
https://www.notion.so/My-Objects-vxml-ca87991158514c179990517f354c51db
https://www.notion.so/Generated-My-Objects-0-cs-c36e2199c453471397fcade21897a245
https://www.notion.so/Generated-My-Objects-DataModel-cs-8873da7b295041ada891dacfd6f6163d
https://www.notion.so/Simulation-module-name-vxml-067b15b7701a4ebe80f1fd45cc19a77c
https://www.notion.so/Generated-Simulation-module-name-0-cs-edf66a4bef2c4bb09d0093c72d77b4af
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File Name Description

./(Pegging module
name).vxml

This file saves information of Pegging Module in Model Explorer.
Configuration information of all items added to Pegging Module is saved.
File type is XML and each item is saved as Pegging.vxml form.

./Generated/(Pegging
module name).0.cs

This file defines the class for Pegging execution and reflects any
modification in Pegging module. When [Pegging module name].vxml file
is saved, the file is automatically created and the file is updated when
[Execute Tool] menu is executed.

VXML File Structure

This section explains the  storage structure of data for each vxml file. If XML 
document's keyword indicates group, collection, generally it defines Capacity property. 
This is configured as the number of items in the subordinate set or a multiple of 4. Item 
cannot be set to exceed the Capacity.

Model.vxml file 
<TargetDefinitioin> : Target information of Model.

<ArgumentArray> : Mode's Input Argument information is saved in this section.

<ctm:Argumentinfo-Array>

<ctm:ArgumentInfo> : Individual Argument information

<ConfigArray> : Model's Config Argument information is saved in this section.

<ctm:ArgumentInfo-Array>

<ctm:ArgumentInfo> : Individual Configuration variable information

<Inputs> : Input Data Section

<ItemArray>

<cdd:DataItem-Array>

<cdd:DataItem> : Stored Information for each DataItem

<cdd:MetaInfo> : Input dataitem information section

https://www.notion.so/Pegging-module-name-vxml-c3245313247a4226b2657c3739345b02
https://www.notion.so/Generated-Pegging-module-name-0-cs-ce460f5d002b41eaa968a3e2dcabc940
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<cdm:DataMetaInfo> : dataitem's metadata header

<cdm:Properties> : dataitem's property set section

<cdm:PropertyMeta> : Individual property information

<cdd:ActiveAction> : Active DataAction information

<cdd:DataAction> : DataAction information

<cdd:Actions> : Non Active but registered DataAction information 
section

<cdd:DataAction> : DataAction information

<Outputs> : Output Data Section. This has the same structure as Input.

<DataSource> : DB registeration information is saved

<Items>

<Entry> : One for each DataSource is created

<String>: DataSource's displayed name

<cdd:DataSource> : DataSource section

<cdd:Items> : Access string section

<cdd:DataSourceItem> : Access string information

<PersistInput> : Input Persist Config configuration information is saved.

<RootItem> : All Input Persist's configuration information is saved

<Config> : Config Argument's data source table configuration information is 
saved.

<Items> : GroupItem group Section

<GroupItem> : Persist Input Group's configuration information is saved.

<Items> : EntityItem group section

<EntityItem> : Individual DataItem's Persist Config configuration 
information is saved

<PersistOutput> : Output Persist Config configuration information is saved.

Main.vxml 
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<FMainMap> : name = "Main"

<Config> :

<FConfigEntity Name = "page name">

<ConfigValues>

<csd:Config class name> : Property configuration for each Config 
class

<Definitions> : Among user-defined Definition or pre-defined Definition, bound 
definition information is saved.

<FDefinitionCatory> : This is created in a unit of created file.

<FDefinitionEntity> : This is created for each defined Definition.

<Children> : Information of FECategory/FEComponent/FEAction having a defined 
Definition

<FActionCategory> : This is saved for each Category displayed in Model Tree

<FActionComponent> : This is saved for each Component in Category

<FActionEntry> : This is created only if Definition is added.

My Object 
<FDataClassRoot name = "My Objects">

<Constants>

<FConstantItem name = "Constants">

<ArgumentArray>

<ctm:ArgumentInfo-Array>

<ctm:AgrumentInfo> : Individual Constant information

<Enums>

<FDataClassFolder : name = "Enums">

<FDataClassItem IsEnum=true> : Data for each Enum item

<Content>

<DataClassMeta>
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<Properties>

<ctd:PropertyMeta> : Property information

<Children>

<FDataClassFolder> : My Objects' folder information

<Children>

<FDataClassItem> : Information for each DataClass in folder

<Content>

<DataClassMeta>

<Properties>

<ctd:PropertyMeta> : Property information

Simulation.vxml
<FActionMap InstanceName="XXX" Name="Simulation">

<Definitions> : Information about bound Definition among user-defined Definition 
or pre-defined Definition

<FDefinitionCategory>: Created in a file unit that is created

<FDefinitionEntry> : Created for each defined Definition

<Children> : Entry item is created for each Category or each Simulation 
subordinate function that comprises FEModel

<FActionCategory> : saved for each Category displayed in Model Tree

<FActionComponent> : Saved in a Component unit in Category

<FActionEntry> : Created only if Definition is added

<FCustomEntry Name = "Statistics"> : User-defined statistics storage section

<csd:StatSheetInstance> : User-defined statistics item information

<FCustomEntry Name = "Weights"> : User-defined Weight Factor Method 
storage section

<csd:WeightInstance> : User-defined Weight Factor Method information

<FCustomEntry Name = "CustomEvents"> : User-defined Event information



MOZART IDE (ENG) 57

<csd:CustomEventInstance> : User-defined Event item information

Pegging.vxml
<FActionMap InstanceName="XXX" Name="Pegging">

<Definitions> : Information about Bound definition among user-defined Definition 
or pre-defined Definition

<FDefinitionCategory>: unit of a created file

<FDefinitionEntry> : created for each defined Definition

<Children> : Entry item for each Category or each Simulation subordinate function 
that comprise FEModel

<FActionCategory> : Saved for each Category displayed in Model Tree

<FActionComponent> : Saved in Component unit within Category

<FActionEntry> : Created only if Definition is added

<FCustomEntry Name = "Rules">

<csd:PredefinedPegRule> : pre-defined Rule

<FActionEntry> : Created if Action that is defined in the corresponding 
Rule is implemented.

<csd:PegRuleInstance> : user-defined Rule

<FCustomEntry Name = "Models">

<FCustomEntry Name = "Stages">

<csd:PegStageInstance>

<FPredefinedReference> : In the case that user-defined Rule is added 
to Stage

<csd:PegRuleReference> : In the case that user-defined Rule is 
added

Definition Profiling
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Overview
Mozart IDE provides a profiling function to diagnose the performance of the default 
definition provided from SeePlan library and the user-defined definition (FEAction and 
My Methods).

Since Mozart IDE is and extension tool of Visual Studio, you may use the profiling tool 
provided from Visual Studio to diagnose performance. However, the profiler of Visual 
Studio analyzes the performance of all the codes within the project including the 
performance of the external calls which in result increases the time to diagnose the 
performance depending on the complexity and length of the codes.

In case of Mozart project, the logic is implemented to the methods provided from the 
modules(Pegging, Simulation, CBS, etc) included in the project, so it would not be 
necessary to get the performance diagnosis of the entire project.  The profiler of 
Mozart IDE diagnoses the performance of the definitions of the modules included in 
the project, and the user-definition in My Methods when specified.

Profiling Class Structure
The class that collects and manages the profiles of the definition is 
Mozart.Task.Execution.Performance.FunctionProfiler. The followings are the essential 
members of the FunctionProfiler  class.

EnablingProfiling Property
Indicates whether to enable profiling.

public static void EnableProfiling {get; set;}

Property Value

Performs diagnosis when true.

OnEntry(string) Method
The entry point of the performance diagnosis of the specified method.
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public static void OnEntry(string name)

Parameters
name

Data Type: string

Definition: The name of the method to start the performance diagnosis.

OnExit(string) Method

public static void OnExit(string name)

Parameters
name

Data Type: string

Definition: The name of the method to end the performance diagnosis.

Report Method
Returns the converted string of the profiling results of the specified methods.

Returns

The converted string of the profiling results of the specified methods.

Example

The following example prints out the profiling result of the default definitions and the 
definition implemented through My Methods.

using Mozart.Task.Execution.Performance;  
 
public void SHUTDOWN0(ModelTask task, ref bool handled) 
{ 
    Logger.MonitorInfo(FunctionProfiler.Report()); 
}
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When the code above is implemented to Shutdown FEAction which is the point where 
model execution completes, the profile results of all the target methods will be shown 
through the log window of Mozart Studio. For this sample the code was written in 
Shutdown but you can the same results when written through OnDone  FEAction.

How to Use
The following steps show how to use the profile function from Mozart IDE.

1. Double click [Arguments] > [Input Args] from Mozart Explorer to open input 
arguments editor window.

2.  Add the following argument which indicates whether to enable profiling. The name 
of following argument is a fixed name.

Name: enableFunctionProfiling

Type: Boolean
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3. Next, enable the function to generate the profiling entry/exit codes to the 
definitions. To enable the function select [Generate Profiler Code] from the 
context menu in Mozart Explorer.

The entry/exit code for profiling is generated to all the methods in the module cs 
files when Generate Profile code is enabled. In addition, the code whether to 
perform profiling depending on the value given from the input argument is 
generated as well.
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The profiling performs when enableFunctionProfiling  is true . As long as Generate 
Profiler code is enabled, any new default definition or method added to the 
FEAction, the entry/exit and EnableProfiling  code is generated automatically to the 
cs file.

How to Perform Diagnosis for Methods in Persists and My 
Methods
It is possible to diagnose performance for OnAfterLoad , OnAction  methods in Persists 
and the methods defined through MyMethods. The following steps are the instructions 
on how to get profiles for those methods.

1. Follow the steps 1~3 as described in How to Use.

2.  Add the code for profiling entry/exit to the method for profiling. The following is an 
example.

public void TEMP_METHOD() 
 { 
     if (FunctionProfiler.EnableProfiling) 
     { 
         FunctionProfiler.OnEntry("TEMP_METHOD") 
     } 
      
     //Your code for this method... 
      
     if (FunctionProfiler.EnableProfiling) 
     { 
         FunctionProfiler.OnExit("TEMP_METHOD") 
     } 
 }

https://www.notion.so/f0baf526ddf0490fb4832ca979564d58#a0a64613c99b4678b574ec528f2d2265
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Once the required code is added to the method, the profiling results for the method will 
be created. The profiling result adds to the model execution log file automatically. The 
location of the model execution log file is located in the user specified path or the 
default path C:\Logs.

Name: Name of the method

Calls: The number of call counts of the specified method

Mean sec: The average run time for each call of the method

Total sec: The cumulated run time for each call of the method

MODEL
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Model Overview & User Guide

Concept of Model
A Model is an information file that includes Input & Output data (schema) and Query & 
Configuration information, etc. Inputs & Outputs data are required for executing logic in 
MOZART project and Query & Configuration information is used to transform data into 
an object form for easy processing of a logic or to save an output data to a file or 
database. This also includes Argument information that receives values deciding a 
method or options about how to work on a project. Most projects developed in 
MOZART IDE use various Input data from many different Data sources and these data 
can be consistently managed and designed through Model.

Multiple Models can be created in a single MOZART project. It is possible to create 
and use a child Model that inherits contents of the first created Model. Refer to Multi 
Model Project for more information.

Components of Model
Arguments : Defines the execution option and setups of the logic to use in the 
Model. There are two kinds of Arguments: Input Argument and Config Argument.

Database : This provides a function to manage a string for accessing to all data in 
the Project. The registered Data source can be used as a configuration value for 
Data source property when Schema and DataAction is edited.

Inputs : This defines Input Data Schema and DataAction of Task. It also defines 
the order and method for input data loading.

Outputs : This defines Output data schema for Task. It also defines the order and 
method for saving output data. Outputs are basically saved in a file. However, 
outputs can be saved into Database through option setting and query.

Add a Model to Project
Add a Model in a newly created Project as follows..
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1. Select Top node of Model Explorer.

2. Open pop-up menu by clicking right-mouse-button.

3. Select Add>VModel.

4. When a Dialog opens, enter a name for the Model.

5. Check whether a Model with the entered name is created or not in Model Explorer.

Edit Model Information
Model information is saved as file using '.vmodel' extension and includes information 
about Model components and properties. TASK(Dll file) developed in MOZART IDE 
can only be executed when it is linked to the Model. Therefore, Model contains relation 
information of Model and dll file, environmental configuration for Model execution, etc. 
In order to read and edit this information, please refer the following procedure.
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1. Select Model node and click right-mouse button to open a pop-up menu. Then, 
select [Edit Vinfo] (this menu item is for editing Model information) to open the 
following window.

2. Edit any required item and save them. Explanation of each item are listed as 
below.

Category : Type of Model. Default value follows the Site Prefix of when a 
Project is created.

Title : Name of Model.

Guid : GUID of Model. This is an ID used to distinguish Tasks (Job Types) 
based on Model. If necessary, you can recreate this ID by clicking the 'browse' 
button on the right side.

Assembly : Name of DLL used to operate a Model. Click a button on the right 
side to designate a specific Dll file. .

Configuration File : Configuration file for executing the Model. Use the button 
on the right side to browse the file. The file can be directly entered.

Private Path : Name of the folder where the target Assembly file (DLL) for 
execution is stored. You can manually designate the corresponding file by 
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clicking the button on the right side. Or you can click Sync to project on the 
bottom side in order to set the path to "bin/Debug" of MOZART Project which 
includes the Model.

Description : Description of Model.

3. This configuration information is saved to a Model file (.vModel) and if it is 
required, only a specific information can be exported to a file. Select [Export 
VInfo] on pop-up menu.

4. Select a folder to store the file. The file will be created and saved as 'Model 
Name.vinfo'.

5. VInfo file includes Model information indicated on the above and is required to add 
user-defined User Interface to MOZART Studio in the future. The next figure 
shows the contents inside the file.

The contents of VInfo file

<target guid="7db113e2-1e7d-493a-8b2b-be22dd1b13ae" category="Site" title="VMS.FP_Planni
ng"> 
  <path configurationFile="" privatePath="D:\MOZART\VMS.FP_Planning\VMS.FP_Planning\bin
\Debug" /> 
  <type assemblyName="VMS.FP_Planning" typeName="" /> 
  <description /> 
</target>

Export/Import Model
In case a new project have similar functions as the existing one, you can copy the 
previously defined Models using Import/Export.

Export
1. Place the mouse cursor to the Model to be exported and then click right button and 

choose [Export VModel] from the menu.
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2. Select a folder to save the Model.

Import
1. Add an empty Model to the new project.

2. Place the mouse cursor to the target Model and then click right button and choose  
[Import VModel] from the menu.

3. Select the exported '.vmodel' file.

4. You can see that Model information is customized to the new project and all the 
data from the exported Model are also created to the new one.
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Arguments Management

Arguments define options and configuration values used in executing logic of Model. 
MOZART's Arguments can be divided into two types according to their purpose.

Input Arguments
Input Arguments are received through input parameters when Tasks are executed. So 
they define arguments that are used as the same parameter values regardless of 
context used in whole execution of Module. Mainly it defines parameters about logic 
execution options. For example, it is used to configure an option value deciding 
whether 'Equipment PM Schedule' or 'Yield' to be applied or not. Input Argument can 
be configured while configuring MOZART Studio's Experiment or while registering 
Server Job & Trigger.

For Input Arguments, you can control how to run a Model by registering pre-defined 
Arguments. (Reference:  System Argument)

Basic Configuration of Argument

Arguments are configured in the following procedure.

1. Select a Model registered in MOZART Explorer.

2. Expand Arguments node into two child nodes : Input Args & Config Args. Then, 
select and double-click Args that needs to be registered.

3. Arguments registration window appears. Then, enter a value to be registered for 
each cell of grid.

Category : This defines Argument Group. In MOZART Studio or MMC's 
Job/Trigger Registration window, Arguments are displayed as a group 
classified by Category.
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Name : Name of Argument

Caption : Name of Argument displayed in MOZART Studio.

Type : Type of Argument data

CollectionType : Argument can be created as Collective variables. The 
available types are listed as List, Set and Dictionary. Dictionary's Key is 
defined in the form of string.

InitialValue : Default Value of Argument

ValueRange : If Argument's value should be within a specific range, an 
information about the range is entered. The range's values are displayed in 
combobox form when parameters in MOZART Studio or MMC are entered and 
a value can be selected. If data input looks like the following figure, you can 
see Arguments' list in Experiment>Argument window of MOZART Studio and 
select one from the list.

Description : Description of Argument 

[Example of Arguments Input]

[Example of Experiment/Argument window of MOZART Studio]
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4. Save input values. (Press Ctrl+S or use Save button on the top menu of Visual 
Studio)

5. If input/modification of Argument is made, Arguments in Model Explorer are 
displayed with check mark. Then, focus on Model Explorer and press the save 
button to save the Model with modified Arguments.

6. If Model is saved normally, Arguments can be used through InputMarts.

How to refer Input value of Argument
Argument's input value can be used through InputMart. Input Argument is referred 
through GlobalParameter of InputMart and Config Argument is referred through 
ConfigParameter. See the following example source code as a reference.

Reference to Value of Argument

// If SourceFolder, DestinationFolder are defined as Input Arguments 
// they can be refered to like the following. 
string source = InputMart.Instance.GlobalParameters.SourceFolder ;  
string destination = InputMart.Instance.GlobalParameters.DestinationFolder ; 
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Config Arguments
Config Arguments are similar to Input Arguments. But they are used mainly in the case 
that arguments change according to context during Module execution. For example, a 
transfer time among steps or a Setup can be dealt with by Input Argument. But, if 
transfering times among steps for each Line are different or Setup time should be 
configured dependent on Equipment group, Config Arguments should be used. The 
value in Config Arguments creates Input Data and links it for usage. (Refer to How to 
use Config Argument)

How To Refer Config Arguments
The input value of Arguments can be used through InputMart. Config Argument is 
referred through GetConfigParameters of InputMart. 
See the example source code as a reference.

Referring Config Arguments

// Define McGrpSetupTime from Config Arguments 
// If the Config values are "EQPEGRP1,60 ; EQPGRP2,45" 
ConfigParameters conf = InputMart.Instance.GetConfigParameters(string.Empty); 
string[] grps = conf.mcGrpSetTimes.Split(';');

System Arguments

sTask and Model created in MOZART Project are executed by ModelTask of MOZART 
engine. System Arguments are arguments that is pre-defined to adjust execution 
options of ModelTask. Developers can use a default setting for execution options by 
designating pre-defined System Argument when they configure Input Argument of 
Model. The following table describes the pre-defined System Arguments.

Basic Arguments 
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Argument
Name

Argument Description
Data

Type
Argument

Name
Argument Description

Data
Type

Model name of Model file (full name including the path to the file) string

#experiment name of experiment that creates results of Model execution string

versionNo
name of Model version (default format is {model-name}-
{yyyyMMdd-HHmmss})

string

model-name if there is no versionNo, this is used instead string

start-time Start time of Task (simulation clock) DateTime

end-time End time of Task (simulation clock) DateTime

period Plan & Schedule period float

period-unit unit for period configuration (default is day) string

#start-
time.AdjustMinutes

an input variable that is used to adjust Job start-time with the
corresponding time length

int

#model-file
Full Path to Model file. This path includes name of an
executable Model

string

#model-dll Full Path to Dll that executes a Model string

#model-config Full Path to Config file of a Model string

Data download/upload Option Arguments 

Argument Name Argument Description Data
Type

#overwrite_result Decision of whether a result is overwritten or not bool

#useDatabase Decision of whether a database is read or not bool

#saveDatabase Decision of whether output data is written to a database or not bool

#db-To-file
Decision of whether only database sync is executed without
simulation run (default is false)

bool

#db-includes
File name of list of tables that are objects for Input data sync.
Only the corresponding tables are synchronized

string

#db-excludes
File name of list of tables that are not objects for Input data sync.
The corresponding tables are not synchronized. If there is the
same value in #daction_includes, executable is not reflected.

string

#daction_excludes
List of tables whose DataAction is not executed after a
simulation run. Comma is used as delimiter.

string

https://www.notion.so/Model-0542bb6f09c1455aa823fefd773882f6
https://www.notion.so/experiment-ab8e1416810d40e88c085b4746391e2e
https://www.notion.so/versionNo-f92b0018ddf34c64882c8ed5fcf5d8b0
https://www.notion.so/model-name-9187f86bc6f746c59ba44d1313afdf6a
https://www.notion.so/start-time-d670963e42824d99a865fd2adc98a87f
https://www.notion.so/end-time-a896cb97507c46f6aa8506d60ffe32e8
https://www.notion.so/period-78d637786dc64c7eabb8b8f012f9064e
https://www.notion.so/period-unit-580ee2e9a98b4e0891f7055e29340428
https://www.notion.so/start-time-AdjustMinutes-025c8511da5a476999f6a0190dc3a61f
https://www.notion.so/model-file-3f2d43bd72184da789d1051f5b3ba037
https://www.notion.so/model-dll-435dd1fe6a0b4d0e8ff7a7eac69a477b
https://www.notion.so/model-config-39e7c0dcc5884b118a1be215e1e54ec8
https://www.notion.so/overwrite_result-001156c399304aea80cb89f272ffd24f
https://www.notion.so/useDatabase-70b01f10f13f48d9a9651812f7e2c7af
https://www.notion.so/saveDatabase-3cdeec1cf4d84c6c8bd57b30bd1f94e3
https://www.notion.so/db-To-file-e2639fb2f4e84811b00de2a12d5a9a8d
https://www.notion.so/db-includes-3c276c5bf4af4d5ba7b4281c1eb211b9
https://www.notion.so/db-excludes-d5101e75f0924dbeac0e2ba5131dc14f
https://www.notion.so/daction_excludes-a90ac1de0a0946da81192643a1d029cf
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Argument Name Argument Description Data
Type

#daction_includes
List of tables whose DataAction is executed after simulation run.
Comma is used as delimiter.

string

#daction_excludes/in
List of Input Schema's DataActions that are excluded from their
execution in the beginning of simulation. Comma is used as
delimiter

string

#daction_includes/in
List of Input Schema's DataActions that are going to be executed
in the beginning of simulation. Comma is used as delimiter.

string

Run Arguments 

Argument
Name

Argument Description Data
Type

#more-
runs

the number of Model's repeated executions int

#more-
config-
[runindex]

an xml file that saves configured values of arguments for each repetition. If
any argument is not configured in Config file for the current repetition, it
uses a value of the previous repetition. If data for previous execution still
remains in memory when new data is being loaded, this can cause an error.
So if moreRun is used, DataMart should be reset after moreRun's result is
written.

string

Zip Model Arguments
This argument is used to configure a rule to make a compressed Model file after a 
Model is executed.

Zip Model Arguments

Argument Name Argument Description Data
Type

#zip
Decision of whether a Model is compressed into a file or not.
This is reflected with priority

bool

https://www.notion.so/daction_includes-9fafe91680404f22b29fdfd7ed545443
https://www.notion.so/daction_excludes-in-fb6278ceea8e4d909cb7de3675b90259
https://www.notion.so/daction_includes-in-9127e3594a5a4933983810625d23f76e
https://www.notion.so/more-runs-b30d027fffca4f908a85a63b75c3aa8a
https://www.notion.so/more-config-runindex-106c364fdb5540878c79702fc7fd2d9e
https://www.notion.so/zip-f5a892accf1e4fbda49797fbeb60f928
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Argument Name Argument Description Data
Type

#zip.FileNameTempate

Template for saving the name of compressed file. The default
template is "${Model_name}_${zip_now}${zip_postfix}" The
followings are usable keywords. • ${Model_name} : name of
Model • ${now} : time when compression is executed
(DateTime) • ${zip_now} : time string used by template (format
: yyyyMMddHHmmss) • ${zip_postfix} : suffix that is used at
the end of the configured name of compressed file •
${version_no} : Model version number

string

#zip.FileNamePostfix
Suffix that is used at the end of the configured name of
compressed file

string

#zip.Path
Path to the location where the compressed file is created. if not
designated, the file is created in the location of Model file

string

#zip.UpdateToRecent

Decision of whether the recently-compressed file is updated or
not. If true, a new compressed file overwirtes the latest
compressed file. If #zip.FileNameTemplate begins with the
naming format like yyyyMM, the new compressed file will have
the name of the same year and month with the latest
compressed file.

bool

Configuring Config Arguments

Defining Config Arguments has the same method as entering Input Argument. 
However, Config has to refer to master information, that has been managed by user 
group, more often. So actual argument values are managed with Input DataItem and 
the corresponding DataItem's values are automatically allocated to Config Argument at 
their configuration execution. See the following figure for details.

https://www.notion.so/zip-FileNameTempate-ab36c418a14b4704ad22889d277f7eb9
https://www.notion.so/zip-FileNamePostfix-3394188c0f5f4397af7b764cd0db0798
https://www.notion.so/zip-Path-1b7e3edad64141bfb810a0470769e450
https://www.notion.so/zip-UpdateToRecent-c8f90435113d46bca7dd62f6ad0e8660
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How to Define & Use Config Argument on Development Phase
1. Create DataItem to store Config Data through Inputs (See example image below).

2. Define Config Argument that is going to be used in System
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3. Set DataItem and Column mapping information in order to allocate Config 
Arguments automatically.

💡 Note 
Set the options for Config Data Table value and Mapping Field so the 
Config Argument values could be stored at the beginning of execution.

Config Type : Select a data table for Config Argument among Input dataitems 
as follows.

Group : This is used to group input DataItem data for necessary cause. In 
order to manage the data as a group, set Group to the corresponding column 
when DataItem's value is configured. One of the selected Config Type's 
columns can be chosen. This setting is not mandatory.

Key : A column that is mapped on Name property of Config Argument. This is 
selected from columns of tables that is configured in Config Type.

Value : A column that is mapped on value of Config Argument. This is 
selected from columns of tables that is configured in Config Type.



MOZART IDE (ENG) 78

4. A logic is implemented with configured Config Arguments. The following shows an 
example code.

Example of Config Argument Use

// A coding example. 
// Different setup time is applied to dependent on equipment group 
// When config4 is set to Config Arugment that defines a setup time for each equipment 
public Time GETSETUPTIME(MOZART.SeePlan.Simulation.AoEquipment aeqp, IHandlingBatch hb,
 ref bool handled, Time prevReturnValue) 
{ 
    ConfigParameters confs = InputMart.Instance.GetConfigParameters(string.Empty); 
    string[] grps = confs.config4.Split(';'); 
  
    Time def = Time.FromMinutes(10); 
    Time setup = Time.MinValue; 
    foreach (string grp in grps) 
    { 
        string[] setupTime = grp.Split(':'); 
        if (aeqp.EqpID == setupTime[0]) 
        { 
            setup = Time.FromMinutes(Convert.ToInt32(setupTime[1])); 
            break; 
        } 
    } 
  
    if (setup == Time.MinValue) 
    setup = def; 
  
    return setup; 
}

Checking on Execution Phase
1. Check data that is used as config information in MOZART Studio. If DataAction is 

included to synchronize the data from DB, use [Query & Save to file] menu to 
extract the data.
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2. If the settings are done as above, the values will be automatically assigned to 
Config name variables of the Config Parameters and these values could be 
directly referred as shown in the example code, Example of Config Arguments. 
The following figure shows the status of values assigned to the corresponding 
confs variables during Debugging.

3. In case you want to manage Config individually from a certain Group, select a 
Group Mapping Column from Config Arguments option and then select the Group 
to set the variables. See the image below for example.
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Get Config Argument for each Group

// To get whole Config Argument 
ConfigParameters confs = InputMart.Instance.GetConfigParameters(string.Empty); 
// To get Config Argument for a specific group, See the following example. 
// The following shows a configuration code example that only data with CONFIG_GROUP 
= "test1" are retrieved from config table. 
ConfigParameters confs = InputMart.Instance.GetConfigParameters("test1");

4. If a specific group is configured as shown in the code above, the result value is 
changed so the value in config4  is set to null.

Data Source Management

This function is for registering and managing data source that can be used in MOZART 
Project. Once a Data Source is registered, it is used to define Input/Output data and 
create DataAction. MOZART's Data Source can include multiple access string 
information and the first string is executed for data access. If necessary, a specific data 
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source can be designated through data soucre's access string name written within a 
program code.

How To Manage Data Source

1. Select a Database node in MOZART Explorer

2. Select [New DataSource ... ] on right-mouse-button pop-up menu.

3. After a Data source name is entered on Edit Data Source dialog, click [Add] 
button to register access string.

4. After entering a data source name on Data Source dialog, choose a target Data 
Provider in Data Provider combobox.

💡 Note 
MOZART supports 4 types of Data providers which are Microsoft 
Access, Microsoft SQL Server, Oracle, and DB2

5. Enter a data access string. This string can be directly entered into text box at the 
bottom of dialog window or you can activate an input window for each data source 
by clicking [...] button.

When [...] button is clicked, a dialog "Select database" will appear. In "Select a 
database" combobox, -registered database can be selected. If a new 
database is added, select [New Database Connection].

To Add a new database, select a database type from "Select a database type" 
combobox at the bottom and click [Create...] button.

If access information is entered through input window for each database type, 
the corresponding data source is added.

6. When access strings are registered, all registered access strings are displayed on 
the list at the bottom of Data Source dialog.

7. In order to delete an access string, select the corresponding access string and 
click [Remove] button.

8. In order to edit an access string, double-click the corresponding access string or 
click [Edit] button while the string has been selected.
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9. If there are multiple strings in Data Source but no specified configuration applied, 
the first string is applied as default. If you want to apply other string, use [Up][Dn] 
buttons to change their order.

Data Item Management

Mozart is a tool for developing Planning & Scheduling system in manufacturing 
industry. Its main job is to implement a logic processing and handling a large amount 
of complicated data of the system. Mozart's Input modeling tool supports easy 
processing of Input data in developing these kinds of logic. Mozart Inputs consist of 
DataItem and Persist Configuration that is used to load DataItems and it is possible to 
only define one of them. Also various Outputs can be created as a result by a logic 
implemented through MOZART Project. Mozart's Output modeling tool provides 
functions to define and refer to these outputs easily. So a series of procedures that 
saves the output into files or Database can be easily processed with this tool. Outputs 
are recorded through three phases which are defining Output Data, writing data values 
into the corresponding Output Data when model is executed, and finally saving the 
data. Output Data can be defined in the same method as Input Data Item is defined.

Creating/Editing DataItem
The defined Input DataItem is loaded to the memory during RunTime and is used as 
Input data for logic implementation. At this moment, it is possible to use data as the 
format of DAO (Data Access Object) based on defined Schema or to use data saved 
as a format of pre-defined DMO (Data Manipulation Object) that is made by processing 
the corresponding data when it is loaded. On the other hand, saving Output DataItem 
automatically creates DAO class and is registered as EntityTable in Project's 
OutputMart so this makes it possible to refer to Output Data with any programming 
code during Logic development. If Output DataItem, that is referred by the execution 
code, is updated to the corresponding output and the desirable data is created in 
Memory. In MOZART IDE, Inputs can define and adjust data loading procedure, 
method, and function with respect to Input DataItem through [Persist Config / Input 
Config] menu. Outputs can configure and execute a series of procedures that write 
Output Data in Memory into the final Data storage like File, DB through [Persist 
Config / Output Config] menu.
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Defining Input Persist Configuration

Defining Output Persist Configuration

Create/Edit Data Item

DataItem consists of Data Schema and DataAction. DataAction is a set of Queries that 
are used to fill data into a file of the corresponding Data Schema or save data of the 
corresponding Schema into outside Database. In Mozart, a concept called as 
"DataAction" is used to manage Queries.

Both Input and Output use DataItem with the same structure. Schema and DataAction 
have a relationship of 1:N. That is, a single DataItem can consist of one Schema and 
more than one DataActions. If Output isn't required to be saved into Database, only 
Schema can be created without any DataAction. DataAction also can have multiple 
Queries (Commands) and these Queries are consecutively executed in the registered 
order. So if data in a specific table should be deleted before new input is executed, a 
single DataAction consists of one Delete Command and Insert Command that are 
consecutively executed.

Editing Schema

Editing DataAction

DataItem Import/Export

You can export and import the DataItem information from Mozart IDE or Mozart Studio. 
This function is useful when you want to add a DataItem to an existing model to run a 
test for the new schema before applying it to the actual operation.  In addition, you can 
simply add a DataItem to your project by exporting the DataItem from another project 
so you do not need to define the schema. 

DataItem Import/Export Highlights
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File Extension 
The file extension of the DataItem information exported from Mozart IDE and Mozart 
Studio are as follows: 

Individual DataItem file: vditem 

Input or Output DataItem set: vditems 

💡 Note 
The file extension of DataItem for Mozart IDE and Mozart Studio is unified 
as vditem from 2021.119.1 version. If you are using a version below 
2021.119.1, you can import the DataItem exported from Mozart IDE to 
Mozart Studio by changing the file extension from vditem to vdinfo. 

Context Menu 
The DataItem import and export command can be found from the context menu of the 
selected DataItem. The given commands are different depending on whether DataItem 
or DataGroup is chosen. 

Import, Export > [DataItem(N)...]: Imports or Exports one or more DataItems. 
(vditem)

Import, Export > [DataItems...]: Imports or Exports the entire Input or Output 
where the selected DataGroup belongs to. 

Exported/Imported Information 
The following information will be exported or imported from the DataItem. 

Schema information of the DataItem 

DataAction script and settings 

You can export/import DataSource from the DataSource context menu. 

DataItem Export Example

Exporting Single DataItem 
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Exporting Multiple DataItems 
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Exporting Vditems  

DataItem Import Example 

Importing Single & Multiple DataItem(s) 
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Importing Vditems 
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To learn how to import the DataItem from Mozart IDE to Mozart Studio, see DataItem 
Import/Export. 

DataItem Import/Export (Studio)

You can export and import the DataItem information from Mozart IDE or Mozart Studio. 
This function is useful when you want to add a DataItem to an existing model to run a 
test for the new schema before applying it to the actual operation.  In addition, you can 
simply add a DataItem to your project by exporting the DataItem from another project 
so you do not need to define the schema. 

DataItem Import/Export Highlights

File Extension 
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The file extension of the DataItem information exported from Mozart IDE and Mozart 
Studio are as follows: 

Individual DataItem file: vditem 

Input or Output DataItem set: vditems 

💡 Note 
The file extension of DataItem for Mozart IDE and Mozart Studio is unified 
as vditem from 2021.119.1 version. If you are using a version below 
2021.119.1, you can import the DataItem exported from Mozart IDE to 
Mozart Studio by changing the file extension from vditem to vdinfo. 

Context Menu 
The DataItem import and export command can be found from the context menu of the 
selected DataItem. The given commands are different depending on whether DataItem 
or DataGroup is chosen. 

Import, Export > [DataItem(N)...]: Imports or Exports one or more DataItems. 
(vditem)

Import, Export > [DataItems...]: Imports or Exports the entire Input or Output 
where the selected DataGroup belongs to. 

Exported/Imported Information 
The following information will be exported or imported from the DataItem. 

Schema information of the DataItem 

DataAction script and settings 

You can export/import DataSource from the DataSource context menu. 

DataItem Export Example

Exporting Single DataItem 
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Exporting Multiple DataItems 
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Exporting Vditems  
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DataItem Import Example 

Importing Single & Multiple DataItem(s) 
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Importing Vditems 
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To learn how to import the DataItem from Mozart Studio to Mozart IDE see, DataItem 
Import/Export.

How to Hide DataItem

MOZART IDE를 통해 특정 DataItem 숨기면서 MOZART Studio에 최종적으로 노출시킬 
DataItem을 설정 할 수 있습니다. 기본적으로는 별도의 설정이 없으면 IDE를 통해 추가한 
DataItem은 MOZART Studio에서 노출이 됩니다. 다음은 MOZART IDE상에서 DataItem을 
숨기는 방법입니다.

1. MOZART Explorer의 [Model > Input/Output > DataGroup >DataItem] 선택하고 
마우스 우 클릭 메뉴에서 [Hidden in studio] 메뉴를 선택합니다.
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2. 아래와 같이 [Hidden in studio]가 체크되어있고 해당 DataItem 명의 색상이 변경된 것
을 확인하였으면 변경 사항을 저장합니다.
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3. 프로젝트를 빌드하여 MOZART Studio를 실행합니다. DataItem을 숨긴 [Model > 
Input/Output > DataGroup]을 선택하여 숨겨진 DataItem이 안 보이는지 확인합니다.

Editing Schema

This describes how to configure a schema and its columns' property in Input & Output 
data used in system. Besides editing basic schema, additional views can be defined in 
InputMart as a reference to the corresponding data in case of Input Data. The following 
shows these 2 methods.

How to Edit Schema 
1. Select [Model > Inputs] in Model Explorer and click [New DataGroup] on right-

mouse-button Popup menu.

2. Select an existing DataGroup or a new one and click [New DataItem] on right-
mouse-button Popup menu.
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3. Enter a DataItem name. Then, the DataItem is created in tree and a window for 
editing Schema opens.

4. Each Data Column can be manually entered or can be copied from a table of a 
specific Data Source.

Click [버튼이름] icon in order to create columns from DB table.

Schema Extraction dialog is activated. Then choose a target Database among 
the existing access informations in "Select a database" combobox.

If there is no target database, enter a new access information. (Reference to 
Datasource Managment)
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If a data is selected, use [Next] button to select columns used in both table 
and schema.

After columns are selected, click [Finish] button. Then, check Schema that is 
going to be created.
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5.  Enter other property of data column.

Name : name of column

PropertyType : type of column data

Caption : column name displayed on UI (of Mozart Studio). If caption of 
PLAN_DATE is configured as DUE_DATE as shown in the above figure, 
column name of grid in Studio is displayed as DUE_DATE.

Description : description of column

Key : Indication of whether it is primary key or not. Validity about the entered 
data is checked.

Null : Indication of whether Null is allowed or not. Validity about the entered 
data is checked.

Editor : This is an input control used to enter value into columns of Data grid 
in Mozart Studio's Experiment window. There are 4 types like {"TimeEdit", 
"DateEdit", "MemoEdit", "ComboBox"}. If Editor is selected, the selected Editor 
is activated when data input is executed in Studio. In the above figure, 
PLAN_DATE's Editor type is configured as "DateEdit". So it is shown in the 
following figure that date selection dialog is activated in Studio.

DefaultValue : This is a default value. In the above figure, LINE_ID's default 
value is configured with "Line1". So it can be seen that Mozart Studio displays 
"Line1" as LINE_ID's value.
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6. If the order among Columns needs to be changed, select a target property in 
property grid and use ⬆ ⬇ icons to change its order. Or click [버튼이름] icon to 
open a dialog box for changing the order. In the dialog box, select one of the listed 
Property names and use [Up][Down] button to change its order. When the task is 
completed, click OK to save the change.
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7. Helper configuration : This is used to configure a display name and basic string 
of data class at debugging or execution.

Debugger Display : This is a name displaying variable's information during 
debugging. If it is configured as shown in the above figure, the corresponding 
object is displayed like the following figure.

ToString : This configures a property that is used as a result of .ToString() 
function for the corresponding object while debugging or writing a logic. The 
following is a result of the configuration in the above figure and if ToString 
property is configured as "PRODUCT_ID+PROCESS_ID+STEP_ID", 
Expression result is displayed like the right one of following figure.
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How to Edit DataView
Data defined with a Schema is automatically created in the form of EntityTable in 
InputMart. If "Use temporary context" option is configured in Persist config, the data is 
created in TempMart instead of InputMart. When EntityTable's data, which is created 
during simulation run, is used, a View can be configured according to Key that is used 
to improve search speed. The following illustrates how to configure a View of data.

1. In "View" section of DataItem Edit window, click [...] button to open Edit View 
window.
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2. Configure View Name in Edit View window and select a View Type and also Key 
for the view. Then, click "OK" to save the configuration. View Type is selected 
according to amount of data or searching method. If only search function is 
required without sorting, HashTable type is used usually. If sorting function should 
be used a lot, BinaryTree is more efficient choice.

3. Check whether the View is created in the list or not.

4. The corresponding View can be referred to through InputMart as described in the 
following example. It is possible a fast search using Key configured in EntityView. 
The following is an example about reference to and use of a created View.

Example. Use of View

public IList<string> GETLOADABLEEQPLIST(DispatchingAgent da, IHandlingBatch hb, ref
 bool handled, IList<string> prevReturnValue) 
{ 
    SiteLot lot = hb.Sample as SimpleMfgSemiconLot; 
    var arrs = InputMart.Instance.EqpArrangeStepView.FindRows(lot.Product.ProductID, 
lot.Process.ProcessID, lot.CurrentStepID); 
    HashSet<string> loadables = new HashSet<string>(); 
    foreach (EqpArrange arr in arrs) 
    { 
        loadables.Add(arr.EQP_ID); 
    } 
                           
    return loadables.ToList<string>(); 
}

Editing DataAction

DataAction is a Query management unit that can consist of multiple queries. 
DataAction bound in Input DataItem is a query to download data into Input Schema 
and DataAction bound in Output DataItem is a query to insert the corresponding output 
data into Database. A DataAction can be added/modified/deleted as follows.

How to Edit DataAction
1. Item and open its tree. Then, "Default" DataAction is displayed. In order to open a 

window for editing DataAction, double-click the corresponding node or click 
[Open] on right-mouse-button Popup menu.
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2. If any DataAction other than default one should be added, click [New DataAction] 
menu on the right-mouse-button Popup menu for the corresponding DataItem. If 
multiple DataActions are registered in a single DataItem, not all DataActions are 
executed but only ones whose Activate checkbox is checked are executed.

3. Select DataSource used by DataAction's query in DataSource ComboBox at the 
left side of DataAction window.
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4. A single DataAction can save multiple Query strings. Individual Query is the lowest 
node displayed in a tree of window's left side. Any command can be 
added/removed by ➖ ➕ icon on the top. ⬆ ⬇ icons are used to change 
execution order of commands. Commands are executed in the order displayed in 
Tree.

Example. Registration of Multiple Commands
The first command is a query with Select statement that selects LineA-related data 
from SampleDB and the second command is a query with Select statement that 
selects LineB-related data from LineB DB.

[Registering the first Command]

[Registering the second Command]

DataSource for this command is configured as the second DB and columns for 
Query result are the same as ones for the first command.
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[Query Result]

When [Query & Save to file] menu is executed, two data are merged together. 
The result can be checked.
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5. Write a Query in the right side of Edit Query window.

Combo box and check box on the top of the window are used to configure the 
followings.

CommandType : Select query type in a window for editing a query

Text : Normal query string is entered.

 Stored Procedure : The storing procedures are executed

TableDirect : Direct connection to a specific table data in Data Source

DataSource : Default DataSource for DataAction is displayed under TreeView 
at the left side of the window. If a specific command in the tree uses a 
DataSource that is different from the default one, it can be configured in this 
ComboBox. The corresponding command (query) is executed in the 
designated DataSource. For example, if data having the same schema from 2 
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different DataSource (DB A, DB B) are selected and merged together, this 
method can be used.

Bind Table : Normally this is an option used in Output Data Item. If this option 
is selected, Query processes target data row by row. This is not applied to 
Select Statement. 

6. In order to use Arguments in a Query, variable having "@" as a prefix can be used. 
After writing a query with this variable, execute [Extract Parameters] command 
on the top menu bar. Then, parameter is automatically registered as in the 
following figure.

As shown in the above figure, a Query can be written to bring with ARRANGE 
information for PROCESS_ID only given by "@PROCESS_ID" variable. The 
corresponding parameter can be configured in [Main > SetQueryArgs] function of 
Main Control. Also if user tests a query in Studio, Studio's [Test Values] menu can 
be used to configure Parameter's value. The following is examples of these 2 
methods.

Query Argument Configuration and its result

// Implementation of Main>Main>SetQueryArgs 
// If a variable is entered as follows, query for input data is executed by reflecti
ng Argument. 
 
public void SETUPQUERYARGS_0(ModelTask task, ModelContext context, ref bool handled) 
{ 
    // When a Query is written in QueryArgs of ModelContext, a value is entered for
 the used variable. 
    context.QueryArgs.Add("PROCESS_ID", "PROC01"); 
}
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Testing in Studio
In order to test the corresponding query in Mozart Studio, first inquiry about Input 
Data. Then, input values of variables used in Query through [Test Values] menu. 
After this, execute the query by using [Query & Save to file] menu. The result 
reflecting the variables is given. 

[Execute "Test Values" and Enter a variable value]

[Output of "Query & Save to file" execution]
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7. If Activate checkbox under Query Tree View is checked and saved, DataAction 
configured for the corresponding Schema is activated..

8. Top menu bar consists of functions for managing Commands of DataAction and 
supporting Query.

Query Builder : This helps to write a Query. After a Data Source is connected, 
Select, Insert, Update, Delete statement can be written through Table Schema.

Extract Parameter : This extracts parameters in Query and add these 
parameters to parameter list at the bottom of Query Edit window. Target 
variable for extraction is defined by prefixing it with "@". ex) @LINE_ID, 
@PROCESS_ID

Test Values : This is used to input test value of Parameter when parameter is 
configured in a Query. The input value is used as a default when "Query & 
Save to file" menu is executed in Studio. If Studio's "Test Values" menu is 
executed, it can be checked that DataAction is configured with a default value.

Data Input Persist Configuration

Persist Config defines a procedure and method that loads Input DataItem as data in 
memory. Input Persist consists of 3 components such as Input Data Group, Input 
DataItem, and Input Save Log. Options for loading of all inputs can be configured 
through input for Root Item of Persist Config. Executable menu is [Persist Config > 
Input Config] in Mozart Explorer.

Configuring option for loading all Input data
If the top node in Tree is selected, menus for defining data loading options are 
activated.
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Name : name of log for all Inputs

Model : This selects a Model that the configuration for the corresponding group is 
applied to. If this is configured as "*", the corresponding configuration is applied to 
all Models. If a specific Model is designated, this configuration makes all 
DataItems in the corresponding group be loaded into only the designated Model.

Log performance: Decision of whether a loading time for all data is recorded or 
not.

Tread count: This designates number of Treads used when batch download is 
executed.

DB job retry count: This designates number of retrials for DB access or 
command execution when batch download is executed.

Configuring option for loading Input DataGroup
It is possible to define loading option for each DataGroup. When a DataGroup is 
selected in Tree menu, user can configure the corresponding properties in property 
pane at the right side.
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Name : Group name used while loading.

Log performance: Decision of whether a loading time for all data is recorded or 
not.

Startup message: Log message used at the beginning of loading for a group. 
When a message is edited, Usable variables can be used.

Example of How to use Usable variable

Entered Log Message : This is test log start message at ${Now}

Displayed Output : This is test log start message at 2014-09-22 06:05:11

End message: Log message used at the end of loading. When a message is 
edited, Usable variables can be used.

Configuring option for loading each Input DataItem
It is defined options for loading an individual DataItem.
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Name : DataItem name used while loading. Change of this name is not allowed.

Enable: Decision of whether the corresponding data is loaded or not. If not 
checked, this DataItem is not automatically loaded.

On after load item : This executes methods that user can process like transition 
or validation for each row of data in DataItem. If this CheckBox is checked, the to-
be-executed method can be executed through ComboBox and buttons just under 
the CheckBox. Return value of this function means whether the corresponding row 
of data is loaded or not. If true, the corresponding row is added to loaded data. 
Otherwise, the row was filtered.

Select Action : One of pre-registered Load Methods can be selected in this 
ComboBox.

Add Action : With [버튼이름] button, a function's name and empty source code is 
created to process the corresponding data. Name of this function is PersistInputs.cs 
file and is created in Logic folder.

Edit Action : [버튼이름] button is used to edit source code of the function selected in 
ComboBox..

Edit Action name : [버튼이름] button is used to edit the name of Action.

Executing action: If an additional special load processing is required after all data 
of DataItem is loaded, this option allows to define and execute a method. In order 
to add and edit an Action, refer to explanation in On after load item.

Log performance: Decision of whether loading time of DataItems is recorded or 
not. If checked, loading time of DataItems is recorded in log information.
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Use temporary context: Generally DataItem can be divided into 2 groups. One is 
a data group that remains loaded in memory while Model is being executed and 
the other is a data group that is temporarily loaded into memory and can be 
removed from memory at the end of loading process. This option decides this 
kinds of group for each DataItem. If checked, this DataItem is removed from 
memory at the end of input data loading. The created class is referred to through 
TempMart.

Configuring option for creating General Log
Log Item can be used to leave a log at a specific location regardless of DataItem 
during data loading or to execute a specific method. Log Item can be added by using 
[Add>Log] of Persist config. To add a log at a specific node in Tree, select the node 
and use the same Add>Log menu. Then, a Log Item is created just under the node 
and its option can be configured through property page as described in the following 
figure.
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Name : name of log.

Model : Model that this log is applied to.

Executing action: This designates a method that runs at log execution and 
configures whether this method is executed or not. If checked, the method 
configured in ComboBox is executed. One of the pre-registered method is selected 
or a new method can be created.

Log message: Log message that appears at the location of LogItem is configured. 
Log message context can include key registered in Usable variables.

Data Output Persist Configuration

In Output Persist Configuration, procedures and methods for saving Output DataItem 
into memory to a file or DB are defined. In order to proceed with a series of 
procedures, components that define Output Persist can be divided into 3 types such as 
Output data group, Output data, and Output save log. And option for processing all 
outputs can be configured through Persist Config. [Persist Config > Output Config] 
menu is used for its execution.
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Configuration of Options for Saving All Output Data
If Top node in Tree is selected, menus that define this option are activated.

Name : A log name for all Outputs

Log performance: The decision of whether a processing time for saving all data 
should be recorded or not.

Thread count: number of threads that are used to upload data in batch.

DB job retry count: number of repetition for DB access or execution of command 
during batch upload.

Monitoring table : An output can be defined to record success/failure of Task 
execution after all Tasks have been executed. After the output is configured, its 
result can be written through ShutDown Action of Main Control.

Example. Use of Monitoring
1. Define an Output data item to write output result.



MOZART IDE (ENG) 117

2. Designate an Output data item (which is defined in 0) for writing result into 
Monitoring table property of Output Persist Config.

3. Implement ShutDwon Action of MainControl.

4. Write results in DB for Monitoring through DataAction configuration about Output 
result.
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Configuration of Options for Saving Output Data 
Group
For each Output Data Group, separate saving option can be defined. When a Data 
Group is selected in Tree, its property is configured through property pane at right side 
of window.

Name : Name of data group.

Log performance : decision of whether a processing time for saving all data 
should be recorded or not.

Startup message: Edit log message at the beginning of Group data saving. If the 
message is edited. Usable variables at the bottom can be used.

Example of How to use Usable variable

Log Message : This is test log start message at ${Now}

Output: This is test log start message at 2014-09-22 06:05:11

End message : Log message used at the end of saving. When a message is 
edited, Usable variables can be used.
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Configuration of Options for Saving Output data Item
For each Output Data Item, separate saving option can be defined.

Name : Name of DataItem. This name can not be changed.

Enable : Decision of whether data is saved or not. If not checked, this DataItem is 
not saved as a file.

Excuting action : This option is used that after data of DataItem is saved, 
additional processing is required for the data. It is possible to write user's codes 
such that adds separate Output by processing data of the corresponding Output 
Data Table. In order to use this option, refer to the method to use Action, which is 
defined in Input Persist Configuration.

Writer Type : This defines types that save output. The following illustrates each 
type.

Auto write : Default option. When the number of data in Output Mart exceeds 
10 thousand, data is written into an Output file and the data saved in a file is 
removed from memory

Buffered : When Output is defined, another Buffer storage is created. If not all 
properties of Output data are defined, the data is temporarily saved in this 
storage. When all properties of Output are confirmed, the data is moved to 
Output and is deleted from Buffer storage. Management code for Buffer is 
written by user. At the end of simulation run, all data remained in Buffer is 
saved as Output data. If saved as Output data, this is saved in Output files by 
unit of 10 thousand entries and is deleted from memory. Please refer to the 
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following example code to see that data is written to Output which is 
configured as Buffered

Keep in memory : Data remains in memory from start till end of all tasks and 
isn't written to output file in the middle of processing

Example. Processing Output using Buffered Option

private void WriteEqpLoadingPlan(ILot lot, IHandlingBatch hb, AoEquipment eqp) 
{ 
    SiteLot mLot = lot as SiteLot; 
    string eqpID = eqp.EqpID; 
     
    // Search an information of starting time that is saved in Buffer 
    var plan = OutputMart.Instance.EqpLoadingPlan.FindBuffer(eqpID, mLot.LotID, mLot.Cur
rentStep.StepID); 
     
    if (plan ==null) 
    { 
        plan = new EqpLoadingPlan(); 
        plan.EQP_ID = eqpID; 
        plan.LOT_ID = mLot.LotID; 
        plan.STEP_ID = mLot.CurrentStep.StepID; 
        plan.START_TIME = mLot.CurrentPlan.StartTime; 
        plan.PRODUCT_ID = mLot.Product.ProductID; 
        plan.PROCESS_ID = mLot.Process.ProcessID; 
 
        // Add one to a Buffer if no time information is available. 
        OutputMart.Instance.EqpLoadingPlan.AddBuffer(plan); 
    } 
    else 
    { 
        // If there is an information, write End time information and add it into a fina
l output 
        // Delete data in Buffer 
        OutputMart.Instance.EqpLoadingPlan.RemoveBuffer(plan); 
        plan.END_TIME = eqp.NowDT; 
        plan.QTY = mLot.UnitQty; 
 
        // Add it into Output data 
        OutputMart.Instance.EqpLoadingPlan.Add(plan); 
    } 
}

Log performance : Decision of whether a processing time for saving Data Item 
should be recorded or not.

Call 'Execute' : This is used to execute DataActions that is not related to Schema
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Multi Model Project

In MOZART project, multiple Models can be created. But, the first created Model 
becomes Base Model and additional Models are created by inheriting Base Model. 
The following figure shows the relationship between Base Model and Child Models.

If Scheduling system is built for each Line, each system may have almost similar 
Inputs, Output structure but partial difference in Data source or Argument, etc. In this 
case, the first developed Line Model becomes Base Model and subsequently 
developed Model is built by inheritance. Inherited Child Model has constraints on its 
modification in order to keep a relationship with Base Model. The followings explain 
constraints on editing each item comprising Model.

Constraints on Editing Child Model
Items in Base Model are targets of constraint. It is basically impossible to delete any 
item from Base Model but to add new ones. However, item modification is allowed but 
these also have set of rules applied. The following explains details for each item's 
constraint.
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Arguments : Constraints on Editing Input Arguments or Config Arguments

Add Arguments : O

Modify Arguments : X

Delete Arguments : X

Data mapped with Config Argument's value : X

Database

Add Database : O

Change Database name : X

Change Database access information : O

Add Database access information and change the order of access informations : O

Remove Database : X

Inputs, Outputs

Add Schema : O

Modify Schema : X (add or change Property)

Delete Schema : X

Add DataAction : O

Modify DataAction : O (Can Change all parts including DataAction name and 
Query, etc.)

Delete DataAction : X

Add and Activate Child Model
Child Model is added by [Add>VModel] menu at top node of MOZART project as if 
adding a Model. Name of this Model should be different from Base Model's name. As 
shown in the following figure, Base Model and Child Model use different icons.
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The blue arrow displayed on Base Model icon means that the Model is currently 
activated. Activated Model is the one used in project during Debugging. In order for 
user to configure a Model to be used for debugging, select a target Model and click 
[Active] on right-mouse-button pop-up menu. Then, the selected Model is displayed 
with blue arrow on its icon, which is indicates the Model is now active.

Information of Activated Model is configured as a Model to-be-executed in Project 
Property information. Like the following figure, a Model in Command line arguments is 
configured as an activated Model.
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Write Logic for each Model
This section explains how to configure or refer a Model in case Arguments from other 
Model is required to add logic or logic required to be applied to each Model 
respectively for simualtion.

How to design a logic for each Model in Persist Config
Model can be designated for each Persist Group. If a Model is selected in Model 
configuration combobox  like the following figure, data is loaded only to the 
corresponding Model. In order to load individual data for each Model separately, user 
may implement this by discerning each Model through the following introduction (How 
to check a Model when you implement a logic)
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How to check a Model when you implement a logic
A Model that is currently running can be checked through VModelName property in 
Model Context object. VModelName has the same name as Model displayed in Tree.  
The following is an example.

if (ModelContext.Current.VModelName == "ChildModel") 
{ 
    // Implement a logic processing Child Model  
    // Example: Data can/cannot be loaded only for a specific Model 
}

All Model files added in Project are created as (Model Name).vModel in [Project root 
folder/Generated folder]. The distributing Child Model is exactly the same as 
distributing Base Model.

MY OBJECTS

My Objects Overview

MOZART processes large volume of data in a short time. So data is converted into a 
Data Model in order to make logic processing easier. The logic processing begins after 
the converted data is loaded to the memory. My Objects provides fuctions to define 
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new Data Model classes or to redefine Data Model in Library, then to use the defined 
Data Model while Execution Module is executed.

Functions of My Objects
1. Define indispensable data for running Library: This is a function for auto-

creation and modification of Data Model Class & Interface data indispensable for 
pegging and running Simulation (Schedule). User can add and use data required 
for managing actual data in user’s organization. Implementing user group's logic 
might use the newly-defined Data class. When an Execution module (Pegging, 
Simulation) is added, data class required for the corresponding module and data 
class used for both modules are added to the Project automatically. Please refer to 
How to use functions of MY Objects for details.

2. Define Data Class: When it is not easy to implement logic using data with simple 
schema defined by Input/Output DataItem, user can define a new data class to 
customize composite DMO (Data Manipulation Object) Class that has a 
appropriate form for use in logic according to user groups. For details, refer to 
How to use functions of MY Objects.

3. Define Constants: User can define and use constants required for implementing 
user organizations's logic. Refer to How to define Constants.

4. Define Enum:  User can define and use Enum type data. Refer to How to define 
Enum. 

5. Define DataMart: For each data or view defined in Inputs/Outputs of Model, a 
Collection is automatically defined in InputMart, TempMart, and OutputMart. Also 
Collection for Data class defined in My Objects is automatically created in 
InputMart. In order to check the contents defined in this way and to define user-
defined Data Collection, this function is used. Please refer to How to define 
DataMart.

How to Use My Objects
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My Objects is basically a function to define Data Class. There are two methods to 
define a new Data Class. One is to implement a class inheriting DataModel class 
basically provided in Library and the other is to create a whole new class. This section 
mostly focuses on the functional part about how to define Object.

How to Add User-defined Data Class and Basic 
Creation Method
1. Use [Add Folder / Add Item] at My Objects node to add a new folder or a new 

data class.

2. Enter Column(Property) Name and edit PorpertyType and other information.
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Define values for Data Class's property.

Name : Property Name

PropertyType : Data Type of Property. Preset data type can be selected 
directly from combo box. All other data types defined in Inputs, Outputs, and 
My Objects can be designated by selecting <Others ...> of combo box.

Press a button on the right side of Data Type to select an item of Input/Output/My 
Object.
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It is possible to designate one of all Data types provided in system Library through 
.

To define the data as collection type, click the checkbox of "Collection Type" row 
and decide a Collection Type. Then, enter an appropriate value.

Normally Collection Type's property has to be initialized. To do this, the initial value 
and Expression that defines this value should be entered by editing DefaultValue.

Key : Check if used as a Key.

Const : If Property is used as Constants, configure this property. Then, Default 
should be given.

Description : Description of Property.

Implements : If Data class is defined by implementing Interface or is created 
by inheriting an abstract class, this is mapped with properties that must be 
implemented. For Interface, explicit implementation can be done by 
configuring this.
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DefaultValue : Property's default value. If user defines PropertyType as 
Collection type or use other object defined in the System to define a property, 
a default value should be specified. The value can be entered in the form of 
Expression. In order to do this, press the [ ... ] button in the cell. Then, Edit 
Expression window appears. The other button (with eraser image) is used to 
delete Expression.

3. Save all edited work.

How to Define a Data Class by inheriting the Class 
Provided from the Library
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1. When an Execution module is added, all necessary data classes are automatically 
included. Simulation folder includes data related to Simulation Module and 
Pegging folder includes data related to Pegging. And Common folder is 
automatically created and includes preset data that is used for developing both 
modules.

2. If you want to add another data inherited from Library, set up Base Class or 
Interface from Inheritance section located at the top part of Data Class definition 
window.

3. Base Class displays objects of main Data Model related to Pegging & Simulation 
among data in Library. In order to select a class to be inherited, open a window for 
Library class selection by pressing [ ... ] button. Basic classes are automatically 
included when any module is selected. Select any required class other than these 
basic classes and press OK button. Then user can define the new class that 
inherits the class. If OK button is pressed while Auto Implements' checkbox is 
selected, essential implementation items having Base Class's property name are 
automatically included to the new classes' property.
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4. Interface inheritance has the same implementation methods as Base Class 
selection. It is implemented by inquiring and selecting a target Interface for 
implementation. If "Auto Implements" is checked, it creates the same properties as 
ones of Interface automatically.
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If the Data Class is configured as shown in the figure above, you can see that data 
fields are automatically filled. Product , Step , RecipeID  and Resource are the 
properties automatically implemented from IEqpArrange  Interface.

At this moment, select Implement item in order to define Resource item as a 
specific class Type in user site and to implement Interface.Resource explicitly. 
Please see the following figure. If you click Implements column cell for target 
property, [ ... ] button appears. Press the button to open a window to select 
properties that you want to implement.
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If you followed all the steps and settings are completed, the code to explicitly to 
implement Interface will created automatically as seen below.
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Mapping between Input Data and My Object
The data does not load automatically as in Input Data when new item is defined 
through My Object since the structure of the data was not build to do so. However, 
data class implemented in My Object normally has main Input data that can be 
mapped in most cases. In this case, My Object can be created by mapping Input data 
columns with My Object's properties. Follow the next steps for InputData mapping.

1. Select the mapping data from InputData to be used for mapping source (User can 
do this from Data Type box in Mapping section).

2. If a Data Type is selected from Mapping section, "Map field" columns will be 
added to Properties grid and the property of the Data Type can be selected.

💡 Note
If My Object's Property has the same name as the column name of Input 
Data configured from Mapping Data Type, data mapping is done 
automatically even without setting the Map Field.

3. Create a Mapping information by selecting Input data's column that is going to be 
mapped on My Object's property. A Mapping information created in this way 
creates "ToMyObject()" function in Input Data automatically and My Object's object 
can be created through this function.

4. Then, in order to load data, use Mapping function through loading function of Input 
Data where the data will be mapped from Inputs/Persist Config.
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Example. Use of Object Creation through mapping function

public bool OnAfterLoad_ToolInfo(ToolInfo entity) 
{ 
    if (entity.TOOL_STATE != "G") 
        return false; 
 
    //A data class object is created from input data,and  
    //at this moment, create an instance of property by auto-transforming Map file
d's value. 
    NcProgram pgm = entity.ToNcProgram();  
  
    if (InputMart.Instance.NcProgram.ContainsKey(pgm.PgmID) == false) 
        InputMart.Instance.NcProgram.Add(pgm.PgmID, pgm); 
  
    return true; 
}

When the mapped column's property and Map Field have different data types, 
auto-transformation is supported. Support for auto-transformation has the following 
range.

String -> Number Type : String items can be automatically transformed into 
Number Type (integer, float, double, decimal,...) of MY Object. Null is not 
allowed.

Number Type -> String : Number type can be automatically transformed into 
Strings.

String -> Enum Type : Strings can be automatically transformed into Enum 
Type. If the following condition is not satisfied, error can occur. Refer to how 
to define Enum

Transforming to Enum defined in Library : strings that is mapped for 
transformation should be exactly the same as Enum's or all characters 
should either be in uppercase or lowercase.
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Transforming to user-defined Enum through [My Objects>Enum] : If Map 
Value is not configured, this is applied in the same way as the case of that 
strings are transformed into Enum defined in Library. Otherwise, strings 
that are exactly the same as Map Value is the only one that can be 
transformed. In this case, characters in the string should either all be in 
uppercase or lowercase.

String -> DateTime Type : Strings of Date type are automatically transformed 
into DateTime Type. Available date format is as follows. (Time and Date could 
be combined)

dates format : yyyy-mm-dd, yyyy/mm/dd

time format : hh24:mi:ss, [AM or PM] hh:mi:ssdf

DateTime -> String : DateTime type can be transformed into String. 
Transformed string's format can be yyyy-mm-dd [AM or PM] hh:mi:ss

Create My Object in Input Mart
Input and Output data are automatically created in InputMart and OutputMart. My 
Object is basically a data required to implement a logic so that it is saved as a property 
of a specific object and can be used after including it to InputMart. The following 
describes how to configure a data structure defined by My Objects.

1. Open Options section at the bottom of the data class editor of My Objects.

2. Saving in InputMart or Temporary Mart and collection type of saved object can be 
defined in Options section. From Options section, you can configure whether to 
save the data through InputMart or TempMart and define object storage collection 
type.
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Use temporary context : This is used to store data to TempMart. TempMart is 
temporary DataMart used during Persist operation.

Entity object : To define data as Entity Object. In this case, data structure of 
EntityTable format can be used.

Collection Type : If data is saved as Collection type, this designates the type 
of Collection.

Dictionary Key1 : To configure data type of the key when Dictionary is 
configured as Collection Type

Dictionary Key2 : To configure the data type of the second key when Multi 
Dictionary is defined as Collection Type.

Initialize with : To input initialization code of Collection directly.Generate in 
Mart : Decision to save data to InputMart

3. Data structure defined in the above figure can be accessed through InputMart. If 
Collection Type is set through Entity Table, you will be able to define View. To find 
more details about setting View please refer to Edit Schema > How to Edit 
Schema.

Example. Use of Data stored in My Object of InputMart

// 1. Example. Processing at the moment of loading data 
MfgArrange arrange = entity.ToMfgArrange(); 
arrange.Product = prod; 
arrange.Step = step; 
arrange.Resource = eqp; 
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InputMart.Instance.MfgArrange.Rows.Add(arrange); 
 
// 2. Example. Processing at the moment of using data  
public IList<string> GETLOADABLEEQPLIST(DispatchingAgent da, IHandlingBatch hb, ref
 bool handled, IList<string> prevReturnValue) 
{ 
    SimpleMfgSemiconLot lot = hb.Sample as SimpleMfgSemiconLot; 
  
    var arranges = InputMart.Instance.MfgArrange.Rows.Where(p => 
            (p.Product == lot.Product && p.Step.StepID == lot.CurrentStep.StepID));  
  
    if (arranges == null) 
        return prevReturnValue; 
  
    HashSet<string> loadables = new HashSet<string>(); 
    foreach (MfgArrange arr in arranges) 
    { 
        loadables.Add(arr.Resource.ResID); 
    } 
  
    return loadables.ToList<string>();  
}

How To Define Constants

Constants are defined frequently by user group during logic implementation. Constants 
could be defined through My Objects. The following explains how to defining constants 
through My Object.

How to Define Constants
1. Click [My Objects > Constants] to open Constants definition window.
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2. Define constants from the column.

3. As shown through the image above, the constant value can be configured with  

DateTime  string when its type is set to DateTime .

4. The constant can be referred using Constant class. The following is an example.

Example. Reference to a defined constant

Logger.MonitorInfo(Constants.t9); 
Logger.MonitorInfo("Constants datetime1 is {0}", Constants.datetime1);

Log output of the above example

How To Define Enum
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This is a function that defines enumerative data in MOZART IDE. This is a function 
that is controlled under My Objects and can be defined from pop-up menu at Enums 
node of My Objects in MOZART Explorer.

How to Define Enum 
1. Define a new Enum type through [AddItem] menu at [My Objects>Enums] node.

2. Enter and save Enum's Name column. While defining it, configuration of Value 
column is not required.
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3. If a property of My Object is defined as Enum Type, Map Value can be used to 
define Map Filed in the proeprty. If Map Value was configured, its value is 
automatically converted to Enum's name when its value equals to Input data. 
However, it should be noted that Input Data should coincide with not Enum name 
but Map Value. Even if Enum name coincides with Input Data, automatic 
conversion doesn't occur when it is different from Map Value.

4. In order to use Enum (which is defined together with My Object) as Property type, 
configure Property Type as <Other...> and select a DataType at [Custom>Enum] 
node as seen in the following figure.

5. Configuration information for Enum Type property of the corresponding class can 
be checked as follows.
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How to Use DataMart

This provides functions that inquire Model Inputs/Outputs Schema and Contents of 
Data Mart. This Data Mart defines Collections about DataModel Class defined in My 
Objects. Also a function to define user-defined data is provided.

Components of DataMart
InputMart : This is a storage where Input data and processed data are saved in 
the beginning of simulation run. Input DataItem defined in Model is basically 
created as data of EntityTable form in InputMart if it is not separately processed 
through Input Persist Config. Collection for Data classes defined in My Objects is 
also created in InputMart. User can also define and use a new saved format.

TempMart : TempMart saves data that is temporarily used during Input Laoding. 
And this data is used to create data for starting a system. If "Use temporary 
context" Option is checked for a DataItem in Input Persist Config, the 
corresponding data is saved in TempMart and will be removed from Memory at the 
end of Input Loading. User can also define a new temporary data.

OutputMart : For a DataItem defined in Output of Model, a Collection variable is 
created to save data in EntityWriter form. OutputMart can be accessed during the 
entire life cycle while a system runs. Only Outputs designated in Model can be 
saved.
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How to define and use DataMarts

Check Stored Form of Model Data
1. At [DataMarts > InputMart > <Model>] node, user can check input data that is 

currently defined in InputMart.

2. If a specific data item is double-clicked, a window for editing the corresponding 
DataItem's Schema opens.
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3. In InputMart, EntityTable is basically defined. And this EntityTable saves the 
corresponding DataItem data class (EntityObject) 

4. If any additional View for DataItem is designated, this is also defined in InputMart. 
The following shows an auto-generated code for EntityTable and View that are 
defined in InputMart.

Checking Stored form of My Objects Data
1. Folders in [DataMarts>InputMart] are displayed with the same layout as folders in 

My Objects. In these folders, data items defined as My Objects are displayed.

2. If a specific data class is double-clicked, a window for the definition of the 
corresponding class opens. From this window, Collection can be defined. For the 
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detail information, refer to "How to use My Object > Create My Object in Input 
Mart".

Creating User-defined Data Collection in DataMart
While user is implementing logic, user may save and use additional data like Data 
defined in Model, Data Class defined as My Objects, or Data Class in Library. In this 
case, Data Collection is defined and used in InputMart, TempMart of DataMarts. The 
following explains the procedure for adding a data class into InputMart. The same 
procedure can be applied for TempMart.

1. After a node in [DataMarts>InputMart] or  sub folder a specific folder in the node, 
click [Add Item] using the right-mouse-button menu.

2. Input values in to define Collection in DataMart.
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DataType : Type of Data to be saved in Collection

Collection Type : Saved Data Type

Dictionary Key1 : When Collection that needs Key(s) is selected, the first 
Key's data type is configured.

Dictionary Key2 : When Collection that needs Key(s) is selected, the second 
Key's data type is configured.

Initialization : When a variable is declared, this option gives how to write its 
initialization code.

None : no initialization code is created

Auto : Variable is automatically created according to Collection Type

Custom : this alternative enters a variable creation code in TextBox as 
shown in the following figure. If this option is used, the expression follows 
C#.

The following source code is automatically created.
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Description : Description of variable.

3. After all inputs are saved, the corresponding data is created in DataMart as shown 
in the following figure. If Save All or Save My Object is used, the corresponding 
input data is created in InputMart..

4. Defined Collection Data can be referred through InputMart during whole period of 
simulation execution.

Reference of Data Collection

// if quantity by arrange's constraint is satisfied, add Prohibition of Use to Arran
ge 
InputMart.Instance.DeadArrange.Add(arr.Key, arr) ; 
 
// When Arrange is used, check whether Arrange with a specific Key Arrange is a proh
bited one or not.   
MfgArrange arr ; 
if (InputMart.Instance.DeadArranges.TryGetValue(arrKey, out arr)) 
    Logger.MonitorInfo("Arrange key {0} is dead arrange at {1}", arrKey, now);

MY METHOD

My Method User Guide
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My Methods defines functions used in both MOZART Main module and Execution 
module. This has a concept like registering and using function that are frequently 
reused when user group's business logic is implemented. Using My Method is similar 
to working through Solution Explorer of Visual Studio in C# language.

Add Method Group and Method

1. Folder(through Add Folder) and Method Item(through Add Item) could be 
included from My Methods node. Method Item is set of Method and the 
compounds of Method sets are in Folder.

2. A Method Item is mapped on a class and is automatically created as an individual 
class.

3. Add a Method in Method Item.

4. When a Method is added, input name of Method and its description.
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5. Press [OK] to create the Method through the selected class in My Method.

6. Double-click the corresponding method to generate the prototype.

7. Now, input Return value and Arguments, etc. and write necessary code in the 
method. Then, the corresponding contents will be synchronized to the 
corresponding node in Tree.
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8. If a method's code is added to the source, the corresponding method is 
automatically created in My Methods' Tree node and synchronized.

9. The created Method can be deleted through pop-up menu (by using Delete) at the 
corresponding Method node. When it is deleted, the source code will also be 
deleted.

Use My Method
Actual source is created as Static class and new Method is also added as static 
function. So when a logic is implemented, My Method is used by referring to Method 
class name and Method name.

Example. Implementation and Use of My Method
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// As a common function, a function to write various errors 
// , that occurs during logic implementation, is written. 
// The following is an example to write an error log 
// when data loading function creates errors after it examines validity of loaded data. 

public bool OnAfterLoad_Product(Product entity) 
{ 

 MfgProcess proc; 
 if (InputMart.Instance.ProcessList.TryGetValue(entity.PROCESS_ID, out proc) == fals

e) 
 { 

 CommonHelper.WriteErrorHistory("Warning", "STD/PRODUCT_DATA", 
 string.Format("invalid process id ({0}) in loading product data {1}", 

   entity.PROCESS_ID, entity.PRODUCT_ID)); 
 return false; 

 } 
 MfgProduct product = new MfgProduct(entity.LINE_ID, entity.PRODUCT_ID, proc); 
 InputMart.Instance.ProductList.Add(product.ProductID, product); 
 return true; 

} 

MAIN MODULE

Main Module Overview & Execution 
Procedure

Main Module Overview
In MOZART's execution framework, only Main Module or Execution Module(which 
implements IModelExecutor Interface) can be executed. Independent execution 
modules that are given as default by SeePlan Library are Pegging module and 
Loading Simulation module. Each module processes basic operations by running Core 
Model and has an extensible structure that allows its control from outside through 
Feature Extension structure. Extensible structure can be used to customize a Model in 
Library-based project. (Refer to Execution Module Library Overview)
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Main Module is designed for configuring property of Model to be executed by 
MOZART, adjusting Model execution option, or defining user's logic to be processed 
before/after Model execution. In other words, Main module is a basic execution module 
possible to customize for main entry point of program. In addition, the default 
configuration of the library can be used if the module is created based on Domain 
Library.

Configuration
Basic parameters in Library can be configured. To check more details to configure 
individual Library, see Execution Module.

1. Double-click [SeePlan Config] on MOZART Explorer to configure the parameters 
provided by the library.

2. All configurable Parameter page can be accessed from Tree View at the left of 
Configuration window.

3. If a specific tree node is selected, Parameter page of the corresponding node 
appears and each Parameter's value can be configured in that page..

Main logic control
Main Logic exposes FEAction to customize the execution logic of MOZART Task. The 
details for FEModel of Main Module could be seen through Main Control and for logic 
development, please refer to  How to Implement FE Control logic.

Main Module Execution Procedure
Main Module exposes FEComponent related to main executable modules that trigger 
all Tasks implemented through MOZART. MOZART's main executable modules are 
executed in the following order.
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Among any tasks that are processed periodically in Server, simple logic, which doesn't 
use Library like Simulation or Pegging, can be easily and quickly implemented only 
with Main module and its functions. For details of FEModel, refer to FEModel/Main 
Control.

Configuration

This is a function to configure system parameters defined in Library. According to the 
Library selected at creation of project, configuration items can be changed.

How to set up Configuration
1. Double click [SeePlan Config] from MOZART Explorer or click [Open] from pop-

up menu to configure the parameters provided by library.
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2. All configurable Parameter page can be accessed from Tree view at the left of 
Configuration window. 

3. If a specific tree node is selected, Parameter page of the corresponding node 
appears and each Parameter's value can be configured in that page.

How to refer to a input value in Configuration
Library basically refers to values set in Configuration. But, if user's logic needs to use 
the corresponding configuration value, the value can be referred by adding the code to 
request configuration service in the form of (the library name of the Configuration Tree) 
+"Configuration". In case the default reference library is SeePlan and Semicon library, 
configuration service can be requested in the form of SeePlanConfiguration, 
SemiconConfiguration. The following is the source code example about reference 
method.

How to refer to Configuration value of Main Module

// Example. Use of SeePlan Library Configuration 
// How to refer to LotUnitSize, DefaultSetupTime Config items in SeePlan Library 
int defaultLotUnitSize = SeeplanConfiguration.Instance.LotUnitSize; 
float defaultSetupTime = SeeplanConfiguration.Instance.SetupTimeMiniutes; ; 
 
// Example. Use of Semicon Library Configuration 
// How to refer to Boolean Type Config like ApplyNoArrangeMove in case of Semicon 
bool applyNoArrangeMoveOption = SemiconConfiguration.Instance.NoArrangeMove; ; 
if (applyNoArrangeMoveOption) 
{ 
    // to do 
}

Main Control

MOZART's Model is operated by Model Task provided from Library. Main Control is the 
FEComponent for configuring parameters to let Model Task operate Model and 
supporting to process data by user after Model operation is completed.
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Model Task sets Task operation's start/end time, Simulation Version, and other 
information used in Simulation Model during Setup phase. Model execution, in general, 
is designed to process Execution Modules registered through MOZART IDE in a 
sequential order. The basic Execution Modules are Pegging & Loading Simulation 
Modules that are used to run Forward, Backward Planning. Basically, it is set for 
Pegging to run first and then Simulation.
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Setup Phase
A set of FEAction is provided to adjust the entire task performance flow during Setup 
Phase. Designating a target Model to be executed and adjusting sequence can be 
done through here.

1. BeginSetup: Before Setup is handled, Logic creating/updating information to run 
Model are implemented in this action.

2. SetupVersion: This Action is called at the point Setup is executed. Plan Version 
can be configured by User definition.

3. SetupPeriod: This Action is called at the point Setup is executed. Plan Duration 
can be configured by User definition.

4. SetupLog: Setup logs can be implemented according to User definition.

5. SetupQueryArgs : Arguments to be used when executing DataAction for 
In/Output are configured.

6. EndSetup: This Action is called at the point when Setup is completed. If any 
additional configuration other than normal Setup handling logic is required, this 
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FEAction is used to implement the configuration.

Input Data Download & Loading Phase
Through this phase, data is downloaded(query) from Data Source, saves it as a file 
and loads the data onto InputMart or TempMart in Memory for executing Module. In 
this phase, there is no Event in that any special user-defined logic can be executed.

Preloading : Input File Download and Data Loading is performed for the data set as 
Pre-loading in Input Data. Pre-loading is mainly used to perform Main Input Data 
Loading or to load condition information from Data Source for controlling the entire 
execution.

Main Input loading : Input File Download and Data Loading is performed for the data 
that is not set as Pre-loading in Input Data.

Execute Phase
This Phase controls executions in MOZART. Each execution Module is initialized 
through this phase and event handling at the end of operation can be customized.

1. OnInitialize : OnInitialize is called after Input Data Loading is completed, but 
before Task is executed. The loaded data is primarily processed here and can be 
used to make additional Input Data.

2. Run : Run is the Main function and the entry point to perform Task. Definition in 
Run is bond to execute all Modules included in Model in Pegging, Simulation 
order.  The default Definition can be used when Pegging, Simulation Module is 
added. Otherwise, if the registered Module is going to be used for arbitrary 
purpose, Run function needs to be redefined.

Module Execution Control through Run Function

// Example. Redefinition of Run function after CustomTest Module is added. 
// In general, Custom Module has higher priority than Simulation. 
// In case Module is required to re-process Simulation result, the following lines s
hould be included. 
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public void RUN1(ModelContext context, ref bool handled) 
{ 
    // Refer Simulation Module by Module name (Module name is same as the name shown 
through Tree.) 
    var module = context.GetExecutionModule("Schedule"); 
    if (module !=null) 
    { 
        module.Execute(context) ; 
        if (context.HasErrors) 
            return; 
    } 
    // Refer to Custom Module 
    module = context.GetExecutionModule("CustomTest"); 
    if (module != null) 
    { 
        module.Execute(context); 
        if (context.HasErrors) 
            return; 
    } 
} 
 
// Sample code to run Custom Module 
public void EXECUTE0(ModelContext context, ref bool handled) 
{ 
    // Simple Log output sample 
    Logger.MonitorInfo("This is Custom Module Test!"); 
    // Logic can be implemented using InputMart, OutputMart Data. 
} 

The result below shows the Custom Module execution log after Simulation is 
executed.

RUN_DEF Sample Code

public virtual void RUN_DEF(ModelContext context, ref bool handled) 
{ 
    var handler = TaskControl.Instance; 
    var modules = context.GetOrderedExecutionModules().ToArray(); 
    Logger.StartHandler(context.GetLog(MConstants.LoggerExecution)); 
    try 
    { 
        int count = modules.Length; 
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        for (int i = 0; i < count; i++) 
        { 
            var module = modules[i]; 
            if (!handler.CanExecute(module, context)) 
                continue; 
            if (!handler.IsContinueExecution(module, context)) 
                break; 
            Logger.MonitorInfo(module.Name + " Start."); 
            this.lastResult = module.Execute(context); 
            if (context.HasErrors) 
                break; 
            Logger.MonitorInfo(module.Name + " End."); 
        } 
    } 
    finally 
    { 
        Logger.EndHandler(); 
    } 
}

3. CanExecuteModule : CanExecuteModule is used in default Definition of Run 
function. The function is called for each Module registered in MOZART project. 
Logic are implemented to decide whether this module should be executed or not. 
For example, if only Pegging Module needs to be performed although both 
Pegging and Simulation modules are applied, it is possible to execute Pegging 
module only by setting the return result of Simulation Module to false.

4. IsContinueExecution : IsContinueExecution is used in default Definition of Run 
function. This function decides whether to run/stop Module performance. If a return 
value is false, Module's execution is stopped. And this doesn't matter how many 
Modules are left to be executed.

5. OnBeginModule : OnBeginModule is used in default Definition of Run function. 
This function is called at the initialization of the Execution Module in order to 
implement user-defined logic. Since this function is called at the beginning of 
execution by all execution Modules, logic should be differently implemented 
according to the Model.

6. OnEndModule : OnEndModule is used in default Definition of Run function. This 
function is called at the end of Module execution in order to implement user-
defined logic. Since this function is called at the end of execution by all execution 
Modules, logic should be differently implemented according to the Model. 
OnEndModule is also called when error occurs during Module execution. Loading 
task for these errors can be separately performed.

7. OnDone : OnDone is called when execution of all Modules in the Project is 
finished. Additional processing for the result can be inserted at the time moment 
before the result is originally written.
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End Phase

Save output file & Save DB : In End Phase, output data in Memory(OutputMart) is 
written into Output file. And among these data, some data items are updated in DB if 
required.

1. Shutdown: Shutdown is used for any future works after Model execution is 
completely concluded. Basically it is used to leave logs for errors occurred during 
Model task execution. When Monitoring table of Output Persist Config is 
configured, codes like the following example can be written.

Write Task Result Log Sample
Configure Outputs that saves the final result onto Monitoring Table from [Persist 
Config > Output Config]. Then, implement Shutdown function like the following. If 
problems are not considered with regard to saving the final result, the 
corresponding data can be written through OnDone or OnEndModule. However, if 
Monitoring table is configured, the results will be saved to a file or to DB after 
Shutdown.

public void SHUTDOWN_0(ModelTask task, ref bool handled) 
{ 
    // If Output DataItem name is ResultFlag 
    ResultFlag result = new ResultFlag() ;  
    result.STATE_TIME = DateTime.Now ; 
    result.STATE = task.HasError ? "FAIL" : "SUCCESS" ;  
     
    // Add values to the corresponding result table. 
    OutputMart.Instance.ResultFlag.Add(result) ; 
}

Save Monitoring Result(with final result) : Saves the final execution result of Task. 
The value of Monitoring Table that is configured in Output Persist Config is saved.

2. ProgressReport: ProgressReport is called on each start/end of reading DB, lading 
DB, executing Module, and writing DB. 'Stage' is the value to identify each 
execution point of the Action and ProgressReport Action is called at the point of 
each 'Stage'.
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'Stage' Input Value of ProgressReport
PreDownload_Start : Read target Pre-loading DB

PreDownload_End : End target Pre-loading DB read.

PreLoading_Start : Load target Pre-loading data.

PreLoading_End : End target Pre-loading data loading

AutoDownload_Start : Read DB

AutoDownload_End : End reading DB

DataLoading_Start : Load data

DataLoading_End : End loading data

{Module(Pegging/Simulation/Custom) Name} Module_Start : Run Module

{Module(Pegging/Simulation/Custom) Name} Module_End : End Module

SaveOutput_Start : Write data

SaveOutput_End : End writing data

CommitOutput_Start : Write DB

CommitOutput_End : End writing data

SaveMonitoringOutput_Start : Write Monitoring Table Data

SaveMonitoringOutput_End : End writing Monitoring Table Data

CommitMonitoringOutput_Start : Write Monitoring Table DB

CommitMonitoringOutput_End : End writing Monitoring Table DB

The followings describes the reference items of ModelContext class that are basic 
classes able to be used while user-defined logic is implemented in Main Control

ModelContext Class

Main Property & Method
StartTime : Start time of Model execution (time set in start-time of Arguments)

EndTime : End time of Model execution (start-time + period of Arguments)

Arguments : Collection of Input Arguments value
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QueryArgs : Collection of Arguments values used from DataAction for Input, 
Output persist. Input, Output persist

Version : VersionInfo object of execution version.

VersionNo : Execution version number string (Name, start time, VersionNom, etc.)

VModelName : Name of execution VModel

HasError : Check Model error

LastException : Error (Exception) information when error occurred from Model

Result : Task result of object form. Writes results of tasks refereed when 
Dependent Trigger is created

GetExecutionModule(string moduleName) : Return execution Module from 
Module name

GetOrderedExecutionModules() : Return list for all registered Modules

How To Refer
Referring through Action Parameter of Main Module : This could be referred 
during Action development of Main Module accessed through ModelTask.Context

Referring through ModelContext.Current : Can be used at any point.

How to Implement FE Control Logic

FEComponent provides an implementation point where a logic for a control of Core 
Model is implemented. When Simulation or Pegging logic is implemented, each Model 
is created as the 1st level of node in Model Explorer, Feature Extension Category as 
the 2nd level, and FEComponent as the 3rd level. The corresponding FEAction node is 
displayed under FEComponent. User can add a user-defined logic corresponding to 
the role of FEAction. This is called the FEDefinition and it is created as a subordinate 
node of FEAction.
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Creating FEDefinition

FEDefinition can be created through the following procedures.

1. Search FEAction of the Model to be developed. At this moment, FEDocument can 
be used to find the point where a logic should be implemented.

2. Select FEAction node and click [Add] from the pop-up menu.

3. Input each item in "Add FE Method" dialog to define FEDefintion.

Category Name: Functional category of FEDefintion. User can define this and 
it will be used as the class name when the Method's code is created. Pre-
existing class names can be selected or new class name could be defined.

💡 Note 
If Category Names is used with well-organized classification. each 
function's progress and history can be easily managed in Project. For 
example, when a specific function is implemented on user's request, 
implementation items can be managed in a single class with respect to 
functions if any related definition is defined after defining Category with 
name of the corresponding request function. Also if the class is 
managed through connection with TFS, history management about 
functions can be provided.

Method Name: Name of an automatically-created function.

Description: Description of the function

Enable: This shows whether FEDefinition is activated or not. Only activated 
FEDefinition will be reflected through the final DLL.

Activation Condition: Activation condition of the corresponding FEDefinition. 
If Activation condition is configured, not only Enable state but also Activation 
condition should be satisfied in order for the created operating Model to reflect 
the code. Activation Condition can select one among Boolean Type 
Parameters defined in Argument.

4. If all information of a Method are entered, a Class is created in "Logic" folder of 
Solution Explorer with Category name configured while defining the Method. A .cs 
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file opens in Source Editor window and Focus is placed over the corresponding 
Method to be edited.

5. The corresponding Method is implemented according to C# grammar.

💡 Note 
Function prototype of FEDefinition that is automatically created 
according to FEAction includes the following 2 pre-defined Arguments.

handled: This is a variable to control execution of a FEDefinition bound to a 
FEAction. If it is "true", it will terminate the current FEDefinition and terminates 
FEAction afterwards. If not, an operation Model will be created to execute all 
FEDefinition bound to the corresponding FEAction.

prevReturnValue: The result value of the previous executed FEDefinition. 
This is used to reflect the code when different logic in FEDefinition of FEAction 
process the same operation and the result of the previous logic is used as the 
input value of the next logic to be proceeded.

FEDefinition method code sample

public IList<string> GET_LOADABLE_EQP_LIST(DispatchingAgent da, ISimEntity entity, 
                                   ref bool handled, IList<string> prevReturnValue) 
{ 
      InputMart im = ServiceLocator.Resolve<InputMart>(); 
      EntityView<EqpArrange> view = im.EqpArrange.AsEntityView(); 
      object[] obj = { "LINE_ID", "PRODUCT_ID", "STEP_ID" }; 
      IEnumerable<EqpArrange> arrs = view.FindRows(obj); 
      List<string> list = new List<string>(); 
      foreach (EqpArrange arr in arrs) 
      { 
          if (!list.Contains(arr.EQPID)) 
              list.Add(arr.EQPID); 
      } 
      return list;              
}

Editing FEAction
FEAction and FEDefinition has 1:N relationship. That is, multiple logic can be 
implemented at a single Logic Point. For example, FEDefinition could be added as 
many as the numbers of existing filtering constraints at the WIP filtering point during 
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Dispatch process. Therefore, if there are more than one FEDefinitions bound to 
FEAction, the sequence among FEDefinitions can be adjusted and if a logic is 
changed, added, or deleted as time goes by, FEDefinition bound to the logic can also 
be changed, added, or deleted. Through [Edit] menu of FEAction, all FEDefinitions 
bound to a FEAction can be edited all at once.

1. Click on FEAction node to be edited and click [Edit] from pop-up menu.

2. "Bind" dialog is loaded.

3. In order to adjust the order of binding list, use ⬆ ⬇ buttons at the top of Binding 
List box.

Select an item whose order is going to be changed in the list

Adjust its order with [Up][Down] button.

4. Bindable List is a list of FEDefinitions that can be bound to a selected FEAction. In 
order to bind any item in this list, double-click a target item in Bindable List. Then 
the FEDefintion item is added to Binding List.

5. If any item in Binding List is double-clicked, the item is unbound. So the item can 
be removed or included  from Binding List.

6. Each FEDefintion in Binding List can change its activated state through Enable 
check button.

7. After Editing is completed, click [OK] button to save the changes. No progress will 
be saved if [OK] is not clicked.

Refer to FEDocument
If any explanation about FEAction and FEDefinition is required, click [Show 
Summary] from any of the nodes(right click to open pop-up menu) to inquire the 
information. Once clicked, Documnet Explorer will be activated.  If FEComponent and 
FEaction of MOZART Explorer is navigated while Document Explorer is opened, the 
descriptions of the chosen items will be synchronized to Document Explorer.

Data Pre-loading



MOZART IDE (ENG) 167

When user sees execution structure of MOZART Main Task (refer to Main Control), 
Input Data goes through two phases to download and load data as shown in the 
following figure.

During Pre-Loading phase, Data is loaded for the first time. Then, during the main 
Data loading, the pre-loaded data is used to write codes like downloading specific data 
selectively or deciding whether a specific Module or Logic is executed or not. The 
following shows how to configure Pre-loading and its example.

Configuring Pre-Loading
1. Register Input DataItem that should be pre-loaded to "Preloading" group of Input 

Persist Config node. The following figure shows an Input DataItem that is 
registered in Preloading group after its creation.
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2. For the item that is the target of pre-loading, it is possible to write Persist handler 
like the above figure.

Query Arguments Configuration Example
This example shows the way to configure Arguments used in Input Data Query 
through Pre-loading.

1. Define RunCondition  schema and DataAction like the following figure.

2. Register RunCondition  to Preloading Group and write Handler as the sample shown 
below.

3. You can see that the data of RunCondition  is downloaded.
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4. The first DataItem loaded from this example is ProcSteps . The code example below 
is the Action Handler function of ProcSteps  and shows that the above 
configuration's result was saved.
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SIMULATION MODULE

Simulation Module Overview

MOZART SeePlan Library provides functions that let users to redefine how to control 
Simulation Core Model for carrying out Simulation Project specialized to manufacturing 
industries. Also, it provides modeling functions to consider property of simulation for 
manufacturing industry and expandability in simulation perspective. The following 
summarizes Simulation Module's functions.
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Controlling Simulation Model : Simulation FEComponent is used to expose 
FEActions and manage the implemented logic(FEDefinition).

Dispatching Weight Factor Method : Simulation Library basically provides two 
types of Dispatching methods in order to support Dispatching methods in 
Manufacturing industry. One is a WeightedSum type Dispatcher for multiple Weight 
Factors and the other type is a Dispatcher that uses sorting with respect to each 
Factor that is considered in order by its priority. User can define and add how to 
manipulate the outputs of the Weight Factor and reflect it to Dispatching.

Collecting Lot-base Statistics : This provides a function to define Lot-base 
statistics.

Processing User-defined Events : User can plan Simulation events which are 
not triggered by Simulation Core but are defined according to user's purpose and 
implement logic that is used to process the Events.

Filtering Method : The Filtering condition definition code for each Filters in the set 
can be implemented at this point. The Filter set will be found through the Filter key 
and the lot will go through each of the defined conditions of corresponding filters in 
the set of the key to be filtered before dispatching is performed.

In order to trigger a Simulation Model, first Simulation Input/Output and DMO Class 
should be defined through Model editing function and My Object Module
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Simulation FEModel Overview

Simulation FEModel consists of 8 categories such as Factory, Dispatching, Equipment, 
Bucketing, SecondResource, Entity, Transfer, and JobChangeAgent and each 
category exposes FEActions through 1 to 3 FEComponents. Designer and developer 
for Project Logic can develop Simulation logic through the corresponding FEAction.

Feature Extension Category

Factory Category
This is a set of components to initialize Simulation by creating objects, setting relations 
among objects and etc. These components are: EqpInit to initialize equipment which is 
Simulation's core object, BucketInit to initialize Bucket, Components to initialize other 
objects composing Factory, and Factory Events.

Entity Category
EntityControl, that comprises Entity Category, is used to control each moment of Lot's 
state change such as creation, extinction, processing, transferring.

Transfer Category
Transfer Category is used to control lot's transfer. This consists of TransferControl and 
TransferExtControl. TransferControl provides a Model for basic transfer time of lots 
among Equipment. TransferExtCotnrol provides a Model for the transfer related to 
outside logistics systems.

Dispatching Category
Dispatching Category consist of three parts; 1) QueueControl is used to control lots 
when lots arrive at a Step, 2) FilterControl examines the condition of both 
equipment and lots on dispatching and filters out only target lots for 
dispatching, and 3) DispatcherControl selects a lot for Dispatching by evaluating 
priority of dipatching target lots.



MOZART IDE (ENG) 173

Equipment Category
Equipment Category consists of Components that control Equipment, a main resource 
which processes lots. These consist of three components such as SetupControl, 
ProcessControl, and DownControl.

Bucketing Category
If it is difficult to process a Step through loading simulation, it is possible to use 
Bucketing. BucketControl is the only component to control Bucketing logic.

SecondResource Category
This category is used to control Second Resources that are occupied and used by 
Equipment and workpiece while each Step is processed. SecondResource category 
consists of SecondResourceControl cotrolling active second resources like SetupCrew 
and passive second resources like Tools, Jigs that are mounted on Equipment.

JobChangeAgent Category
This category is used to process data logic for specific purposes like release of lots, 
Job change for equipment, and workload balancing among lines. SeePlan Library 
provides JobChangeControl and InputControl components.

The following figure illustrates relationship between each FECategory and 
FEComponents.
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Factory

Factory is a set of components to initialize Simulation by creating objects, setting 
relations among objects and etc. Especially it deals with the initialization related to 
Resource. There are four components and the call sequence of these components are 
shown below.
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EqpInit
This is used to create and initialize Equipment, Dispatcher, DispathcingAgent.

BucketInit
This is used to create and initialize Capacity Bucket and other Bucket required for 
various constraint.

FactoryInit
This is used to register Factor Method for using Dispatching Presets and Monitor for 
collecting statistics.

FactoryEvents
This exposes functions that process Factory Events which affect subordinate Models 
in whole simulation Model (Factory Model).

EqpInit Control

This FEComponent is used to create Equipment used in a Simulation and to configure 
Equipment Simulation Reference Model and Dispatching method for simulating 
Equipment. After AoEquipment are created, their registeration into AoFactory (an 
Integrated Factory Model) is executed.
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The following figure illustrates interrelationship among FEActions of EquInit and when 
each FEAction is called.

EqpInit allows to add user-defined logic for equipment initialization through the 
following four Actions.

1. GetEqpList(*): This is used to implement a logic to return a list of 
Equipment(Resource) that will become targets of Simulation. Only Equipment in 
the list are created as simulation Equipment. This Action must be implemented for 
simulation without exception. But, if only Bucketing is used for Forward simulation, 
this Action doesn't need to be implemented.

2. GetDispatcherType : This designates Dispatcher Type for each Equipment. 
SeePlan provides WeightSumDispatcher and WeightSortedDispatcher dependent 
on Weight Preset information. Equipment's dispatcher type is configured in 
Equipment Data of Project and is returned when it is initialized.

Default Logic Example

  public string GET_DISPATCHER_TYPE_DEF(Mozart.SeePlan.DataModel.Resource eqp, ref b
ool handled, string prevReturnValue) 
    { 
        return eqp.DispatcherType.ToString(); 
    }



MOZART IDE (ENG) 177

3. GetEqpSimType : This configures Simulation equipment type for each 
Equipment. Basically SimType is a basic data that is uploaded to Equipment 
DataModel through Input Schema. However, SimType may need to be modified 
dependent on user's logic.

Default Logic Example

public string GET_EQP_SIM_TYPE_DEF(Mozart.SeePlan.DataModel.Resource eqp, ref bool h
andled, string prevReturnValue) 
{ 
    return eqp.SimType.ToString();            
}

4. GetEqpDispatchingGroupKey : If a Schedule group is decided according to a 
specific condition of Equipment and lots are processed only in the corresponding 
Equipment Group, it is possible to make a Model that processes Dispatching 
through separately-created DispatchingAgent. In this case, it is required a logic 
that maps each Equipment with a DispatchingAgent. This FEAction is used to 
implement the logic. If Dispatching is processed through a single 
DispatchingAgent, it is not requried to implement the corresponding Action.

5. InitializeEquipment: This method is called right after AoEquipment object is 
created. Implement logics to initialize the properties of AoEquipment. For example, 
to create an event schedule for Inline type equipment, users can decide whether to 
create schedule using the flow time; the time counsumed  to produce one unit from 
the equipment; or to create schedule using the process time of the entity(lot); the 
start-end of the processing time of the entity. The property to use to decide 
whether to apply flow time or process time is the UseProcessingTime. The 
default return value is true which means the schedule is created using process 
time of the entity(lot).

6. GetEqpUpTime : If an Equipment's initial state is Down and the state needs to be 
changed to Up before Simulation ends, the time moment of the change is 
configured in GetEqpUpTime function.

BucketInit Control
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If manufacturing resource in simulation is modeled not with individual equipment but 
through Bucketing, Capacity Bucket is created and it can decide Bucket Capacity. For 
any constraint that can be applied when Bucketing is executed for each Product/Step, 
Bucket can be defined and added according to Bucket Key if it is required.

1. InitializeBuckets : On Bucketing, this creates each Equipment group's(Step 
group's) Capacity Bucket and configures its property. Also if required, Product 
(Step) constraint for a specific Bucket can be created in the form of Bucket.

2. OnCompensate : Standard time of Bucketing Rolling is Factory Start Time. So if 
Simulation begins in the middle of Bucket Rolling Cycle, Bucket Capacity should 
be adjusted by considering Factory Start Time and Rolling Cycle. Default logic 
provided by Library initializes CapacityBucket as if actual output occurs 
proportionally to time progress in a cycle. If user definition is used, this Action 
should be implemented.

Bucketing Property Configuration :
Rolling Cycle property for Bucketing can be configured in Properties window of Visual 
Studio as follows. There are two configurable properties.
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InnerRollingMinutes : Actual cycle of Bucket Rolling is defined in unit of minute. 
Default is 60 minutes. So Rolling occurs every hour.

RollingHour : Duration for Capacity configuration is defined in unit of hour. If 
RollingHours is set to 8 hours as in the above figure, Bucket Capacity also should 
be configured in unit of 8 hours.

Factory Init Control

This component is used to initialize resources in Factory and simulation output, etc.
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1. GetWeightPresets : MOZART SeePlan Library provides default Dispatchers. 
Other default Dispatchers except FIFO Dispatcher, that is, WeightSumDispatcher 
and WeightSortedDispatcher, use Presets. If user uses Preset-based Dispatcher, 
user also should implement evaluation function for each Factor used in the 
corresponding Preset through function of Weights in Simulation Model. In addition, 
Preset information should be configured when dispatching is executed for each 
equipment group (or equipment). This Action initializes Dispatcher by 
implementing a logic to return whole list of pre-defined Presets. If FIFO Dispatcher 
is used, this is not implemented.

2. InitializeInOutAgent : When lots are released into a Line or a section of specific 
Steps, an Agent control is created and added for deciding whether lots should be 
released or not according to the related constraint. In order to create the object 
and configure its execution conditions, InOutAgent class in library is used.

Sample code

// For the release control of lots into production linke, InputAgent is configured. 
// Cycle of Release execution is set to 1 hour. 
// Agent's Key is named as "InputControl". 
public IList<InOutAgent> INITIALIZE_IN_OUT_AGENTS0(AoFactory factory, ref bool handl
ed, IList<InOutAgent> prevReturnValue) 
{ 
    List<InOutAgent> agents = new List<InOutAgent>(); 
    InOutAgent InAgent = new InOutAgent(factory, "InputControl") ; 
    InAgent.Duration = Time.FromHours(1);             
    agents.Add(InAgent) ; 
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    return agents ; 
}

3. GetSecondResourcePools : It creates and returns each SecondResource & 
SecondResourcePool used in Simulation.

4. GetEqpMonitors : It returns a class that implement IEquipmentMonior to collect 
statistics for equipment in simulations. This can be implemented individually and 
can bind definition that is searched in Domain Library.

5. InitializeWipGroup : This defines Group in order to use WIP statistics classified 
by various purposes during simulation.

6. InitializeFilterManager : This FEAction is used to store Filter Key and 
Filter(factor) lists to FilterManager in order to filter lot/wafer before dispatching is 
performed during simulation. Filtering condition for each filter factor should be 
defined through Filters node of MOZART Explorer. In order to use the filter set 
users must return the filter key value through Dispatching > FilterControl > 
GetFilterKey. The corresponding filter set will be called from DoFilter.

Factory Events
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This component lets the user define functions processing events that affect all objects 
in the simulation.

1. OnBeginInitialize : This function is called when simulation initialization begins.

2. OnEndInitialize : This function is called when simulation initialization ends.

3. OnStart :This function is called when the simulation begins after Factory Object, 
which is the whole simulation model, is created. This is used to implement user-
defined logic that should be initialized at the start of the simulation.

4. OnStarted: OnStarted method is called right after the simulation engine starts. 
Implement logic to perform tasks after initiation of the simulation module is 
completed. 

5. OnShiftChange : This function is called when the configured Shift is changed in 
Simulation. This is the first function to be called at the moment of the shift change 
and other tasks will be performed after OnShiftChange is called.

6. OnShiftChanged : This function is called after the configured Shift is changed in 
Simulation. This is the last function to be called after all other tasks are completed 
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at the moment of shift change. In a manufacturing factory, it is usual to see that 
tasks like adjustment of statistics (such as actual output and utilization rate, etc.) or 
initialization of constraints are processed when the work shift is changed. If the 
real model's behavior needs to be modeled in simulation, this action is used to 
implement the corresponding logics.

7. OnDayChanged : Similarly to OnShiftChanged, this action is used to implement 
the logic for updating various information when a day is changed.

8. OnDone : This Action is called when Factory, Simulation's Root Active Object, is 
closed. This time is the same moment when the simulation ends. The related logic 
is implemented.

9. CompareSameTimeEvent : Implement logic to compare the occurrence priority 
among the simulation events with the same event occurrence time based on 
Factory Time. CompareSameTimeEvent is called during the simulation module 
reset.

10. OnException: The FEAction which enables users to write the code to handle or 
control the exception frequently thrown from the library during the simulation. To 
learn more about the frequent thrown exception in simulation and how to 
implement logic in OnException, go here.

Entity

Entity Category consists of 3 components. 2 of them is used to create Simulation 
Entity and the other is Route component that deals with all logic related to routing of 
lots during simulation run.

https://gitbook.vmsmozart.com/releasehistory/-M2gEErBn5tXv6FlSpvb/v/english/2020.118/onexception-a-new-feaction-to-handle-frequently-thrown-library-exception
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WipInit
WipInit is used to synchronize initial state of lots in Simulation with state of WIPs. In 
addition it creates and initializes initial WIPs in Simulation.

InputBatchInit
InputBatchInit is a FEComponent that is used to create new work pieces(lots) to be 
released to the corresponding line according to release plan or release rule. And this is 
also used to process a series of tasks for deciding when the lots is released.

Route
Route deals with controls about lot's process flow from its creation to extiction and 
controls about how to process data at the moment of the state change of lot. Route 
forms inter-relationship with FEComponents of dispatching control and Resource 
control by using work piece(lot) as a medium.

ForwardPeg
If a lot changes its target product during simulation, this FEComponent deals with logic 
to designate the target product for a lot.

WipInit Control
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WipInit is used to synchronize initial state of Lot in Simulation with WIP State 
information. This FEComponent allows users to implement a series of logic related to 
this synchronization. WIP State is classified as Transfer/Wait/Run. If its state is Wait, 
the state can be divided further into a state loaded in an Equipment and a state waiting 
outside of an Equipment.

1. GetWips : This implements a logic that returns a list of WIPs. In order to run 
simulation, this FEAction must be implemented.

2. OnBeginInit : This FEAction is called to apply additional user logic before actual 
initialization of lot is started.

3. CompareWip : For Lots to be initialized, their initialization order can be decided 
according to their state and time information. If a lot is transferring or on standby, 
the lot is not affected by its initializing order. However, if a lot's state is Run or Wait 
in an equipment, the initializing order can be an important factor for its initialization.

Default Logic Example

public int COMPARE_WIP_DEF(IHandlingBatch x, IHandlingBatch y, ref bool handled, int 
prevReturnValue) 
{ 
    if (object.ReferenceEquals(x, y)) 
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    return 0; 
 
    var a = (ILot)x.Sample; 
    var b = (ILot)y.Sample; 
 
    // RUN-INBUF->WAIT->HOLD 
    int cmp = b.CurrentState.CompareTo(a.CurrentState); 
    if (cmp != 0) 
        return cmp; 
 
    return cmp; 
}

4. IsSkipWipLocating : If information for initializing lots is not enough or errors in 
processing data exist, a logic should be implemented to filter the corresponding 
lots instead of being initialized. This Action is processed for each lot individually. If 
a lot is not initialized, it is made a decision for the initialization of the next lot in 
order.

5. IsSplitBatchForNotRun : This FEAction is used to decide whether to split and 
handle the batches into lots that are not in RUN state. The default value is true so 
any batches not in RUN state will be split to lots and initialized. Return false to 
maintain as batches.

6. LocateForOthers : When initial WIPs is initialized. WIP may be in HOLD state. 
Also the current step may be processed by Bucketing. Or a Lot may not be 
normally initialized in a normal state like Wait/Run/Transfer. LocateForOthers is 
used to initialize these kinds of lots. In this case, the corresponding lot should be 
initialized with user specific logic.

7. OnBeginLocateWip : This Action is called when lots in a normal state is initialized 
for each state. Any user-defined logic that is required for this case is implemented 
in OnBeingLocateWip. If a lot's state is RUN, this Action can be used to configure 
Second Resource or Lot's property.

8. LocateForDispatch : This is used to implement a logic to set a lot to WAIT state.

Default Logic Example

public void LOCATE_FOR_DISPATCH_DEF(AoFactory factory, IHandlingBatch hb, ref bool h
andled) 
{   
    if (hb.IsFinished) 
    { 
        factory.Router.AddInitial((Entity)hb, hb.IsFinished); 
    } 
    else 
    { 
        var router = EntityControl.Instance; 
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        string dispatchKey = router.GetDispatchingKey(hb); 
        DispatchingAgent da = factory.GetDispatchingAgent(dispatchKey); 
        if (da == null) 
            throw new InvalidOperationException("DispatchingAgent is not registerd,
 check 'Route/GetDispatchingKey' implementation"); 
        da.Take(hb); 
    } 
}

9. LocateForRun : This is used to implement a logic that deals with lots in Run state 
initially. Library provides a default logic and GetLoadingEquipment and 
CheckTrackOut Action are used in this logic. If user defines this Action 
separately, implementation in these 2 Actions is not used.

Default Logic Example

public void LOCATE_FOR_RUN_DEF(AoFactory factory, IHandlingBatch hb, ref bool handle
d) 
{ 
    var wipInitiator = ServiceLocator.Resolve<WipInitiator>(); 
    AoEquipment eqp = null; 
    string eqpID = wipInitiator.GetLoadingEquipment(hb); 
 
    // Lot is in RUN state but its processing has been completed. Check out whether
 the lot's location is Outport or not. 
    bool trackOut = wipInitiator.CheckTrackOut(factory, hb); 
 
    if (string.IsNullOrEmpty(eqpID) || factory.Equipment.TryGetValue(eqpID, out eqp) 
== false) 
    { 
        // No equipment, then proceed bucketing 
        factory.AddToBucketer(hb); 
        Logger.Warn("Eqp {0} is invalid, so locate running wip to dummy bucket. chec
k input data!", eqpID ?? "-"); 
    } 
    else 
    { 
        if (trackOut) 
        { 
            eqp.AddOutBuffer(hb); 
        } 
        else 
        { 
            eqp.AddRun(hb); 
        } 
    } 
}

10. GetLoadingEquipment : If a lot is being loaded, it is implemented a logic that 
returns ID of Equipment that the lot is being loaded onto. This Action is a 
fundamental function that should be implemented if the lot's initial state is Wait or 
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Run after it was loaded onto an equipment. This Action is not called if 
LocateForRun is redefined.

11. CheckTrackOut : This is used to implement a logic that decides whether a lot in 
Run(processing) state has actually completed or not. Processing start time of the 
lot is considered. This Action is not called if LocateForRun is redefined.

12. FixBatch : This is used to deal with the case of when WIP in Run state initially do 
not match with Equipment's processing type(Batch). For example, while an 
equipment is Batch Type, work piece may consists of a single unit or vice versa. In 
this case, logic should be implemented to make valid data which can be processed 
in the system. After this, the data is initialized in the logic. This function is not 
called if LocateForRun function is redefined.

Default Logic Example

public virtual ISimEntity FIX_BATCH_DEF(AoEquipment aeqp, ISimEntity entity, ref boo
l handled, ISimEntity prevReturnValue) 
{ 
    if (aeqp.IsBatchType() && (entity is BatchEntity) == false) 
    { 
        BatchEntity lbatch = new BatchEntity(); 
        lbatch.Contents.Add(entity); 
        entity = lbatch; 
    } 
 
    return entity; 
}

13. FixStartTime : This function deals with the case when WIP initially in a Run state 
doesn't have correct starting time. If the time difference between a lot's processing 
starting time and current time(Simulation starting time) is not within the range of 
processing time at the current Step and normal processing time, the lot's starting 
time or state information is considered as abnormal. So it is implemented a logic to 
redefine initial states of the corresponding lot and equipment according to Rule. 
This Action is not called if LocateForRun is redefined.

Default Logic Example

public virtual DateTime FIX_START_TIME_DEF(AoEquipment aeqp, IHandlingBatch hb, ref
 bool handled, DateTime prevReturnValue) 
{ 
    return aeqp.NowDT; 
}

14. OnEndLocateWip : This is called after an individual WIP is initialized.



MOZART IDE (ENG) 189

15. OnEndInit : This FEAction is called after all initialization of WIPs are completed.

InputBatchInit Control

InputBatchInit is a FEComponent used to create new lots that are going to be released 
into a Line according to Release plan or Rule and decides the relese time point of lots. 
Normally, lots are created according to release plan and release quantity and time are 
decided by considering capacity of bottleneck equipment at release step, release 
quantity, and release batch size, etc. However, if lots to be released is decided in a 
relatively short cycle by using a separate InputControl or no additional lots are 
released due to a specific simulation characteristics, this Control is not implemented.

The following shows Actions in InputBatchInit and their order.

1. Instancing : This creates lots to be released. If BatchInitiator is used, each 
product's daily release target or release plan becomes input for Instancing.

2. CompareLot : The information of Lots created by Instancing is sorted in release 
order.

Default Logic Example
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public int COMPARE_LOT_DEF(ILot x, ILot y, ref bool handled, int prevReturnValue) 
{ 
    if (Object.ReferenceEquals(x, y)) 
        return 0; 
    return x.ReleaseTime.CompareTo(y.ReleaseTime); 
}

3. OnBeginReserve : It is implemented a logic that requires pre-processing before 
registering lots as release target.

4. DoReserve : A list of lots that are target of release is registered to 
Factory.BatchRelease for release reservation. Factory.BatchRelease releases 
each registered lot into a line when its reserved release time is met. Library 
includes this Action as a basically implemented component and calls ReserveOne 
Action. Therefore, if user defines a new logic into this Action, implementation in 
ReserveOne Action is not used.

Default Logic Example

public void DO_RESERVE_DEF(List<ILot> lots, ref bool handled) 
{ 
    var batchInitiator = ServiceLocator.Resolve<BatchInitiator>(); 
 
    int index = 0; 
    while (index < lots.Count) 
    { 
        batchInitiator.ReserveOne(lots, ref index); 
    } 
}

5. ReserveOne : It is implemented a logic required to handle each lot when lots are 
individually registered for reserving release. This Action is not used if DoReserve 
is redefined.

Default Logic Example

public void RESERVE_ONE_DEF(List<ILot> lots, ref int index, ref bool handled) 
{ 
    var batchInitiator = ServiceLocator.Resolve<BatchInitiator>(); 
 
    batchInitiator.Reserve(lots[index]); 
    index++; 
}

6. OnEndReserve : This is called after all target lots for release are registered. At 
this moment, any additional logic can be implemented if necessary.
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Route Control

Route is a FECompoent handling a series of logic related to decision about lot's 
routing and processing state during whole simulation cycle. The following figure shows 
a flow of FEActions processed in Route. Route does not handle consecutive logic but, 
is a set of Actions processing logic for main events in order to deal with property of 
lots. Although some actions may maintain consecutiveness in processing logic events 
that handle most of Actions are called intermittently.

The following figure shows Route's actions according to their execution order when 
each action is called.
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A lot is processed by an equipment or Bucket at each Step. When current Step's 
processing was completed, a lot decides routing for the next Step. At this moment, the 
lot can be split into smaller lots or merged with other lot. If any following Step exists, 
the lot is transferred to the Step by logistics rule and waits. Otherwise, the lot is 
removed. These procedures are processed by the following FEActions. User can 
implement an user-defined logic using these FEActions in order to process routing of 
each lot.

When WIP is initialized and new lots are released
1. OnAddWipManager : This function is called when a Lot is added to WipManager. 

When WIP is initialized and new lots are released, the lots are automatically added 
to WipManager. If a new lot is created as a result of Split or Merge during 
simulation, user needs to add the new one to WipManager. And it is called when 
the lot is added.

2. OnRelease : This action is called when a lot is released into a line so that user can 
implement user's logic to reflect information at the moment to lot property or to 
collect statistics.
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When Routing begins after Transfer has completed
1. IsInputControl : This decides whether a lot is released into the current step or 

not. If it returns true, this requests a Key value for InOutAgent that is going to be 
used as GetInputControlKey function.

2. GetInputControlKey : This return a Key value for InOutAgent that deals with 
release control if lot release control is requireds. Returned Key value is a key of 
target Agent among InOutAgent's created through 
Factory>FactoryInit>InitializeInOutAgent function. Lots are released into a 
registered InOutAgent which has the same Key.

3. GetLotDispatchingKey : This action selects a controller for lot dispatching. If only 
one Dispatching Controller is used, this is only used to distinguish normal loading 
from Bucketing. But, if Dispatching is applied for equipment group, it is required a 
rule that chooses a Dispatching Controller according to lot's current Step. This is 
implemented in this FEAction.

When Dispatching begins
1. OnDispatchIn : This action selects a Controller that handles Lot Dispatching. If 

only one Dispatching Controller is used, this is only used to distinguish normal 
Loading from Bucketing. But, if Dispatching for equipment group is processed, the 
Rule to choose a Dispatching Controller according to lot's current Step is required. 
This FEAction is used to implement this logic.

2. PrePegging : Before a lot is dispatched, it may require an information about which 
demand the lot can be mapped with. The reason is that dispatching prioirty or 
processing of the corresponding WIP can be decided by target of each product. 
PrePegging is actually processed after Entity>ForwardPeg Control has 
completed. In PrePegging is implemented a code that change Product or Step 
according to target information in Lot

Example. PrePegging Code

// Implementation of PrePegging 
public void PREPEGGING_0(IHandlingBatch hb, Step step, object key, ref bool handled) 
{ 
    var slot = hb as SiteLot; 
    // Key is StepPlan's Key and assumes Product information 
    // If Lot's Product information is different from StepPlan's Key that is a Targe
t of Forward Pegging, Product information is changed 
    if (slot.Product != key) 
    { 
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        slot.Product = key as SiteProduct; 
        slot.Route = slot.Product.Process as SiteProcess; 
        // If Step info. is changed with Producud change, reflect this 
        if (slot.CurrentStep != step) 
        { 
            var newPlan = EntityControl.Instance.CreateLoadInfo(slot, step); 
            slot.SetCurrentPlan(newPlan); 
        } 
    } 
}

3. GetLoadableEqpList : This is used to implement a logic for searching and 
returning a list of equipment that normal lot objects can be loaded onto.

4. GetLoadableEqpList2: If no equipment is loadable in normal condition, it provides 
a list of alternative loadable equipment.

💡 Note 
If control for loading is managed in a unit of equipment group by mapping 
Step & Equipment with equipment group, it is possible to provide a list of 
equipment in an alternative equipment group that can process the same 
step when default equipment group is overloaded or equipment in the group 
has problems.

When Dispatching ends
1. OnDispatched : This action is called when a lot has been selected. Normally after 

the selection is done, conditions or constraints that were set to Lot for this 
selection are updated.

2. ConfirmPegging : For Dispatching, ConfirmPegging is used to confirm Pegging 
information processed by F/W Pegging. Library provides default logic for this 
confirmation. If user needs to process any additional logic, this function should be 
implemented with the new logic. Default processing includes 1) Subtracting a 
pegged quantity from Target of PegInfoList which is configured in Lot's 
CurrentPlan, and 2) Deleting PegInfoList configured in Lot's CurrentPlan.

When the current step's task begins
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1. OnStartTask : StartTask is used to implement a logic that handles the beginning 
of a Step when a lot begins to be processed. Although actual task is begun by an 
equipment, lot should be updated with information to be processed in the 
beginning of the task. This action can be called when Equipment loading or 
bucketing is processed and has the same handling method. While SeePlan Library 
deals with triggering of basic tasks, user can implement this Action to handle 
additional properties in lot.

2. OnCreateDummy : This FEAction is used to define logic to create dummy lots. 
Equipment state can change to PM or Down during lot processing. The processing 
lots should continue to be processed when equipment state is changed to UP state 
again. In this case, the loading history of the reloaded lot should not be duplicated 
with the first loaded lot history. Dummy lot is created and reloaded to avoid this 
situation.

When the current step's task was completed
1. OnEndTask : When a lot has completed its task, OnEndTask is used to implement 

a logic that deals with the completion of a Step.

2. StepChange: When a lot has completed the current Step, StepChange is used to 
implement a logic that searches the next Step for the lot. At MoveNext, lot can be 
split into several lots by Part change. StepChange is also used to implement user 
rule for this split. Also MoveNext is called before Entity is physically moved in 
order to configure the next Step of the lot. Then, it calls IsDone function.

3. GetNextStep : This returns a lot's Next Step on process flow. If a standard 
process is defined for each product, Next Step is returned from the process. 
However, if a certain Step should be skipped or Next Task is decided by special 
logic, user-defined logic is implemented.

Default Logic Example

public Step GET_NEXT_STEP_DEF(ILot lot, LoadInfo cLoadInfo, Step cStep, DateTime no
w, ref bool handled, Step prevReturnValue) 
{ 
    Step next = cStep.GetDefaultNextStep(); 
    return next; 
}

4. CreateLoadInfo : A code is written to create a LoadInfo for a new Step configured 
in a Lot. LoadInfo, one of properties of Lot, is recorded for every step where a lot is 
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processed during simulation and saves information at that moment when a lot is 
processed. Basically it includes information such as resource that has processed 
the lot, starting time, and completion time, etc. Also user can add new property by 
inheriting and redefining LoadInfo through functions of My Objects. 
CreateLoadInfo is automatically called from Simulation Library when Step is 
changed. However, if user needs to change CurrentPlan of the current Lot at the 
random time moment, Lot's SetCurrentPlan function can be used.

5. IsDone : This is called after MoveNext or when WIP is initialized. At the 
Initialization of WIP, IsDone is called in order to decide whether a WIP has 
completed all Steps on Step route or not. Also if a lot can't find a next Step on Step 
route when MoveNext has been processed, usually it means all tasks for the lot 
has been completed. Therefore, this lot can be removed, too. For this kind of 
situation, IsDone is implemented to indicate the WIP can be removed from Factory 
on simulation.

Default Logic Example

public bool IS_DONE_DEF(IHandlingBatch hb, ref bool handled, bool prevReturnValue) 
{ 
    return hb.IsFinished; 
}

6. OnDone : OnDone is called when a lot is processed for all tasks in a Line. User-
defined logic can be implemented for statistics collecting

7. OnDeleteWipManager : When Lot's all tasks are completed and the Lot is 
removed, OnDeleteWipManager is called after the Lot is deleted from 
WipManager. This is used for logic verification.

The relationship among actions of the related control is illustrated as follows.



MOZART IDE (ENG) 197

ForwardPeg Control

ForwardPeg is a FEComponent to control the procedure to decide a target product 
when there are multiple alternatives as target product of a lot at a specific Step. This 
logic is executed before a lot, which has arrived at the Step, searches and starts to 
wait for a loadable equipment

The following figure shows the order that FEActions included in ForwardPeg is 
executed.
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When the simulation run begins
1. InitStepPlanManager : This Action initializes StepPlanManager. It can process 

StepPlan and StepTarget which are added by Pegging module's WriteTarget Rule 
or can add new StepPlan and StepTarget. Here, StepPlanManager is a class to 
manage Step targets, which are generated by Backward pegging, for the usage in 
Forward Pegging

When Forward Pegging begins (When a lot comes into 
DispatchingAgent)
1. GetStepPlanKeys : This action returns a list of Keys that is used for searching 

StepPlan for lots. If a StepPlan with the first Key exists, Forward Pegging Logic 
uses the corresponding StepPlan. Otherwise, StepPlan with the next Key is used. 
If no StepPlan is found for all Keys, Forward Pegging logic is not executed.

2. GetForwardPeggingQty : This action returns the quantity that can be pegged to a 
specific Target during Forward Pegging. Generally if Target is large enough, all lots 
can be pegged. However, if not all lots can be pegged, pegging quanity should be 
configured.

3. GetForwardPeggingQtyOfKey : This action returns the quanity of lots that can be 
pegged for each key in GetStepPlanKeys. It might be possible to peg all lots of 
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each key in StepPlanKey. However, it is also possible to control the pegging 
quanity for each Key. The maximum possible pegging quantity cannot exceed 
GetForwardPeggingQty.

4. CompareStepTarget : If a lot has multiple StepTargets as a possible pegging 
targets, their priorities are defined.

5. FilterStepTarget : This action checks whether a lot cannot be pegged to 
StepTarget. This is evaluated for every possible Target. If it returns true, the 
StepTarget is filtered.

💡 Note
Forward Pegging is executed when the above 4 Actions have been 
processed and decides Target for each lot. In this case, if the pegged 
Product is different from Product of current, it is conducted a task that 
changes Product through Entity>Route>PrePegging function and leaves 
log.

InOutControl Control

InOutControl is a FEComponent used to decide release quantity according to release 
target and constraint, select lots to be released, and control their release for a specific 
section or line. When lots are released for the first time, lots are usually created and 
released into the system based on release Target. However, if it should be decided 
whether a lot should be put into following steps at a specific step or not, lots are 
gathered and the decision is periodically made by considering the section's capacity 
and constraint through Entity>Route>IsInputControl, GetInputControlKey 
functions.
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1. InitializeControl : This process a logic to initialize InOutAgent.

2. OnEnterControl : This is called when a lot is fed into Agent for lot's release 
control. This is used to write a task log, edit released lot's property, or collect 
statistics, etc.

3. IsWaitToSelect : If a lot is fed into Agent for lot's release control, this decides 
whether the lot should wait or not when it is not in the Agent's execution cycle.

4. OnBeginRun : This is called when Agent begins to execute a logic that 
selects(creates) target lots for release.

5. RunAgent : Implement logic for Agent. Logic can be implemented by 2 kind of 
methods.

When lots are released into the system for the first time : Lots are created and 
released up to possible release quantity which is decided from release target 
for each product. If target lots for release have been already created, logic that 
doesn't include lot creation is implemented.

When lots are released: Selects releasable lots by checking priority and 
constraints for lots which is fed into the Agent and is waiting for their release.

6. GetTimeToRelease : The entity returned from RunAgent, exits InOutAgent right 
after RunAgent executes. Implement the logic to GetTimeToRelease to specify 
the delay time to exit from InOutAgent. But first, add the lots to 
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InOutAgent.AddToRelease(). GetTimeToRelease method is called in case lots 
exists in AddToRelease. So basically the lots to delay the exit from InOutAgent 
goes to AddToRelease and the time to wait in AddToRelease to exit InOutAgent 
is set from GetTimeToRelease.   

7. OnExitControl : This is called when a lot, which is returned by RunAgent logic, 
leaves Agent.

8. OnEndRun : This is called just after Agent's logic execution has completed.

The following figure illustrates the operation of InOutAgent control. The name and the 
execution cycle of InOutAgent is made during Factory initialization. When the lot enters 
to the InOutAgent, the decision to release the lot is made during the InOutAgent cycle. 
Sometimes the decision to release the lots concerns which lines to release to. In this 
case, the lots are held in Releaser. The lot exits from Releaser at the specified time 
and enters the designated line for production.

MergeControl Control

MergeControl is a Component to support users to develop series of logic to Merge 
entities that are split due to Step criteria or other reasons to one entity. Entity Merging 
can occur from several FEActions so it is designed to let users call AoFactory.Merge() 
function. In addition, if Merge function is called, the entities can be returned through 
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MergeControl so it is possible for the users to make the decisions of the tasks to be 
held for the entities.

1. GetMergeableKey : This gathers each keys of the entities to be merged and used 
to identify and classify the entities. If the key value is set as Null, the 
corresponding entity of key is not merged and passed.

2. OnEnterControl : This FEAction is used to write results or configure the entities to 
be merged. This is called if GetMergeableKey is not Null and registers the entities 
to MergeControl.

3. Merge : This merges the target entities to be merged. The entities are determined 
whether to be merged and if the criteria are met the entities are merged and 
returned. The logic should be implemented to return null if no entities are merged, 
or else, to return the merged entities if the entities are merged.

4. DisposeEntities : This Action is used to remove merged entities from the Merge 
candidate list. If the merged entities are required to be removed from the Merge 
candidate list, this Action searches and returns the targets to be removed. If there 
are no corresponding entities to be removed, Null is returned. When Merge 
FEAction is called this refers to the Merge candidate list, so if the merged entities 
are not removed from the list without additional handling, the entities can be 
duplicated.

5. OnExitControl : This FEAction is performed after Merging is completed.
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Transfer

This category is used to control From-To location transfer of a lot. Dependent on the 
requirement drawn from analysis of lot transfer, Lot transfer can be designed as a 
simple Model or as a sophisticate transfer control Model that uses interface with an 
external logistics simulation tool. The following figure shows components of Transfer 
Category.

TransferControl
After a lot has completed the current step and the next Step is configured, the lot's 
transfer is handled by this control.  If objective is to collect statistics related to lot 
transfer (such as average transfer time, average number of lots in queue, etc.), logic 
can include more detailed information in a Model. Otherwise, transfer Model can use a 
logic that considers simply transfer time which is designed as Delay.

TransferSystemInterface
If lot transfer is simulated with more detailed information, an interface logic can be 
implemented to TransferSystemInterface to perform manufacturing simulation by 
linking transfer simulation.

TransferControl Control

TransferControl is a FEComponent for controlling a lot from the start until the end of lot 
transfer. In automated manufacturing line, lots are transferred through AMHS 
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(Automated Material Handling Systems) and TransferControl plays a role of AMHS. 
Surely this TransferControl can be used to model a material handling system where 
some transfer is processed by workers due to low level automation. Only differences 
are who makes the transfer decision and who executes transfer of lots. 
TransferControl is used to design a relatively simple material handling system which 
only considers transfer time.

Lot's next step is decided by Step Route after the lot has completed the current step. 
Simulation's Transfer control model searches for next Step's location and calculates a 
transfer time based on Step & Equipment information about the current and destination 
step. Transfer of a lot is completed after the calculated transfer time has elapsed. 
Then, information such as lot's final location and other properties are updated and 
necessary statistics are collected.

TransferControl is used to execute time-based transfer control to handle transfer of lots 
among steps without a connection to external material handling system.

1. SetDestination: This action is used to implement a logic to decide the destination 
of a lot based on information of step and loadable equipment before its transfer 
begins.

2. OnTransfer: In the beginning of transfer, this FEAction is called for collecting 
transfer-related statistics and changing property of lot.
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3. GetTransferTime: This action calculates and returns transfer time. A calculation 
logic for transfer time between from-to locations is implemented according to user 
definition. In simulation model, transfer is modeled by holding a lot in the beginning 
of the transfer and releasing the lot after a given transfer time.

Default Logic Example

public Time GET_TRANSFER_TIME_DEF(Mozart.SeePlan.Simulation.IHandlingBatch hb, ref b
ool handled, Time prevReturnValue) 
{ 
    SeeplanConfiguration conf = ServiceLocator.Resolve<SeeplanConfiguration>(); 
    return Time.FromMinutes(conf.TransferTimeMinutes); 
}

4. OnTransfered: This action is called when a lot arrives at the destination. A logic 
can be implemented to collect transfer-related statistics and change lot property.

The following shows correlation between actions of related controls.

TransferSystemInterface Control

If there are many issues about distribution or capacity verification of transferring 
equipment, more sophiscated modeling for transferring system is required to address 
those issues in simulation. There are various systems that provide transportation 
simulation including automated material handling equipment such Crane, AGV, and 
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Conveyor, etc. and logic to control those equipment. MOZART Engine can interwork 
with these simulation system in order to reflect more realistic transporting system 
models.

To interwork with external logistics simulation system, first register the corresponding 
external system. Then, implement logic for inteworking through the following two 
FEActions in Transfer control. TransportAdapter is automatically created when the 
system is registered. Please refer to the manual to see how to register 
ITransportSystem.

1. MoveRequest : A logic needs to be implemented to make a transfer request to 
External Transport System. MoveRequest in Transport Adapter object is used for 
this.

2. OnDelivered : This FEAction is called when lot transfer has been completed in 
external transport simulation system. So this FEAction terminates transfer with 
respect to lots which were placed in TransportAdapter while being transferred by 
the external transport system.

Default Logic Example

public void ON_DELIVERED_DEF(TransportAdapter ta, string key, string sourceLocation, 
string targetLocation, ref bool handled) 
{ 
    // Lot has to be searched using the key value but not quite sure if the logics s
hould be implemented here. 
    ISimEntity entity = ServiceLocator.Resolve<ISimEntity>(); 
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    if (ta.Fifo.Contains(entity)) 
    { 
        ta.Factory.Transfer.TakeOut(entity); 
    } 
}

3. OnCstResponse : This action is used to implement a logic that should be 
executed when transport request of Lot Container (Cassette) is responded.

Dispatching

Dispatching Control Category consists of 3 parts such as QueueControl, FilterControl 
and DispatcherControl. 1) QueueControl is used to control a lot when the lot 
arrives at a Step. 2) FilterControl leaves only target lots for Dispatching by 
examining the condition of lot and equipment in the beginning of Lot 
Dispatching. 3) DispatcherControl evaluates lot's priority and selects lot with the 
highest priority for Dispatching. If Dispatching evaluation is processed only for 
waiting lots, it is difficult to make a schedule that considers incoming lots or the 
capacity/loading status of the following Step. Therefore, to decide the moment when 
Job Change is made while considering capacity balance between previous step and 
following step, its logic might be implemented together with JobChangeAgent.

Dispatching control has two trigger events. One event is arrival of a lot and the other is 
when an equipment selects a lot(Dispatching). If a lot can be directly loaded into a 
loadable equipment on its arrival at a Step, events to select the lots occur 
consecutively. However, if no loadable Equipment is available because all of them are 
in use or in Down state, the lot should wait until any loadable equipment become 
available. If an equipment become Idle, a Dispatching event occurs. Then, after logic 
in DispatchFilterControl and DispatchControl are sequentially processed, this control is 
terminated.

The following diagram illustrates components of Dispatching Category.
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QueueControl
When a lot has arrived from the previous Step, this FEComponent is used to control 
the lot. This control ends when the lot is allocated to an equipment's Queue.

FilterControl
On dispatching, if a lot can't be processed due to some dispatching condition for an 
equipment or constraints, FilterControl excludes the lot from candidate lot list for 
dispatching.

DispatcherControl
When an equipment has to select a lot, waiting lots' priorities are evaluated and a lot is 
selected according to the evaluation result and Equipment's processing method. This 
is implemented in DispatcherControl.

FilterControl Control

FilterContorl is a control logic to select either new lots arrived to the equipment on 
standby or select the next processing lot when an equipment has completed its work. 
This can reflect Dispatching constraints for both equipment and lot perspective.
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If an event to select lot by an equipment occurs, the following FEAction checks 
whether Dispatching should be executed or not.

1. IsPreventDispatching : Prohibit dispatching if PM(Preventitive Maintenance) of 
equipment is in processing or has been scheduled within a certain time limit. Also 
if equipment has the constraints on processing, dispatching is not executed.

Sample Code

// 
public bool IS_PREVENT_DISPATCHING0(AoEquipment aeqp, IList<ISimEntity> entities, Ti
me waitDownTime, ref bool handled, bool prevReturnValue) 
{ 
    // Do not select new lot if the equipment downtime is whitin 10 minutes. 
    if (waitDownTime <= Time.FromMinutes(10))            
        return true; 
    return false; 
}

2. CheckReservation : This checks whether an equipment has any reserved lot. If 
there is any reservation, priority evaluation for lots is skipped and the equipment 
should select one of the reserved lots. User can define a user logic related to this 
in CheckReservation.
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3. SetFilterContext : Before evaluating filtering conditions with respect to waiting 
lots, SetFilterContext calculates a reference value used in common for evaluating 
all lots and saves it to DispatchContext.

💡 Note 
DispatchContext : DispatchContext has a role like storage for 
reference values which is used for implementing FEActions during 
Dispatching. So all FEActions of FilterControl and DispatcherControl 
uses DispatchContext. Each value is configured with 'Key" and referred 
by the Key. For more details, please check Reference Library.

4. DoFilter : This function executes filtering task with respect to lots that is actually in 
Wait state. This is a default function implemented in Library. If user redefines this 
function, "IsLoadable" function is not called.

Default Logic Example

public virtual IList<IHandlingBatch> DO_FILTER_DEF(AoEquipment eqp, IList<IHandlingB
atch> wips, IDispatchContext ctx, ref bool handled, IList<IHandlingBatch> prevReturn
Value) 
{ 
    var filterControl = DispatchFilterControl.Instance; 
    filterControl.SetFilterContext(eqp, wips, ctx); 
    for (int i = wips.Count - 1; i >= 0; i--) 
    { 
        var hb = wips[i] ; 
                filterControl.SetLotCondition(eqp, hb, ctx); 
                if (filterControl.CheckSecondResouce(eqp, hb, ctx) == false) 
                { 
            wips.RemoveAt(i); 
            continue; 
                } 
                if (filterControl.CheckSetupCrew(eqp, hb, ctx) == false) 
                { 
            wips.RemoveAt(i); 
            continue; 
                } 
                if (filterControl.IsLoadable(eqp, hb, ctx) == false) 
                { 
            wips.RemoveAt(i); 
            continue; 
                } 
    } 
    return wips; 
}
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5. SetLotCondition : When QueueControl logic is processed, lot's some properties 
are still not configured because it is unknown which equipment will process the lot 
actually. However, when FilterContorl Logic is processed, decision about target 
equipment is already made so the final processing condition for the lot can be 
confirmed. This FEAction is used to implement the code configuring the final 
processing condition for each lot. Usually these properties are configured in each 
lot and later they are used as reference values when FEActions of Loadable & 
DispatcherControl, that implements Filtering Main logic, are implemented.

6. GetFilterSetKey : This FEAction is used to return the Filter Key to decide whether 
to filter the lot not to be loaded to the equipment using the filter conditions in 
FilterSet. If Filter key exists, DoFilter FEAction decides to filter the lot according to 
each filter conditions in the filter set correspondent to the filter key. In case there is 
no filter key found, DoFilter will call IsLoadable FEAction.

7. IsLoadable : This is an FEAction that filters lots that can't be processed at the 
current moment and lot and leaves only processable lots according to properties of 
equipment. User can add a Loadable logic which reflects various constraints. 
When filtering is executed, Basic Filtering conditions such as availability of 
SetUpCrew or of SecondResource are reflected. In order to execute logic 
normally, functions such as  Equipment>SetupControl>IsNeedSetupCrew and 
SecondResource>ToolControl>IsNeedToolSettings needs to be implemented. 
If user redefine DoFiter, IsLoadable is not called.

 The following shows correlation between actions of related controls.
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QueueControl Control

When a Lot arrives at a Step, normally it searches for loadable equipment at the step 
and waits until it is selected through evaluation for dispatching or any loadable 
equipment becomes available. However, depending on the lot's condition, the lot may 
be held during a certain amount of time at the step, can be split into several lots, or 
can be merged together with other lots. If the corresponding lot has specific equipment 
reserved, the lot should be directly loaded onto the equipment by skipping the normal 
processing order.

QueueControl is a FEComponent to control a sequence of tasks that is processed on 
the arrival of a lot at a Step. The following FEActions are called in the order and the 
user can redefine these FEActions according to operating methods of the site where 
MOZART is implemented.

1. IsHold : This is used to check whether a lot is in the HOLD state at the current 
Step or not.
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2. OnDispatchIn : This is called before a lot executes the following logic in 
QueueControl. This is used to write a code that changes the state of the lot or of 
other information required at this moment.

3. GetHoldTime : If IsHold is 'true', holding time should be decided. This FEAction 
examines the corresponding lot's property and calculates & returns a hold time. 
After holding a lot during the time length, the lot repeats all logic in QueueControl.

4. OnHoldExit : This Action is processed when the lot has entered Dispatching 
Queue after HOLD period.

5. InterceptIn : A logic is implemented to check if the lot has to be merged or is 
eligible for exception condition and to excludes the lot if necessary. If the result of 
Action is true, the lot will not be processed through the logic afterwards but it will 
be separately processed.

6. IsBucketProcessing : This is used to decide whether a lot should be processed 
by Bucketing at the current step or not. If Bucketing is used, the following logic in 
QueueControl is not executed. Bucketing uses the Bucketer defined in Library so 
the user doesn't need to write any separate code.

7. FilterLoadableEqpList : If there is any constraint on the list of loadable 
Equipment, this is used to exclude the Equipment from the list of loadable 
equipment.

8. OnNotFoundDestination : This is used to define a logic to process a lot if the lot 
has to be processed by the equipment but no loadable equipment is available. 
Normally this is caused by the improper configuration or no update of Master data. 
Therefore it is possible to define a rule to process the lot through TAT-based 
Bucketing at the corresponding Step. However, the user can make the lot not be 
processed but wait until simulation ends in order to analyze the problem that 
master data and simulation have. The following shows an example to process 
Bucketing.

Sample Code

public void NOARRANGE_HANDLER(DispatchingAgent da, IHandlingBatch hb, int destCount, 
ref bool handled) 
{ 
    var lot = hb.Sample as Lot; 
    //If no loadable equipment is available, a lot is processed through Bucketing 
    if (destCount == 0 && 
        SemiEdsConfiguration.Instance.NoArrangeMove) 
    { 
        da.Factory.AddToBucketer(hb); //Define processing logic in Bucketing 
    } 
}
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The following shows relationships between the actions of related controls.

DispatcherControl Control

When an equipment looks for the next lot to be processed, DispatcherControl is used 
to evaluate loadable and not filtered lots, decide their priority, and select one among 
these lots according to the equipment's Processing type. This FEComponent 
corresponds to RTD(Real Time Dispatcher) in real system and consists of the following 
FEActions.
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1. RetryLotGroup : This FEAction is used to regroup the lot group before 
dispatching begins. This action is related to GetLotGroupKey of QueueControl 
FEComponent.

2. SortLotGroupContents : This FEAction is used to sort the lots in LotGroup by lot 
priority. When a certain Lot Group selected during dispatching, this action is 
required to select the lot with the highest priority within the Lot Group.

Default Logic Example

public IList<IHandlingBatch> SORT_LOT_GROUP_CONTENTS_DEF(DispatcherBase db, IList<IH
andlingBatch> wips, IDispatchContext ctx, ref bool handled, IList<IHandlingBatch> pr
evReturnValue) 
{ 
    return db.WeightEval.SortLotGroupContents(wips, ctx); 
}

3. UpdateContext : UpdateContext generates reference values for each lot all 
together instead of calculating separately for each lot and saves the values into 
DispatchContext. These values include the current status of target equipment and 
equipment group for Dispatching (such as product loaded in each equipment, the 
number of waiting lots, etc.) and group property of waiting lots (such as status of 
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equipment allocation for each product, etc. ). This task can contribute to reducing 
time for distpatching.

4. GetLotBatchType : If a lot is Batch type, this lot can be bound with other lots as a 
BatchType configured by this Action. This can be done before processing lots that 
comprises HandlingBatch in Library when dispatching has processed. The code is 
written to return an user-defined Batch Lot Type.

5. OnDispatch : It is used to implement logic that should be processed before each 
lot's priority is evaluated.

6. DoSelect : This is Dispatcher's main function and has been implemented in library 
to call Evaluate or Select function explained below. If DoSelect is redefined, 
Evaluate or Select should be redefined with logic to reflect the change.

Default Logic Example

public IHandlingBatch[] DO_SELECT_DEF(DispatcherBase db, AoEquipment aeqp, IList<IHa
ndlingBatch> wips, IDispatchContext ctx, ref bool handled, IHandlingBatch[] returnVa
lue) 
{ 
    var control = DispatchControl.Instance; 
    if (wips.Count == 0) 
        return null; 
    var lotList = control.Evaluate(db, wips, ctx); 
    var evalLots = new List<IHandlingBatch>((int)(lotList.Count * 1.5)); 
    foreach (var entity in lotList) 
    { 
        if (entity is LotGroup<ILot, Step>) 
                { 
            evalLots.AddRangeCast(entity.Contents); 
                } 
                else 
                { 
            evalLots.Add(entity); 
                } 
    } 
    var selected = control.Select(db, aeqp, evalLots); 
    if (control.IsWriteDispatchLog(aeqp)) 
        aeqp.Target.EqpDispatchInfo.AddDispatchInfo(evalLots, selected, aeqp.Target.
Preset); 
    return selected; 
}

7. Evaluate: This function sorts lots by evaluating their priority. If 
WeightSumDispatcher or WieghtSortedDispatcher in SeePlan library is used, no 
other implementation is required except for providing Preset as Input and 
implementing Factor method that comprises Preset.

Default Logic Example
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public IList<IHandlingBatch> EVALUATE_DEF(DispatcherBase db, IList<IHandlingBatch> w
ips, IDispatchContext ctx, ref bool handled, IList<IHandlingBatch> returnValue) 
{ 
    if (db is FifoDispatcher) 
        return wips; 
    if (db.Comparer == null) 
        return wips; 
    return db.WeightEval.Evaluate(wips, ctx); 
}

8. Select: Batch processing equipment selects target lot among lots that are sorted 
according to priority decided by processing method or step handling method of the 
equipment. Generally equipment manages information about processing condition 
related to comprising a Batch based on task type as master data. Also since batch 
processing equipment's processing time is normally very long, it is common to 
implement a logic to decide whether a batch equipment should form a batch with 
only on-hand lots to start its processing or whether the equipment has to wait for 
the incoming lots during specific time period while to make a larger batch.

💡 Note 
If target equipment for dispatching is an equipment of Batch processing 
type like LotBatch or BatchInLine, lots will comprise a batch defined in 
[Dispatching>DispatcherControl>GetLotBatchType] and the batch 
will be processed in the equipment when Select function selects multiple 
lots. However, if the equipment is not Batch Processing Type, the lot 
with the highest priority will be directly loaded onto the equipment while 
the lots with lower priority are fed into equipment's buffer in order. Lots in 
the buffer will be automatically loaded onto the equipment sequentially 
when the proceeding lot has completed its task. If buffer has the lot to 
be processed, Dispatching is not executed.

Default Logic Example

public IHandlingBatch[] SELECT_DEF(DispatcherBase db, AoEquipment aeqp, IList<IHandl
ingBatch> wips, ref bool handled, IHandlingBatch[] returnValue) 
{ 
    return new IHandlingBatch[] { wips[0] }; 
}
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9. IsWriteDispatchLog : This decides whether to write Dispatching log or not. The 
decision can be made for each equipment. The following functions like 
AddDispatchWipLog, GetSelectedWipLog, and WirteDispatchLog are not executed 
if IsWriteDispatchLog returns false.

10. AddDispatchWipLog : This function is used to return Dispatching log about a 
particular equipment and target lot as string type. The returned string of this 
function is used to configure DISPATCH_INFO property in EqpDispatchInfo which 
is delivered as parameter from WriteDispatchLog function. The following example 
shows how to write a dispatch log string of a specific lot for a specific equipment 
when Weight Preset-based Dispatcher is used.

Default Logic Example

StringBuilder _log = new StringBuilder(); 
public string ADD_DISPATCH_WIP_LOG_DEF(Resource eqp, EntityDispatchInfo info, ILot l
ot, WeightPreset wp, ref bool handled, string returnValue) 
{ 
    _log.Clear(); 
 
    _log.Append(lot.LotID); 
    _log.AppendFormat("/{0}", lot.UnitQty); 
 
    if (wp != null) 
    { 
        foreach (var factor in wp.FactorList) 
        { 
            var value = lot.WeightInfo.GetValue(factor); 
            _log.Append("/"); 
            _log.Append(value); 
        } 
    } 
 
    return _log.ToString(); 
}

Sample Code

public string ADDDISPATCHWIPLOG_0(Resource eqp, EntityDispatchInfo info, ILot lot, W
eightPreset wp, ref bool handled, string prevReturnValue) 
{   
    StringBuilder log = new StringBuilder(); 
 
    if (eqp.Preset != null) 
    { 
        foreach (var factor in eqp.Preset.FactorList) 
        { 
            if (string.IsNullOrEmpty(log.ToString()) == false) 
                log.Append(","); 
 
            //float s = lot.WeightInfo.GetValue(factor); 
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            var val = lot.WeightInfo.GetValueData(factor); 
            log.Append(val.Description); 
        } 
    } 
    SimpleMfgSemiconLot slot = lot as SimpleMfgSemiconLot; 
    StringBuilder result = new StringBuilder(); 
    result.Append(slot.LotID); 
 
    if (!string.IsNullOrEmpty(log.ToString())) 
        result.Append(",").Append(log) ; 
    return result.ToString(); 
}

The outputs of the example code are shown below. As seen in DISPATCH_INFO 
column of the following result, it can be shown that LOT ID and its score for each 
factor is displayed with delimiter ",".

11. GetSelectedWipLog : This returns Log strings about lots selected by Dispatching. 
When lot information is the input of the parameter, the parameter converts and 
returns the information as string type. The following sample code shows how the 
result of SELECT_INFO from above is converted and returned as string.

Default Logic Example

public string GET_SELECTED_WIP_LOG_DEF(Resource resource, IHandlingBatch[] sels, ref 
bool handled, string prevReturnValue) 
{ 
    _log.Clear(); 
    foreach (var hb in sels) 
    { 
        if (_log.Length > 0) 
            _log.Append(";"); 
        var lotID = hb.Sample.LotID; 
        _log.Append(lotID); 
    } 
    return _log.ToString(); 
}

12. WriteDispatchLog : It is used to output the dispatching result according to output 
schema defined by user.
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Sample Code

public void WRITEDISPATCHLOG_0(DispatchingAgent da, Mozart.SeePlan.DataModel.EqpDisp
atchInfo info, ref bool handled) 
{ 
    Outputs.EqpDispatchInfo dispatchlog = new Outputs.EqpDispatchInfo(); 
 
    dispatchlog.LINE_ID= (info.TargetEqp as SimpleMfgSemiconEqp).LineID ; 
    dispatchlog.EQP_ID = (info.TargetEqp as SimpleMfgSemiconEqp).ResID; 
    dispatchlog.DISPATCHING_TIME = info.DispatchTime.DbToString(true); 
    dispatchlog.DISPATCH_INFO = info.DispatchWipLog; 
    dispatchlog.FILTER_INFO = info.FilteredWipLog; 
    dispatchlog.SELECT_INFO = info.SelectedWipLog; 
    OutputMart.Instance.EqpDispatchInfo.Add(dispatchlog); 
}

13. OnDispatched : If a lot or the property of equipment should be changed just after 
a lot is selected, this Action can be used to implement the corresponding logic. 
Since the equipment has already made it decision for the next processing lot, 
several information can be updated at this moment.

14. InterceptRemove: This is called when a lot is removed from Dispatching Queue 
after it is selected. If a lot should be returned without being removed from the 
Queue, the corresponding logic is implemented.

Equipment

Equipment Category consists of DownControl, SetUpControl, ProcessControl, and 
other 5 Controls that handles equipment events and logic for other equipment. 
DownControl, SetupControl and ProcessControl are responsible for controlling the 
representative resource and equipment that process lots.

The following diagram illustrates FECompoents of Equipment Category and inter-
relationship among those components.
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Each Control in Equipment Category has the following role.

ProcessControl
This FEComponent is used to implement logic related to all controls including loading, 
setup, processing, and unloading. This control is linked to SetUpControl to distinguish 
and handle Setup.

SetupControl
This FEComponent is used to control the decision and execution of Equipment setup. 
It is triggered by ProcessControl and return its control flow to ProcessControl when its 
task is completed.

DownControl
This FEComponent is used to control the Down states (PM, Failure) of equipment.

EqpEvents
For possible equipment events other than ones by ProcessControl, SetupControl, and 
DownControl, user can define a logic for the corresponding event when it takes place.

Misc
It is a set of functions that can be called at random moment in order to configure/check 
the state or property of an equipment.
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ProcessControl Control

This FEComponent controls all procedures including loading, processing, and 
unloading of a lot in equipment. FEActions in this FEComponent can be classified as 
four parts as shown in the diagram below.

When a lot is loaded into an equipment

1. OnTrackIn : This is used to implement logic required after a lot is loaded onto an 
equipment but before it is processed in the equipment. Since basic process and 
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data collecting have already been completed while lot is loaded, this is used to 
implement additional user-defined logic.

2. OnCustomLoad : This is used to implement a user-defined logic to change 
property of lot or to split a lot for its consecutive processing when a lot is loaded. 
This Action is activated only when Misc.UseCustomLoad function's value is true.

3. IsNeedSetup : It decides whether Setup for a loaded lot is required or not. If 
required, IsNeedSetup receives control authority from SetupControl.

When Setup is completed (When processing is prepared)

1. GetProcessTime: This configures processing time of a lot. As a result, it returns 
ProcTimeInfo Class that consists of Process Time and Tact Time. If a lot's 
processing time is configured for the current equipment at the current step before 
the lot begins its processing, Simulation Model handles logic by using this 
information when the lot should be processed.

💡 Note 
Basically Process Time and Tact time should be configured for each unit 
comprising a lot. If user specified data does not match with this, the data 
in Input should be converted to meet the requirement of the data unit 
from Library.

Sample Code

public ProcTimeInfo GETPROCESSTIME(Mozart.SeePlan.Simulation.AoEquipment aeqp, IHand
lingBatch hb, ref bool handled, ProcTimeInfo prevReturnValue) 
{ 
    SimpleMfgSemiconLot lot = SimHelper.GetLot(hb); 
    ProcTimeInfo result = new ProcTimeInfo(); 
    // Default Time Setting 
    result.FlowTime = TimeSpan.FromMinutes(60); 
    result.TactTime = TimeSpan.FromMinutes(60); 
  
    // Search Time 
    string recipe = lot.Product.ProductID + "." + lot.CurrentStep.StepID; 
    object[] keys = new object[] { lot.Product.ProductID, lot.Process.ProcessID, lo
t.CurrentStep.StepID, recipe, aeqp.EqpID }; 
    Inputs.StepTime st = InputMart.Instance.StepTime.Rows.Find(keys); 
  
    if (st != null) 
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    { 
        result.FlowTime = TimeSpan.FromSeconds(st.PROC_TIME); 
        result.TactTime = TimeSpan.FromSeconds(st.TACT_TIME); 
    } 
  
    return result; 
}

2. GetProcessUnitSize: This returns Processing Unit Size of a lot. Processing Unit 
size is the minimum number of units that comprises a lot. Based on composition of 
master data and a method to calculate processing time in an equipment, 
Processing Unit can be changed. However, if an equipment is batch type, 
processing time is decided by basic Unit Size which is used for counting actual 
output regardless of actual unit quantity of lots. So logic should reflect this.

💡 Note 
Tact Time and Process Time for actual Equipment are decided by 
Handling Batch unit. In other word, even if multiple lots are loaded 
together into a Batch Type equipment, its actual processing in the 
equipment is considered as a single work piece. Therefore, processing 
time of a lot is configured as follows. For Batch equipment, basically 
processing time for one lot is the same as the time for n lots bound as a 
batch. So processing time per unit for Batch equipment is calculated by 
collecting statistics with the average Unit size of a lot. Like the following 
example, processing time of an actual batch is calculated by using an 
average Unit Size, too.

Default Logic Example

public double GET_PROCESS_UNIT_SIZE_DEF(AoEquipment aeqp, IHandlingBatch hb, ref boo
l handled, double prevReturnValue) 
{ 
    double unitSize = SeeplanConfiguration.Instance.LotUnitSize; 
 
    if (!aeqp.IsBatchType()) 
        unitSize = hb.UnitQty; 
    return unitSize; 
}

FlowTime = UnitProcTime∗ProcessUnitSize

TactTime = UnitTactTime∗ProcessUnitSize
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Sample Code

public double GETPROCESSUNITSIZE_0(AoEquipment aeqp, IHandlingBatch hb, ref bool han
dled, double prevReturnValue) 
{ 
    //Setting Lot Unit Size information as default. 
    double unitSize = SeeplanConfiguration.Instance.LotUnitSize; 
    SimpleMfgSemiconLot lot = SimHelper.GetLot(hb); 
    double unitBatchSize = 13 ;  
  
    if (aeqp.Target.SimType == SimEqpType.UnitBatch) 
    { 
        // If UnitBatch, then time required is calculated as the multiple of UnitBat
ch 
        unitSize = Math.Ceiling(((double)lot.UnitQty / unitBatchSize)) * unitBatchSi
ze; 
    } 
    else if (!aeqp.IsBatchType()) 
    { 
        // If not Batch Type, consume time is the actual unit quantity of lot 
        unitSize = lot.UnitQty; 
    } 
} 

3. GetLoadableChambers : For an equipment whose SimType is ParallelChamber, 
this function returns the information of only Chambers which is actually loadable. 
The decision making is based on the Chamber status and loadable information in 
Chamber unit.

public string[] GET_LOADABLE_CHAMBERS_DEF(AoChamberProc2 cproc, IHandlingBatch hb, r
ef bool handled, string[] prevReturnValue) 
{ 
    // default values : all available chambers 
    DateTime now = cproc.NowDT; 
    List<string> chambers = new List<string>(); 
    foreach (var info in cproc.Chambers) 
    { 
        if (info.GetAvailableTime() <= now) 
            chambers.Add(info.Label); 
    } 
    return chambers.ToArray(); 
}

Sample Code

public string[] GETLOADABLECHAMBERS_0(AoChamberProc2 cproc, IHandlingBatch hb, ref b
ool handled, string[] prevReturnValue) 
{ 
    SimpleMfgSemiconLot slot = lot as SimpleMfgSemiconLot ; 
    string[] chambers = slot.CurrentPlan.LoadableChambers; 
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    List<string> loadables = new List<string>() ; 
    foreach (AoChamberProc2.ChamberInfo info in cproc.Chambers) 
    { 
        foreach (string id in chambers) 
        { 
            if (id == info.Label) 
            { 
                if (info.GetAvailableTime() <= cproc.NowDT) 
                    loadables.Add(id); 
                break; 
            } 
        } 
    } 
  
    return loadables.ToArray(); 
}

4. GetTactTimeByChamberCount: Calculates the tact time to load the lot into the 
parallel chamber type equipment.

5. OnEntered: This FEAction is called after the lot/batch is loaded to the equipment 
and before processing starts. This is where you can implement user-defined logic 
to be handled before processing end time.

6. OnBeginProcessing : It is called just before a lot is processed. A logic required at 
the corresponding time can be implemented.

When processing is finished
1. OnEndProcessing : This function handles any logic required just after a lot was 

processed in an equipment. Before the processed lot is unloaded, the lot's 
property, statistics, constraint configuration can be changed.

When a lot is unloaded
1. OnTrackOut : It is used to implement a logic required when a lot is Track Out from 

an equipment. This is the last point where any logic required before changing Step 
information of a lot to the next Step can be implemented.

2. OnCustomExit : If usage of user-defined Output Port is configured through 
Misc.UserCustomOutPort function, lots are moved out from the equipment through 
the configured Port without using the normal Unloader. When a lot is unloaded 
after its processing, all necessary processes should be implemented by users.
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3. InterceptMove : This FEAction is used to define logic for the lot/batch to be 
Split/Merge after Track Out and before proceeding to Transfer.

4. OnCustomUnload: OnCustomUnload  is called after Simulation > Equipment > 
ProcessControl > OnEndProcessing . During this time, the lot is still inside the 
equipment, so the property of the lot and the equipment can be updated before 
unloading proceeds. For instance, you can implement logic to model the unloading 
time of the lot during the unloading event or if a material is required for unloading, 
then modeling logic for the material can be implemented through OnCustomUnload . 
But first, a value to indicate whether to use OnCustomUnload  needs to be returned. 
Return true  from Misc.UseCustomUnload to call OnCustomUnload .

The correlation between the actions of ProcessControl and the actions of other related 
Control is illustrated as follows. In the point of view of processing order, the repeated 
Control includes Entity>Route, Equipment>SetupControl, and 
SecondResouce>ToolControl, etc.

SetupControl Control
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In order for a lot to be processed in an equipment, the equipment should be set to 
manufacture the lot. If the equipment's setup is not matched with processing condition 
for the lot, configuration of the equipment or the lot should be adjusted for processing. 
This procedure is called Setup. In order to design and control the occurrence and 
processing procedure of Setup, it is necessary to decide whether Setup is required, 
whether additional resources are required for Setup, and time consumed. Afterwards, 
the information should be provided to the Simulator.

EqpSetupControl provides the following FEActions for the Setup-related Control.

1. IsNeedSetupCrew: This is used to implement a logic that decides whether 
Second Resources are required for equipment setup or not. Not all second 
resources of real system are object for Setup Model, but only resources that have 
a restriction on their use due to a finite capacity are the target.

2. GetSetupCrewKey: If a certain Second Resource is required for Setup, this is 
used to implement a logic to return Key information used to search for which 
resource is required according to condition of lot.

Default Logic Example
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public string GET_SETUP_CREW_KEY_DEF(AoEquipment aeqp, IHandlingBatch hb, ref bool h
andled, string prevReturnValue) 
{ 
    return aeqp.EqpID; 
}

3. GetNeededSetupCrews: This is used to implement a logic that calculates a 
required quantity(number) of Setup Resource (or SetupCrew).

4. GetSetupTime : If all Setup condition is satisfied, this calculates the time taken by 
the corresponding Setup. A fixed time can be used regardless of lot and 
equipment. However, if Setup time is widely different depending on Setup types, 
the model should reflect this gap.

5. GetSetupCrewTime: Returns the amount of time of Setup Crew required out of 
the entire Setup time of the equipment. The equipment uses the Setup Crew until 
the specified time and releases the crew to be available for other equipment that 
requires setup.

6. SetLastLoadingInfo: This updates information of the last lot that has been 
processed in the equipment. In some cases, setup can occur when every lot 
begins its processing, but in general, the lots correspondent to the current setup 
condition of the equipment are loaded to reduce Setup Loss. So when setup 
occurs, the setup information should be written. Since processing conditions that 
affect Setup can be different according to the process step or manufacturing area, 
this part can be defined by the user. The latest processing condition configured by 
SetLastLoadingInfo can be used to decide whether setup is required or whether 
any SetupResource is required.

Default Logic Example

public LoadInfo SET_LAST_LOADING_INFO_DEF(AoEquipment aeqp, IHandlingBatch hb, ref b
ool handled, LoadInfo prevReturnValue) 
{ 
    var lot = hb.Sample; 
    return lot.CurrentPlan; 
}

7. GetNeedSetupChambers: Returns the list of chambers in a parallel chamber type 
equipment to perform setup individually for each chamber. In other words, setup 
will take place only for the chambers in the returned list. Use 
ChamberInfo.SetupTime(Time)  method to schedule setup for chambers individually.

Default Logic Example
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public ISet<string> GET_NEED_SETUP_CHAMBERS0(Mozart.SeePlan.Simulation.AoEquipment a
eqp, ChamberInfo[] loadableChambers, IHandlingBatch hb, ref bool handled, ISet<strin
g> prevReturnValue) 
{ 
        SiteEqp eqp = aeqp.Target as SiteEqp; 
        SiteLot lot = hb.Sample as SiteLot; 
        HashSet<string> list = new HashSet<string>(); 
    if (eqp.SimType == Mozart.SeePlan.DataModel.SimEqpType.ParallelChamber) 
    { 
        foreach (ChamberInfo chamber in loadableChambers) 
        { 
            string subEqpID = chamber.Label; 
            if (string.IsNullOrEmpty(subEqpID)) 
                continue; 
            Time setupTime = Time.FromMinutes(30d); 
            chamber.SetSetupTime(setupTime); 
            list.Add(subEqpID); 
        } 
    } 
    return list; 
}

8. OnBeginSetup: This is called when Setup begins. It is called after executing basic 
logic which is going to be processed when Setup in Library begins.

9. OnEndSetup : This is called when Setup is about to be completed. It is called 
after executing basic logic which is going to be processed when Setup in Library 
ends.

DownControl Control

DownControl is a control model that supports simulation reflecting equipment's down 
(which can possibly happen in a production line) by modeling causes that could make 
the equipment go down. There are two causes for the equipment to go down. One is 
predictable such as PM(Preventive Maintenance) and the other is Failure which is 
unpredictable. In the equipment-intensive manufacturing industry like semiconductor 
manufacturing, PM is usually executed according to PM Schedule. So it is general to 
reflect PM schedule in Simulation Model. In case of Failure, stochastic frequency of 
failure and MTTR (Mean Time To Repair) might be used in modeling failure. Also it is 
possible to use a method that adjusts equipment capacity reflecting mean utilization in 
equipment processing time. In this case, a separate model about failure is not 
required.
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EqpDownControl provides the following FEAction to control logic related to 
equipment's Down.

1. GetFailureList : This is used to create Failure Events according to rule for 
processing failure and return a list of the events. This is reflected when equipment 
failure occurs stochastically in a considerable level.

2. GetPMList : This is used in order to create PM Events according to PM Schedule 
and return the list. Based on PM Schedule of target site for modeling, it is general 
to create start and end event of a PM.

3. OnPMEvent :  If a PM event registered in an equipment occurs, the corresponding 
equipment changes its state and is restricts any additional loading. This is 
implemented here.

Default Definition

public void ON_PM_EVENT_DEF(AoEquipment aeqp, PMSchedule fs, DownEventType det, ref
 bool handled) 
{ 
    PM_PREVENT_LOADING_DEF(aeqp, fs, det, ref handled); 
}

4. OnFailureEvent : If a Failure event registered in the equipment occurs, the 
corresponding equipment changes its state and is restricts any additional loading. 
This is implemented here.

Default Definition
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public void ON_FAILURE_EVENT_DEF(AoEquipment aeqp, FailureSchedule fs, DownEventType 
det, ref bool handled) 
{ 
    if (det == DownEventType.End) 
    { 
        aeqp.Loader.Unblock(); 
        aeqp.WriteHistoryAfterBreak(); 
    } 
    else 
    { 
        aeqp.WriteHistory(LoadingStates.DOWN); 
        aeqp.Loader.Block(); 
    } 
}

💡 Note 
PM and Failure Event are basically processed similarly.  The only 
difference is equipment's state code. It is possible to implement a 
special user-defined logic according to event type.

5. ModifyDownSchedule :  This FEAction is where you can reschedule or cancel 
the PM or Down schedule in case the loaded lot/batch processing is not completed 
before the PM or Down event start time. ModifyDownSchedule is called from the 
default definition of LOCAT_FOR_RUN_DEF in Entity > WipInit > LocateForRun 
and called when a lot is loaded to the equipment but, before processing starts.

Default Definition

public void MODIFY_DOWN_SCHEDULE_DEF(AoEquipment aeqp, ref bool handled) 
{ 
    var downManager = aeqp.DownManager; 
    if (downManager == null) 
        return; 
 
    DateTime now = aeqp.NowDT; 
    var startItems = downManager.GetStartScheduleItems(Time.MaxValue); 
    var lastEndTime = Time.MinValue; 
    var ignoreBlock = new List<string>(); 
    foreach (var item in startItems) 
    { 
        var schedule = item.Tag as PeriodSection; 
        var rule = schedule.ScheduleType; 
        if (rule != DownScheduleType.ShiftBackward 
            && rule != DownScheduleType.ShiftBackwardStartTimeOnly 
            && rule != DownScheduleType.Cancel) 
            continue; 
 
        var componentID = string.Empty; 
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        var isPM = schedule is PMSchedule; 
        if (isPM) 
        { 
            var pm = schedule as PMSchedule; 
            if (pm.PMType == PMType.Component) 
                componentID = pm.ComponentID; 
        } 
        if (!ignoreBlock.Contains(componentID) && aeqp.IsBlocked(componentID)) 
            continue; 
 
        var remainEndTime = aeqp.GetRemainTimeToEnd(componentID); 
        if (lastEndTime > remainEndTime) 
            remainEndTime = lastEndTime; 
        var wait = item.EventTime - now; 
        if (remainEndTime != Time.MaxValue && wait >= Time.Zero && wait < remainEndT
ime) 
        { 
            var adjStartTime = now.AddSeconds(remainEndTime.TotalSeconds); 
            var adjEndTime = DateTime.MaxValue; 
            var adjSchedule = (PeriodSection)schedule.Clone(); 
            var adjusted = false; 
            switch (rule) 
            { 
                case DownScheduleType.ShiftBackward: 
                    adjEndTime = adjStartTime.Add(schedule.Duration); 
                    adjSchedule.StartTime = adjStartTime; 
                    adjSchedule.EndTime = adjEndTime; 
                    downManager.AdjustEvent(item, adjSchedule); 
                    adjusted = true; 
                    lastEndTime = adjEndTime - now; 
                    break; 
 
                case DownScheduleType.ShiftBackwardStartTimeOnly: 
                    var newDownDuration = schedule.EndTime - adjStartTime; 
                    downManager.CancelEvent(item); 
                    if (newDownDuration <= Time.Zero) 
                        continue; 
                     
                    adjusted = true; 
                    adjSchedule.StartTime = adjStartTime; 
                    downManager.AddEvent(adjSchedule); 
                    lastEndTime = adjSchedule.EndTime - now; 
                    break; 
 
                case DownScheduleType.Cancel: 
                    downManager.CancelEvent(item); 
                    continue; 
            } 
 
            if (adjusted && adjSchedule is PMSchedule && aeqp.IsParallelChamber) 
            { 
                var pm = adjSchedule as PMSchedule; 
                if (pm.PMType == PMType.Full) 
                    aeqp.Loader.Block(); 
                else 
                { 
                    var cproc = aeqp.Processes[0] as AoChamberProc2; 
                    var block = true; 
                    foreach (var c in cproc.Chambers) 
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                    { 
                        if (c.Label == componentID) 
                        { 
                            if (c.BlockEndTime < now && !ignoreBlock.Contains(compon
entID)) 
                                ignoreBlock.Add(componentID); 
                            c.BlockEndTime = pm.EndTime; 
                        } 
                        else if (c.Active) 
                            block = false; 
                    } 
                    if (block) 
                        aeqp.Loader.Block(); 
 
                } 
            } 
            else 
                aeqp.Loader.Block(); 
        } 
    } 
}

Misc Control

Misc is a set of functions that can be called at any moment in order to check or 
configure equipment's state and property.
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UseCustomOutPort : This configures whether to use user-defined logic for lot's 
unloading event at Output Port of equipment. If it is configured as true, 
ProcessControl.OnCustomExit FEAction should be implemented. In SeePlan 
Library, a lot is unloaded by AoUnloader at the end of Processing in an equipment 
if there is no special configuration. Otherwise, this function is implemented only if 
user-defined logic should be implemented.

GetCamberCapacity : Implement logics to configurate properties of the 
SimEqpType = Chamber equipment. For instance, the number of chambers of the 
chamber type equipment can be set.

IsBatchType : This returns whether an equipment is Batch type or not. Basically 
BatchInlin and LotBatch are only SimType classified as BatchType and these are 
also classifed in Library as well. However, if SimType of a specific equipment is 
separately configured based on the initial input data or new SimType is created, 
the corresponding Action should be implemented.

Default Definition Example

public virtual bool IsBatchType(AoEquipment aeqp, ref bool handled, bool prevReturnValu
e) 
{ 
    if (aeqp.Target.SimType == SimEqpType.LotBatch || 
        aeqp.Target.SimType == SimEqpType.BatchInline) 
        return true; 
    else 
        return false; 
}

CanEnter : This decides whether additional lots can be loaded into an equipment 
when it is called. Basically this checks whether the equipment is in Process/Down 
state and if Blocking is enabled to Loader. If there are other conditions to impose a 
constraint on equipment loading, they are implemented in this Action.

GetChamberIDs : GetChamberID returns list of ID for each Chamber and 
initializes them if the equipment SimType is ParallelChamber. This must be 
implemented if the equipment is set as Parallel Chamber.

UseCustomLoad : This is used to process user specific logic at the moment when 
a lot is loaded for making changes such as lot property. If the value is true, 
ProcessControl.OnCustomLoad FEAction is executed. Otherwise, the lot is 
processed without any special handling.
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Eqp Events

Eqp Events is used to implement user-defined logic about equipment events other 
than Process, Setup, and Down. This is called when the corresponding events occur.

1. OnEqpStart : Equipment are created when Simulation is initialized. This Action is 
called for each equipment when simulation begins. At the moment, equipment's 
additional and dynamic properties can be initialized.

2. LoadingStateChanged: This is used to implement logics that should be 
processed on the basis of both an equipment's previous and current state when its 
LoadingState is changed.

The state code of Equipment are listed as follows (LoadingStates):

SETUP : Setup status of Equipment

BUSY : Processing state of Lot. For InLine type equipment, the processing 
state changes to BUSY only when lots are loaded constantly if the equipment 
has enough capacity for release.

IDLERUN : The equipment(Inline type) state changes to IDLERUN if no new 
release occurs although the equipment's capacity is enough for the new 
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release.

IDLE : Equipment's state is UP but not processing(Inactive).

PM : Equipment 's state is DOWN because of PM.

DOWN : Equipment's state is DOWN because of FAILURE.

WAIT_SETUP : Equipment's state is waiting for SETUP so that is is not active.

3. ProcessStateChanged: This is used to implement a user-defined logic required 
when processing state of the current lot is changed.

A lot's Processing state is changed in the following order:

FL(First Loading) : The first unit in a lot starts its processing.

LL(Last Loading) : The last unit in a lot starts its processing.

FU(First Unloading) : The first unit in a lot ends its processing.

LU(Last Unloading) : The last unit in a lot ends its processing.

4. ResourceStateChanged : This FEAction is used to apply user-defined logic when 
Resource state is chanted.

Resource states are listed as follows:

UP : Up state.

DOWN : Down state.

Bucketing

During Forward Loading Simulation, Bucketing is used to handling lot's waiting and 
processing in a step without equipment loading simulation. Bucketing can be used in 
the following cases.

1. A specific step's equipment information is unreliable or only step capacity is known 
since it is manually processed.

2. Since various constraints based on quantity capacity unit are applied to Step 
In/Out Plan, a method to use equipment loading damages accuracy of the plan.

3. The lot should be loaded to equipment but there is no information of equipment 
that can be used to process a specific step due to omission or lack of master data
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Library provides controls that consists of two components for implementation of 
Bucketing Logic in the above cases.

BucketControl
This provides methods to implement customized logic to interwork with the Bucketing 
logic to control the entire flow of the lot from the entrance to the exit of the Bucket .

BucketEvents
This is used to add specified logic into events occurred by Bucketing logic.

Other basic logic like Bucket creation and initialization can be implemented by using 
BucketInit Component  of Factory.

SeePlan Library Class Structure for Bucketing



MOZART IDE (ENG) 239

BucketControl Control

BucketControl is used to control logic required from the start until the end of Bucketing 
for a target lot of Bucketing. If capacity of resources for Bucketing is given, 
BucketControl consists of functions that basically searches the corresponding Capacity 
Bucket and control lot and its processing time, etc. according to property of Bucket. 
The following diagram shows BucketControl's control flow.
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1. GetCapacityBucketKey: This FEAction returns a Key that is used to search a 
target Bucket based on lot and step. Its rule is defined and implemented according 
to Bucket management method of customer site. If no key in a lot is configured 
while Bucketing is executed because this function is not implemented, the lot is 
processed through Dummy. Dummy processing begins with the execution of 
GetBucketTime function as illustrated in the above flow. That is, Dummy 
processing cannot reflect any constraint. Bucketing for lots with the same 
BucketKey is processed in the same Bucketer

Sample Code

public object GETCAPACITYBUCKETKEY(IHandlingBatch hb, ref bool handled, object prevR
eturnValue) 
{ 
    SimpleMfgSemiconLot lot = SimHelper.GetLot(hb); 
 
    // This is an example to proceed Bucketing seperately accoring to the rules of S
tepID string 
    if (lot.CurrentStep.StepID.StartsWith("S50") || lot.CurrentStep.StepID.StartsWit
h("S70")) 
        return lot.CurrentStep.StepID.Substring(0, 3); 
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    return null; 
}

2. GetCapacityBucket : This returns a Capacity Bucket correspondent to the above 
BucketKey. If the corresponding Bucket was not created through BucketInit, a 
Capacity Bucket using the corresponding key is created and returned. If a key is 
configured through GetCapacityBucket function but no Bucket having the 
correspond key is created, the corresponding lot is executed by Dummy 
processing. In addition, if Enable, one of Bucket properties, is set to false, this is 
another case of Dummy processing.

Sample Code

public CapacityBucket GETCAPACITYBUCKET(BucketManager bm, object key, ref bool handl
ed, CapacityBucket prevReturnValue) 
{ 
    CapacityBucket cb = new CapacityBucket(); 
 
    // Set Bucketer with same capacity for S50, S70 
    switch (key.ToString()) 
    { 
        case "S50": 
        case "S70": 
            cb.CapaQty = 1000; 
            cb.Key = key.ToString(); 
            cb.Enabled = true;  // Enable Bucketing. If this is set to false, Dipatc
hing by Bucket doesn't occur but Dummy processing is executed. 
            break; 
    } 
 
    return cb; 
} 
// To use different DummyBuckets according to Key although the step is processed by
 Dummy 
// Do not create CapacityBucket instead ~~

3. InitializeBucketer : Bucket is initialized. This function can be used to configure the 
property of Bucketer in order to force Bucketer's dispatcher evaluate lot's priority 
according to user-defined logic instead of FIFO.

4. OnDispatch : This function executes at the dispatching moment for lots that wait 
for Bucketing.

5. GetConstraintSetKey : This returns Bucket Key for dealing with not only Bucket's 
capacity but also constraints for each product(step) that is processed through 
Bucket itself. Generally a step processed through Bucket, has an arranged 
production capacity limit (upper limit) per day and/or a shift for each product. 
Sometimes multiple constraints have to be satisfied simultaneously for the same 
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product. GetConstraintSetKey is used to implement a logic that returns a Key 
defining these Constraint Bucket Set.

6. GetConstraints : This returns Bucket Set corresponding to a Constraint Bucket 
Key. Like the following example, CapacityBucket Class is also used to create a 
Constraint Bucket. If Capacity of the Bucket used in Constraint does not change, 
first register Constraint Bucket through Factory>BucketInit>InitializeBuckets 
and then seek for and return the registered ConstraintBucket throught 
GetConstraints. If ConstraintBucket cannot be registered in advance because the 
capacity of Bucket changes in a certain cycle including a shift, a new Bucket 
should be created and returned. In this case, user should handle Rolling instead of 
automatic Rolling. The following example code shows when ConstraintBucket 
cannot be registered and new Bucket needs to be created.

Sample Code

public IEnumerable<IBucket> GETCONSTRAINTS(IBucketManager bm, IHandlingBatch hb, Dat
eTime now, ref bool handled, IEnumerable<IBucket> prevReturnValue) 
{ 
    string key = GetConstraintKey(hb); 
 
    List<IBucket> consts = new List<IBucket>(); 
    if (string.IsNullOrEmpty(key)) 
        return consts; 
 
    CapacityBucket cb = new CapacityBucket(); 
    cb.Key = key; 
    cb.CapaQty = 400; 
    consts.Add(cb); 
 
    return consts; 
}

7. IsStopSelection : This decides whether Bucket stops Dispatching or not. Even if 
there are several lots on standby, Dispatching is canceled when IsStopSelection = 
true.

8. CanDispatch : This discerns whether a specific lot can be dispatched among lots 
on standby in Bucket. The lot can be selected only if this function returns true. If 
this function returns false, the corresponding lot is excluded from Bucketing. 
However, Dispatching itself doesn't stop unlike IsStopSelection.

9. CustomSelect: If there is standby WIP in Bucket, it is possible to implement a 
logic that process lots in the order of the evaluated priority for each lot. Default 
dispatching method of Bucketer is FIFO. In order to apply user-defined dispatching 
rule, user should reconfigure FIFO property of Bucketer through initialization action 
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like InitializeBucketer. Only when IsFifo = false, CustomSelect is called to select a 
lot. This function compares two lots' priority and returns the lot with higher priority. 
The function provides the logic to select the lot with the highest priority in case 
there are several lots on standby.

10. DispatchSelect: The lots are evaluated by the weight-sum method if the Bucketer 
has WeightPreset set and CustomSelect method is inactive. Implement logic to 
DispatchSelect to select the lot after weight evaluation is complete.

11. OnDispatched : This function is executed at the moment when Dispatching for 
Bucketer has been completed and a lot is selected. This is used for verification, 
debugging, and also can be used to write information of the corresponding 
moment.

12. WriteCheckConstraintLog : This function is used to write the result of checking 
Constraint Bucket. This is called just after deciding whether Constraint Bucket is 
satisfied or not. If violate is null among parameters of WriteCheckConstraintLog, it 
means that lots are properly released because there is no Bucket that constraints 
are imposed on. However, if violate is not null, it means that no lots was released 
because of Bucket constraints.

13. AddBucketMove : If a lot is selected by dispatching of Bucketer, the capacity of 
Bucketer should be reduced as much as the dispatched lot's quantity (update 
actual product output) . Its processing can be changed according to a method 
configuring capacity of target Bucketer. Generally capacity is configured by 
production quantity, but also can be configured by time. In this case, this function 
returns the calculation result about the decrement quantity of capacity

Default Logic Example

public void ADD_BUCKET_MOVE_DEF(CapacityBucket bucket, IHandlingBatch hb, ref bool h
andled) 
{ 
    int qty = 0; 
    hb.Apply((x, __) => qty+=x.UnitQty); 
    bucket.MoveQty += qty; 
}

14. GetBucketTime: This FEAction calculates and returns Processing Time for 
Bucketing. If Batch Capacity or Volume Capacity of Bucket is specified, Processing 
time is specified by the similar method with equipment loading. Otherwise, Step 
TAT is used as Processing time. This can be changed according to operation 
method of the target system. So user should implement the appropriate logic by 
using the corresponding FEAction.
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15. GetBucketInputDelay: This is used to implement a logic to return time of when a 
new lot can be released to a Bucket if no lot can be currently released due to the 
shortage of capacity in Bucket.

Default Logic Example

public Time GET_BUCKET_INPUT_DELAY_DEF(IHandlingBatch hb, AoBucketer bucketer, ref b
ool handled, Time returnValue) 
{ 
    var move = bucketer.Bucket; 
 
    if (bucketer.RollingHours <= 0 
        || move.CapaQty == 0 
        || move.CapaQty > int.MaxValue / 2 
        || move.SlotCount == 0) 
    { 
        return Time.Zero; 
    } 
 
    double delay = ((double)bucketer.RollingHours / (double)move.CapaQty) * (double)
move.SlotCount; 
 
    return Time.FromHours(delay); 
}

16. BucketRolling : Bucket Rolling occurs in InnerRollingMinutes unit defined as a 
property of [Factory>BucketInit] within the system. The above logic is 
implemented in Definition provided by System as a default. However, if user wants 
to implement a special logic for Rolling, user can add and use a new definition 
after removing the default definition. If Slant is configured in Bucket, MoveQty of 
each Rolling cycle is reset and CumulativeQty(Cumulative actual production 
quantity) is initialized at every BucketRollingHour unit. So additional lots can be 
processed up to configured capacity. If Default definition is not used, user should 
process this in a similar way.

Default Logic Example

public void BUCKET_ROLLING_DEF(CapacityBucket cb, DateTime now, bool atBoundary, boo
l atDayChanged, ref bool handled) 
{ 
    if (atBoundary) 
    { 
        //cb.PreviousQty = 0; 
        cb.CumulatedQty = 0; 
        cb.MoveQty = 0;    
      
    } 
    else 
    {                
        cb.PreviousQty = cb.MoveQty; 
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        cb.CumulatedQty += cb.MoveQty; 
        cb.MoveQty = 0; 
    } 
}

17. InterceptMove : Implement logic to intercept entities to be sent to the next step 
and to perform split/merge lots.

The following figure shows interrelationship among Actions of the relevant Controls.

BucketEvents

his is a set of user-defined events that can occur from objects handling Bucketing 
Logic.
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1. OnBeginRolling : This event occurs in the beginning of Bucket Rolling. After this 
event, Rolling for all Buckets (Capacity, Constraint) are executed. Events handler 
function during Rolling is Bucketing>BucketControl>BucketRolling.

2. OnEndRolling : This is an Event that occurs when Bucket Rolling ends.

SecondResource

This FEComponent is used to manage and control second resources including Tools 
installed in an equipment when a step is processed, Setup crews and Jigs that are 
required for setup, and Rack used to mount lots for Batch step, etc.

Except for Setup Crews, all Second Resources can be classified as two types. One of 
them is installed on a lot and the other is installed in an equipment. Each type is 
processed in a slightly different method.

ToolControl
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This is a set of functions dealing with all basic controls for using second resource. This 
include selection, validity test, occupation, or release of second resource, etc.

ToolEvents
This is a set of functions called when any event occurs in a simulation Model related to 
second resource.

ToolControl Control

This is a set of functions handling all basic controls for using Second resources. These 
controls include selection, validation test, occupation or release, etc. of Second 
resource. In order to process a lot at a specific step, the required quantity of Second 
resources can be n. SeePlan Library provides a class Model called "ToolSettings" to 
deal with this. To control multiple Second Resources, ToolSettings can include multiple 
ToolItems that are mapped with those Second Resources.

ToolSettings is configured when a lot is filtered just before dispatching is executed. If a 
lot that needs ToolSet cannot set up with any valid Toolset, ToolSettings control 
processing of the lot.
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1. IsNeedToolSettings : This action decides whether a target lot needs a set of 
second resources to be processed at the current step or not.

2. GetToolData : This returns whole set information for selecting Second Resource 
that a target lot needs at the current step. Multiple second resources can exist 
according to equipment capable of processing a specific lot at a specific step. 
Since this action is called after an equipment is designated, this returns a set of 
available Second Resources for the corresponding equipment. Return type of The 
data is IToolData so that a class implementing IToolData should be defined in My 
Objects.

3. BuildToolItems : This action creates ToolItem for each Second Resource required 
to process a target lot at the current step. For example, if a Rack that a lot is 
mounted on and a Tool installed in an equipment are required for processing at the 
current step, two ToolItems should be created. The following is an example code.

Sample Code

public IEnumerable<ToolItem> BUILDTOOLITEMS(IToolSettings tool, ref bool handled, IE
numerable<ToolItem> prevReturnValue) 
{ 
    List<ToolItem> toolItems = new List<ToolItem>(); 
    ToolItem rack = new ToolItem("Rack", 1); 
    ToolItem tool = new ToolItem("Tool", 1); 
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    toolItems.Add(rack); 
    toolItems.Add(tool) ; 
 
    return toolItems; 
}

4. GetLastToolSettings : This action returns ToolSettings information of the latest 
setup of the target equipment. There is a default definition that returns an 
equipment's CurrentToolSettings. If implementation is done through modification of 
equipment information, GetLastToolSettings can be modified.

Default Logic Example

public ToolSettings GET_LAST_TOOL_SETTINGS_DEF(AoEquipment aeqp, ref bool handled, T
oolSettings prevReturnValue) 
{ 
    return aeqp.CurrentToolSettings; 
}

5. SelectTool : This function decides the currently available second resource based 
on ToolData and returns the key information of the second resource to be set in 
ToolItem. For example, if ToolData indicates that there are currently n available 
Tools, SelectTool is used to implement a logic to select which Tool to be used. This 
action also checks Tool's availability. The following is the sample code.

Sample Code

public object SELECTTOOL(IToolSettings tool, ToolItem item, ILot lot, AoEquipment ae
qp, ToolItem last, bool canAlt, ref bool handled, object prevReturnValue) 
{             
    ToolArranges loadable = tool.Data as ToolArranges; 
    if (loadable.Tools== null || loadable.tools.Count <= 0) 
        return null; 
    var factory = aeqp.Factory ; 
    // Searches for Pool objects through SecondResourcePool name of target ToolItem 
    var pool = factory.GetResourcePool(item.ResourceType); 
    if (pool == null) 
        return null; 
    SiteLot slot = lot as SiteLot; 
    string resourceKey = string.Empty; 
    foreach (SiteTool tool in loadable.Tools) 
    { 
        // Searches tool in arrange from second resource pool. 
        var sres = pool.GetResource(tool.ToolID, aeqp); 
        if (sres == null) 
            continue; 
 
        // Check availablity of the corresponding Second Resource. 
        if (sres.IsAvailable(aeqp) == false) 
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            continue; 
        if (last != null && last.ResouceKey.ToString() == tool.ToolID) 
        { 
            resourceKey = reticle.ReticleID; 
            break; 
        } 
    }      
 
    return resourceKey;  // Set item.Resourcekey as return value 
}

6. IsValidToolInfo : This function performs validity check on all Tool Data composing 
ToolSettings after a Tool is selected. IsValidToolInfo checks if Tool Data of lot or 
equipment is valid and if all required Tool Data is avaiable. In general, it is checked 
whether the configuration of any required ToolItem is proper or not because 
configured ToolItem's ResourceKey is basically configured .

Default Logic Example

public bool IS_VALID_TOOL_INFO_DEF(ToolSettings tool, ToolItem current, ref bool han
dled, bool prevReturnValue) 
{ 
    if (current.ResouceKey == null) 
        return false; 
    return true; 
}

7. IsReadyTool : This decides whether the selected Tool (Second Resource) is 
currently available.

Default Logic Example

public bool IS_READY_TOOL_DEF(ToolSettings tool, ToolItem current, ToolItem last, re
f bool handled, bool prevReturnValue) 
{ 
    if (current.ResouceKey == null) 
        return false; 
    return true; 
} 

8. IsSameToolSettings : This decides whether a pair of ToolSettings are identical or 
not.

9. AttachTool :  This FEAction occupies the Second Resource which requires for the 
product to be put in or to be attached to the product for processing.  This FEAction 
called after lot is selected from OnDispatched action. Before this action is called, 
releasing/seizing of the second resource from the equipment is handled in prior.
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Default Definition Code

public void ATTACH_TOOL_DEF(IHandlingBatch hb, ref bool handled) 
{ 
    hb.ToolSettings.Attach(); 
}

10. CanDetach :  When processing in the current equipment ends, CanDetach 
decides whether a lot can be detached from the Second Resource (ex. Rack, 
Cassette, etc.) that the lot was put in. If multiple lots are mounted on one Second 
resource in order to be processed in a step, lots can be transferred to or 
processed at the consecutive Step in form that these lots are mounted in the same 
Second Resource. In this case, it is required a logic that decides whether a target 
lot can be detached from Second Resource at the end of the first step. Its default 
is true. And the logic is implemented to return Second resource that the lot is 
mounted on at every step. If multiple lots (ILot) is mounted on a single Second 
Resource and processed together, they should be tied together as LotBatch or 
LotGroup before their processing.

11. DetachTool : This FEAction is used to detach(release) the Second Resource 
which type concerns : 1)requires for the product to be put in 2)to be attached to the 
product for processing.

Default Definition Code

public void DETACH_TOOL_DEF(IHandlingBatch hb, ref bool handled) 
{ 
    hb.ToolSettings.Detach();  
}

Tool Events

This is a set of functions to handle Events occurred in Simulation Model related to 
control of Second Resource. User add logic to the event handler.
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1. OnSeized : For Second Resource installed in Equipment, this event is triggered 
just after an equipment has seized Second Resource.

2. OnReleased : For Second Resource installed in Equipment, this event is triggered 
just after an equipment has released Second Resource.

3. OnAttached : For Second Resource attached with lots, this event is triggered just 
after a lot is attached to the Second Resource.

4. OnDetached : For Second Resource attached with lots, this event is triggered just 
after a lot is detached from the Second Resource.

JobChangeAgent

F/W Loading simulation basically supports pull type schedule. On Dispatching, a lot 
with the highest priority is selected for next processing. However, in scheduling of an 
equipment group that has a lot of equipment and whose setup takes long time, 
decisions for job change need to consider the production goal for each product and lot 
arrival pattern for each steps using the equipment group in order to reduce Step Loss 
and increase equipment efficiency. JobChangeAgent is a planning function from 
SeePlan which supports this kind of decision making.
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JobChangAgent consists of the following five components.

AgentInit
This component defines equipment (step) group that needs to make decisions for 
JobChange and initializes input lot or available resource for the corresponding group.

JobProfileControl
This is the Component to write In/Out profile of the Wip to be used as a reference 
when performing JobChange decision making. This Component is called on each 
JobChange decision making cycle and could be called multiple time in one cycle 
depending on the case.

JobChangeControl
This is the JobChange Main Logic Component to perform JobChange decision making 
and controlling the Queue. If the JobChange decision making(AgentType) of 
WorkAgent is CHANGE method, this component is performed. The CHANGE type 
JobChange decision making first decides the Down target Step(WorkStep) and then 
allocates Down or Idle equipment to Up target Step(WorkStep). This component is 
called on each JobChange decision making cycle.

JobTradeControl
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This is the JobChange Main Logic Component to perform JobChange decision making 
and controlling the Queue. If the JobChange decision making(AgentType) of 
WorkAgent is TRADE method, this component is performed. The TRADE type 
JobChange decision making first decides the Up target Step(WorkStep) and then 
allocates equipment that is allocated to other Step or Idle equipment to Up target 
Step(WorkStep). This component is called on each JobChange decision making cycle.

JobChangeEvents
This is a set of function to handle events triggered when JobChangeAgent Model is 
executed. User-defined logic can be added at the corresponding point.

SeePlan Library Class Structure for JobChangeAgent

JobChange Agent Class Definition

WorkManager Class
The class that administrates the entire logics of the JobChangeAgent. This class is 
initialized automatically during AoFactory initiation.

WorkManager
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Method/Memebers
Data Type(Return

Type)
DefinitionMethod/Memebers

Data Type(Return
Type)

Definition

Duration Time Agent Rolling Cycle Time

Initialized bool

Specifies whether the WorkManager is
initialized. The simulation lots are
stored temporary before WorkManager
initialization and changes to WorkLot
entities after WorkManager initiation.

Agents ICollection<WorkAgent>
The list of WorkAgents in the
WorkManager.

AddLot(IHandlingBatch) void
Adds the WorkLot to the WorkStep.
This method is called when WIPs are
initialized during simulation.

UpdateLot(IHandlingBatch) void
Updates the WorkLot information when
lot event occurs during simulation.

RemoveLot(IHandlingBatch) void
Removes the WorkLots from the
WorkStep. This method is called at the
end of simulation.

AgentType (ENUM)
Specifies the job change logic type of the WorkAgent.

AgentType

Method/Memebers Definition

CHANGE Specifies the CHANGE type WorkAgent

TRADE Specifies the TRADE type WorkAgent

WorkAgent Class
The run unit class which can independently execute the job change logic.

WorkAgent 

Method/Memebers Data Type(Return Type) Definition

Id string Agent ID

AgentType AgentType(Enum)
AgentType =
{“CHANGE”,”TRADE”}

https://www.notion.so/Duration-7d5aab01ec2a4d10ab0b7875ca07867a
https://www.notion.so/Initialized-7fe8d5a66f12472fb27794590271354c
https://www.notion.so/Agents-9f80fe48fa0a41639442de9280fab538
https://www.notion.so/AddLot-IHandlingBatch-f792def969fa4ddabaee1df66da71345
https://www.notion.so/UpdateLot-IHandlingBatch-a1433573a83643c38b7df3ff35e6f870
https://www.notion.so/RemoveLot-IHandlingBatch-0fe4649a6cf44dc1b681daff7e84b5ec
https://www.notion.so/CHANGE-1cc593dbcfd840d89c999b7601413dd5
https://www.notion.so/TRADE-a4cc677b8de0427d8b48e9936df708b3
https://www.notion.so/Id-d529905958be4b31afa9c4ba852dfa60
https://www.notion.so/AgentType-f7a1857a56424465846f82784bc61b88
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Method/Memebers Data Type(Return Type) Definition

Groups IList<WorkGroup>
The list of WorkGroups in
the WorkAgent.

Interval Time
The run cycle of the
WorkAgent

LastActiveTime Time
The last run time of the
WorkAgent.

Factory AoFactory AoFactory object.

LoadableWorkSteps Dictionary<AoEquipment,List<WorkStep>>

The list of WorkSteps where
each equipment in the
equipment list can process
to.(

Context JobChangeContext

Only when AgentType =
“TRADE” The context to
store global variables to use
at WorkAgent run.

AssignedInfos Dictionary<AoEquipment,AssignEqp>
Stores the information of the
equipment that requires job
change.

IsReProfiling bool

Only when AgentType =
“TRADE” Specifies whether
to reconstruct the profile of
the WorkGroup where the
WorkStep, that changed
after equipment allocation
changed, belongs to. If true
is returned, profiles for all
WorkSteps in the
WorkGroup where the
updated WorkStep
(equipment assigned or
released) belongs to, are
recalculated. In this case,
equipment can be assigned
additionally to the Up
specified WorkStep after
one equipment is assigned.

https://www.notion.so/Groups-e894df29b3f04b91aa7d3f6dbadb22ca
https://www.notion.so/Interval-baa0d1cfe1b54caeab3e3c7329facadb
https://www.notion.so/LastActiveTime-b874afcf891b4bbaa06bec6b324708df
https://www.notion.so/Factory-0781620d2359483888c9f24380a64eac
https://www.notion.so/LoadableWorkSteps-08502d0878c34772aa08335ae95a24cb
https://www.notion.so/Context-9bb939b16a1042aaa4fd15f5ab0f3fa6
https://www.notion.so/AssignedInfos-01ae5552728c48009ccf7914c45f1d2b
https://www.notion.so/IsReProfiling-d50f518e0818481490b6a56dfc7be0d1
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Method/Memebers Data Type(Return Type) Definition

IsReleaseDownEqp bool

Only when AgentType =
“TRADE” Specifies whether
to release an equipment
from the WorkStep specified
as Down. True, to release
equipment from Down
specified WorkStep;
otherwise, false.

AddDummyProfile bool

Specifies whether to create
individual dummy lots and
add to the profile when idle
time occurs due to
equipment state changes to
idle or setup is occurred
during profile calculation.
True, to add dummy lot to
the profile each time when
idle time occurs; otherwise,
false.

WorkGroup Class
The group of products with same work condition. When WorkGroup is changed, it 
means job change has occurred. WorkGroup is also used by the WorkAgent to 
evaluate in/out profile.

WorkGroup 

Method/Memebers
Data

Type(Return
Type)

Definition

Steps List<WorkStep> The list of WorkSteps in the WorkGroup.

Agent WorkAgent
The WorkAgent where the WorkGroup belongs
to

Factory AoFactory AoFactory object

Key object WorkGroup Key

Data object User defined data

https://www.notion.so/IsReleaseDownEqp-abdae9f85ec146ebacc267437b11a003
https://www.notion.so/AddDummyProfile-c89c0a8512ee4aa283fec01a155d620c
https://www.notion.so/Steps-ac57774b144243a9a9184fb9a65e0cf4
https://www.notion.so/Agent-198d03e65d6d4bd7a4104e3f1aadb658
https://www.notion.so/Factory-21b256043a004b6b903f49a7b19a318a
https://www.notion.so/Key-9c52575afafc4944af4a9cfcdf9f6177
https://www.notion.so/Data-4b3532ea79884e6097d02a828b4a9ea8
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Method/Memebers
Data

Type(Return
Type)

Definition

Ordered bool

Indicates whether to create profile in the sorted
order of the WorkStep. true  to sort the
WorkStep within the specified WorkGroup to
create profile in the sorted order by calling
JobProfileControl.CompareProfileStep  method;
otherwise, false .

CalculateProfile() void

Gets the list of all the equipment in production
from all the WorkSteps in the WorkGroup and
calculates the in/out profile for all the
WorkSteps.

CalculateProfile(WorkStep) void
Calculates the in/out profile for all the working
equipment in the specified WorkStep.

OpertionType (ENUM) - Used only in AgentType = "TRADE"
Specifies the WorkStep’s operation type after evaluating out profile. This enumeration 
is only used in TRADE WorkAgent type.

OperationType

Method/Memebers Definition

Keep
Specifies to keep the current equipment allocation of the specified
WorkStep.

Up
Specifies that the specified WorkStep requires additional equipment
allocation.

Down
Specifies that the specified WorkStep has to release an equipment from
the current allocation.

Hold Specifies no job change decision will be made on this agent cycle.

WorkStep Class
The step that is processed by the equipment group that is specified for job change 
decision. WorkStep is created per WorkGroup and in case the actual processing step 
is the same, it is treated and created as different WorkSteps if the WorkGroups are 
different. WorkStep is the unit in which profile is calculated and decision is made 
whether to assign or release equipment from.

https://www.notion.so/Ordered-b4c71f9c7f8b44e6a6da1f78fbea640d
https://www.notion.so/CalculateProfile-bbebe6e3403d4eaa927a6e9cd49711a2
https://www.notion.so/CalculateProfile-WorkStep-618a8b70d98e467fb934d5beb5316049
https://www.notion.so/Keep-08c9b92cecbf4d12a9d9a34223a83c6f
https://www.notion.so/Up-ae0a1b6d6daf490f9e7b5c2de99e5ba0
https://www.notion.so/Down-0c0693d538d54337b1ae119c021132f6
https://www.notion.so/Hold-d3219644d705409492a8a949421084f6
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WorkStep

Method/Memebers Data Type(Return Type) Definition

Group WorkGroup
The WorkGroup where the
WorkStep belongs to.

Agent WorkAgent
The WorkAgent where the
WorkStep belongs to.

Factory AoFactory AoFactory object

Key object
The key in which identifies
WorkStep.

Steps IList<Step>

The list of actual steps in t
Route(simulation steps) m
the WorkStep. In general, 
among simulation step and
is 1:1. However if the prod
WorkGroup are produced 
equipment and do not requ
to produce, but each produ
steps are different, then th
among WorkStep and sim
steps can be 1: n.

LoadableEps ISet<AoEquipment>

The list of equipment that 
produce the products in th
WorkGroup and process fr
specified WorkStep .

LoadedEqps ICollection<WorkEqp>
The list of equipment curre
producing the products of 
WorkGroup at the WorkSte

LoadedDictionary IDictionary<string, WorkEqp>
The equipment currently p
the product of the WorkGr
WorkStep. Dictionary, Key

LoadedEqpIDs List<string>

The list of equipment proc
the WorkStep. If
LoadedEqpDictionary is no
list of keys (EPQ_ID) is ret
otherwise a new list of EQ
returned.

LoadedEqpCount int
The numbers of equipmen
processing at the WorkSte

https://www.notion.so/Group-1e44efd9b1a64f79bc1401ca2667cb19
https://www.notion.so/Agent-1ff9fab168b9487bbbe431e46c6af6e4
https://www.notion.so/Factory-be5105f2353946b99c12b66e411f2e89
https://www.notion.so/Key-9e9767310f604899bf243b6ae73a4891
https://www.notion.so/Steps-744d1430317c4340a74bd25dcc7a4003
https://www.notion.so/LoadableEps-b09a515ced3a44a4a815208f7717f9f4
https://www.notion.so/LoadedEqps-233f545faa324b148323c02aa725b192
https://www.notion.so/LoadedDictionary-dfe6d1643bc5487abaa45d8d4ba87140
https://www.notion.so/LoadedEqpIDs-98570e87e2fa4224acc9ed3835b54ebb
https://www.notion.so/LoadedEqpCount-83824cd968bc4495bed38971ccf8c255
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Method/Memebers Data Type(Return Type) Definition

InFlows SearchQueue<WorkLot>
The entities that can be loa
the current WorkStep.

Wips List<WorkLot>

Inflows (WorkLots in the cu
WorkStep) + inflow entities
arrived from the previous W
The WorkLots in Wips are 
the Loader to load the Wo
the equipment in the Work
Loader first initiates the eq
with Inflows and starts to lo
WorkLots.

Profiles
MultiDictionary<IHandlingBatch,
WorkLot>

The WorkLots allocated to
WorkEqp by the WorkLoad
are initialized when profile
starts.

OperationType OperationType(Enum)

Specifies the WorkStep’s o
type after evaluating out p
enumeration is only used i
WorkAgent type.

Reason object
The reason for the WorkSt
operation type setting.

IsDown bool

The variable indicating to a
change the WorkStep as D
WorkStep when it is specif
Down. This variable is rese
new profile is calculated.

Unassigns List<ISimEntity>

The list of simulation lots i
queue of the equipment se
be released from the Dow
WorkStep.

ProfileAssignWips ISet<WorkLot>

The WorkLots that have be
during profile calculation. T
initialized when out profile 
of the WorkStep starts.

FindOverTime(Time decision,
Time gap)

WorkLot

Returns the WorkLot in the
where WorkLot.InTime is g
decision. If the equipment 
longer than gap then the la
WorkLot is returned.

https://www.notion.so/InFlows-156151d695514467ad1ea450fdfa2f0c
https://www.notion.so/Wips-5f078d55ca1d4ae4a06ab499ebeef5f6
https://www.notion.so/Profiles-9ca665e914814767bb23a738b5dd1389
https://www.notion.so/OperationType-7bd5388e09e34517a3be5e7d90caa977
https://www.notion.so/Reason-36018d95b45346baa15aea24ac5d2be9
https://www.notion.so/IsDown-0866cb5b668e485fb3268b39b15383a5
https://www.notion.so/Unassigns-c321ebe799aa42c6a6604185a6d556bb
https://www.notion.so/ProfileAssignWips-92e359a2125648208c18f67256a51c59
https://www.notion.so/FindOverTime-Time-decision-Time-gap-a2aa9b27bba34dc8a52a62054cf86ae1
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Method/Memebers Data Type(Return Type) Definition

AllowedArrivalGap Time

The time limit for the
equipment(minimum idle t
for the next WorkLot to arr
WorkStep. If the WorkLot a
the time limit, the job for th
equipment needs to be ch
Used as one of the key arg
WorkLot.FindOver method

UpInterval Time

The job conversion time of
WorkLot inflow in order to 
whether additional equipm
allocation is required to thi
WorkStep. If the job conve
of the WorkLot inflow is lar
UpInterval, the WorkStep r
additional equipment alloc
process the WorkLots. � In
WorkAgent = ChangeType
UpInterval is used from the
definition of
JobChangeControl/IsNeed

DownInterval Time

The job conversion time of
WorkLot inflow in order to 
whether to remove an equ
from the WorkStep. If the j
conversion time of the Wo
is lower than DownInterva
equipment from this WorkS
released and change job t
from other WorkStep. � In 
WorkAgent = ChangeType
DownInterval is used from
definition of
JobChangeControl/IsNeed

https://www.notion.so/AllowedArrivalGap-152e27261a9f491c8571d89b78d27091
https://www.notion.so/UpInterval-f9bf788fae254bdf81d87d629de3bbad
https://www.notion.so/DownInterval-88b4d2c86bf84dc394cb4044d5da318b
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Method/Memebers Data Type(Return Type) Definition

NewUpInterval Time

The minimum time for the 
to maintain its current assi
the newly assigned WorkS
equipment must continue 
the same product entities f
given time before it could b
assigned to another WorkS
new job. � In case of Work
ChangeType, NewUpInter
from the default definition 
JobChangeControl/IsNeed

AddedLoadedEqp(AoEquipment,
bool is Real=true)

void
Adds the equipment used 
Loader to load WorkLots to
profile.

RemoveLoadedEqp(AoEquipment,
bool isReal=true)

void
Removes the equipment u
Loader to load WorkLots to
profile.

Data object User defined data

WorkLot Class
The data class of the entity used by JobChangeAgent to calculate profile.

WorkLot

Method/Memebers

Data
Type(Return
Type)

Definition

Batch IHandlingBatch The simulation batch entity mapped to the WorkLot.

Lot ILot The simulation lot mapped to the WorkLot.

StepKey object
The key of the WorkStep in which the WorkLot is to be
processed.

Step Step The current step information of the simulation entity.

AvailableTime Time The time to arrive at the WorkStep.

InTime Time
The plan start time(Loading Start Time) used in profile
calculation. The time WorkLot was loaded to the
equipment of the WorkStep by the Loader.

https://www.notion.so/NewUpInterval-f88afe1fda2745f28a9a7857e7c1f286
https://www.notion.so/AddedLoadedEqp-AoEquipment-bool-is-Real-true-0888bee3ae484c73824a448088c8c4a5
https://www.notion.so/RemoveLoadedEqp-AoEquipment-bool-isReal-true-a2bc25b3db9a454ebe6b4ae010cc5be8
https://www.notion.so/Data-f2db5cbd8c454b2f8df9d068695ae5a3
https://www.notion.so/Batch-700e23dfa9604e1e8c58ad7461b02168
https://www.notion.so/Lot-7aaaf03e513b45aebd66ae6ed10d9b6f
https://www.notion.so/StepKey-319304a36a0447a0a30359afb7e59ef1
https://www.notion.so/Step-cd755325ba6d49a980f30c5941cd0d4c
https://www.notion.so/AvailableTime-0728150693024bc3a042d3dfaec29efe
https://www.notion.so/InTime-cf668ed99fcb4682b28f0cfa42727b4c
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Method/Memebers

Data
Type(Return
Type)

Definition

OutTime Time
The plan end time (Loading End Time) used in profile
calculation. The time WorklLot was unloaded from the
equipment of the WorkLot by the Loader

InEqp WorkEqp
The equipment used during in/out profile calculation. The
equipment where the WorkLot is loaded to.

ProfileType WorkLotType

Specifies the state of the WorkLot during profile
calculation. = {‘Busy’, ‘Idle’, ‘Setup’, ‘PM’}. All ProfileType
except for ‘Busy’ is used by the DummyLots to shift idle
time during profiling and can be set when
WorkAgent.AddDummyProfile = true.

WorkUpInfo Class - Used only in AgentType = "Change"
The data class used from CHANGE WorkAgent which contains the information of the 
changed job for the job changed equipment.

WorkUpInfo

Method/Memebers

Data
Type(Return
Type)

Definition

Target AoEquipment AoEquipment

Setups List<WorkStep> The list of WorkSteps where setup occurs.

NoSetups List<WorkStep> The list of WorkSteps where setup does not occur.

IsEmpty bool
Indicates a value whether no WorkSteps are in either
Setups  or NoSetups . True if empty; otherwise, false.

WorkLoader Class 
The class that administers the out profile creation of the WorkStep in 
JobChangeAgent. The WorkLoader instance is created for each WorkGroup and 
disposed after profiling is completed.

WorkLoader 

Method/Memebers

Data
Type(Return
Type)

Definition

https://www.notion.so/OutTime-acaea45b5cca4f9887cad181efb577e3
https://www.notion.so/InEqp-fec02f90134d462f96b89ac3d998eeda
https://www.notion.so/ProfileType-01b919328f144f43a54c6338a6c8ba84
https://www.notion.so/Target-53bfccaadc134662a6ab00b8ba348e3c
https://www.notion.so/Setups-c784b8e586be4075be5d2b4f2414bbee
https://www.notion.so/NoSetups-b202c4e27dcb40dd99851f2dd2653837
https://www.notion.so/IsEmpty-e33c08a2bd5f45c4a5c3dca534f13135
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Method/Memebers

Data
Type(Return
Type)

Definition

EqpList List<WorkEqp>
The list of WorkEqp to load WorkLots from the
WorkLoader.

Steps List<WorkStep> Gets the list of WorkSteps to create profile.

Group WorkGroup
The WorkGroup to load and create profile (The entities
in the WorkSteps of the WorkGroup)

LockAdvance bool
Indicates whether to move the WorkLot to another
WorkStep within the WorkGroup to continue to calculate
profile. Default value is false.

Load() void

The method to create profile using the entities of the
WorkGroup and WorkEqp listed in the WorkLoader. This
is where the WorkLoader starts to load the WorkLots of
the WorkGroup to the WorkEqp at the WorkStep and
creates profile.

WorkEqp Class
The class to reference the information of the equipment from JobChangeAgent and 
used from the WorkLoader to load WorkLots and create profile.

WorkEqp 

Method/Memebers
Data

Type(Return
Type)

Definition

Target AoEquipment
The simulation equipment mapped to the
WorkEqp.

AvailableTime Time The next available time to load the WorkLot.

IncludeBufferForAvailableTime bool
Indicates whether to consider the WorkLot in
the buffer to get the next available time for
loading.

Data object User defined data

Step WorkStep
The WorkStep in which the WorkEqp is
processing at.

Stop bool
Indicates the value whether to stop loading
WorkLot to the WorkEqp. True, to stop loading
WorkLots; otherwise, false.

https://www.notion.so/EqpList-a259cb877f2443e8b6521778a2909be0
https://www.notion.so/Steps-3613961df32644f095eb7a1bd748ff2f
https://www.notion.so/Group-6e084def35af46b4b62ac308d1cf5b35
https://www.notion.so/LockAdvance-2171c0a069b74b338ed7d377d5b2ebfa
https://www.notion.so/Load-44548e85268d4641bb6671414ec9d933
https://www.notion.so/Target-9d114242656540b6ae5843216377cf70
https://www.notion.so/AvailableTime-0f4c20f85f4049958c032d76d168cffc
https://www.notion.so/IncludeBufferForAvailableTime-fea6614a818143d5befdce8bc7cdd0ea
https://www.notion.so/Data-d213a866f26445e6a4f5330f1e930458
https://www.notion.so/Step-404bc11fb0ec494e8e0d3f66d809882a
https://www.notion.so/Stop-55270e8cfb334d5a95b8ed0493289e2e


MOZART IDE (ENG) 265

Method/Memebers
Data

Type(Return
Type)

Definition

IsDone() bool

Specifies whether all WorkLots are loaded to
the WorkEqp or Stop = true.  True, if all
WorkLots in the WorkSteps are loaded or Stop
= true ; otherwise, false.

JobChangeContext Class - Used only in AgentType="TRADE"
The class to store global variables to be used in TRADE type job change decision.

JobChangeContext 

Method/Memebers

Data
Type(Return
Type)

Definition

UpList List<WorkStep>
The list of WorkSteps specified to be allocated with
additional equipment. The list is made after profile
calculation.

KeepList List<WorkStep>
The list of WorkSteps to keep the current equipment
allocation.

DownList List<WorkStep>
The list of WorkSteps to release equipment from its
current task.

HolderList List<WorkStep>
The list of WorkSteps in which no decision was made
or pended for the current agent cycle.

CurrentUpWorkStep WorkStep
The WorkStep selected from the UpList when TRADE
is executed. (WorkStep selected from
TradeControl/SelectUpStep)

CurrentDownSteps List<WorkStep>
The list of WorkSteps specified as Down during
TRADE execution

AllAssignEqps List<AssignEqp>
The list of equipment that can be assigned to the
CurrentUpWorkStep, selected during Trade
execution.

FilteredAssignEqps List<AssignEqp>
The list of the equipment that can be assigned to the
CurrentUpWorkStep that matches the criteria defined
within DoFilterAssignEqp FEAction.

SelectedAssignEqps List<AssignEqp>

The list of the best equipment out of
FilteredAssignEps list to assign to the
CurrentUpWorkStep. The list of AssignEqp is
returned from SelectAssignEqp FEAction.

https://www.notion.so/IsDone-a4f0e2f90c5d460f9bd1b23a78c0f2d3
https://www.notion.so/UpList-b95b1c7b23f84d13b4f1481698b485f1
https://www.notion.so/KeepList-18451fbb0b57459fbf281962c88564b6
https://www.notion.so/DownList-26047f5c66ff4bcd9a231cd0eac93dd3
https://www.notion.so/HolderList-9d0088e3793f4315b9ec5288c9036765
https://www.notion.so/CurrentUpWorkStep-9da8c3e9206d4a3f925578d3a4cbd273
https://www.notion.so/CurrentDownSteps-8cc45ade95314cd2bb5192ddd57f2ac3
https://www.notion.so/AllAssignEqps-3cc8e11c653d4288b67f703c85220827
https://www.notion.so/FilteredAssignEqps-2097df610f0d46faadd2d77c86f8221e
https://www.notion.so/SelectedAssignEqps-e8137d2f1d254115b68fb88d9ceee643
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Method/Memebers

Data
Type(Return
Type)

Definition

AssignedEqps List<AssignEqp>
Gets the list of equipment allocated during agent
execution.

Data object User defined data

AddStep(WorkStep,
OperationType,
object reason = null)

void

Adds the specified WorkStep object to the list of
WorkSteps having the same specified OperationType
classification. If the specified WorkStep is already in
one of the list of WorkSteps with same
OperationType, the specified WorkStep will replace
the old WorkStep.

AssignEqp Class - Used only in AgentType = "TRADE" 
The data class of the equipment assigned to the specified WorkStep.

AssignEqp 

Method/Memebers
Data Type(Return

Type)
Definition

Target AoEquipment The WorkStep where the equipment is assigned to.

WorkStep WorkStep The mapping data of AoEquipment object.

IsAssigned bool
Indicates a value if the equipment was assigned
during agent run.

AgentInit Control

AgentInit is a component to define equipment (step) group that has to make decisions 
for JobChange and to initialize released lots and available resources for the 
corresponding group.

https://www.notion.so/AssignedEqps-70b9d86e7de94d8eba228ca87da37a4c
https://www.notion.so/Data-ae8653efb1434f37a3483754978b493c
https://www.notion.so/AddStep-WorkStep-OperationType-object-reason-null-834454ffbfff40188341c0423658fb38
https://www.notion.so/Target-ec5305cd24b847fa97b4e86ad64ed614
https://www.notion.so/WorkStep-ab79eb4f8a3c4e69a07c368284ea5c5a
https://www.notion.so/IsAssigned-b2463600102e4196b7ff292ca99a739f
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1. InitializeWorkManager : This initializes WorkManager that manages all 
JobChangAgents. Agent is created for each object which needs to add JobChange 
Agent depending on Modelling. Also Agent Key is defined.

Default Login Example

public void INITIALIZE_WORK_MANAGER_DEF(WorkManager wmanager, ref bool handed) 
{ 
    var agentInitControl = ServiceLocator.Resolve<JobChangeInit>(); 
    var agents = agentInitControl.GetWorkAgentNames(wmanager); 
    if (agents != null) 
    { 
        foreach (var agent in agents) 
        wmanager.Add(agent); 
    } 
}
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2. GetWorkAgentNames : This defines the name of the Agent to be incluede to 
WorkManager.

3. InitializeAgent : This configures the execution cycle of Agent and JobChange 
methodology..

4. AddWorkLot : This registers the target lot for releasing to WorkAgent. This is 
performed for each entity at WIP initialization stage and performed each time lot is 
created/released (AoFactory.Current.In) afterwards.

Default Logic Example

public WorkStep ADD_WORK_LOT_DEF(IHandlingBatch hb, ref bool handled, WorkStep prevR
eturnValue) 
{ 
    var agentInitControl = ServiceLocator.Resolve<JobChangeInit>(); 
    var wagentName = agentInitControl.GetWorkAgentName(hb); 
    if (string.IsNullOrEmpty(wagentName)) 
    return null; 
    var wmanager = AoFactory.Current.JobChangeManger; 
    var wagent = wmanager.GetAgent(wagentName); 
    if (wagent == null) 
    return null; 
    var wgroupKey = agentInitControl.GetWorkGroupKey(hb, wagent); 
    if (wgroupKey == null) 
    return null; 
    var wgroup = wagent.GetGroup(wgroupKey); 
    var wstepKey = agentInitControl.GetWorkStepKey(hb, wgroup); 
    if (wstepKey == null) 
    return null; 
    var targetStep = agentInitControl.GetTargetStep(hb, wgroup, wstepKey); 
    if (targetStep == null) 
    return null; 
    var wstep = wgroup.GetStep(wstepKey, targetStep); 
    var availablaTime = agentInitControl.GetAvailableTime(hb, wstep, targetStep); 
    var wlot = new WorkLot(hb, availablaTime, wstepKey, targetStep); 
    wstep.AddWip(wlot); 
    return wstep; 
}

5. GetWorkAgentName : This configures the name Agent where release target lots 
will belong to.

6. GetWorkGroupKey : This configures the Key of the WorkGroup where release 
target lots will belong to. If the Key reference WorkGroup is not in the Agent, a new 
WorkGroup is created and at this point, the created WorkGroup is initialized.

7. CompareWorkGroup: The FEAction where you can apply the rules to sort the 
WorkGroup . The profiles for WorkGroup  will be created in the sorted order from 
ProfileControl  later on.
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8. GetWorkStepKey : This configures the Key of the WorkStep where release target 
lots will belong to. If the Key reference WorkStep is not in the Agent, a new 
WorkGroup is created and at this point, the created WorkStep initialized.

9. GetTargetStep : This configures the target Step of the release target lots. Target 
Step will be registered as the Step managed by WorkStep where the release 
target lot belongs.

10. GetAvailableTime : This configures the arrival time to WorkStep of the release 
target lot. When the lot state changes after initialization, the arrival time can be 
updated through Update Action of JobProfileControl.

11. InitializeWorkGroup : Initializes WorkGroup when Agent is registered to 
WorkGroup.

12. InitializeWorkStep : Initializes WorkStep when WorkStep is registered to 
WorkGroup. See the note below to check the major parameters of WorkStep for 
configuration.

AllowArrivalGap : A Time Limit that an equipment can wait for a next lot when 
the equipment's Down occurs. If next release lot arrives at a WorkStep after 
the configured time, the equipment should change its target product.

UpInterval : Time criterion that determines equipment's Up. If processing time 
converted from the quantity of released lots is less than the criterion, increase 
the number of equipment that handle WorkStep.

DownInterval : Time criterion that determines equipment's Down. If 
processing time converted from the released quanity of lots is less than the 
criterion, decrease the number of equipment that handle WorkStep.

NewUpInterval : The minimum time to maintain the same task after WorkStep 
is changed. The product cannot be changed during this time.

Default Logic Example

public void INITIALIZE_WORK_STEP_DEF(WorkStep wstep, ref bool handled) 
{ 
    var agentInitControl = ServiceLocator.Resolve<JobChangeInit>(); 
    var loadables = agentInitControl.GetLoadableEqps(wstep); 
    if (loadables != null) 
    { 
        loadables.ForEach(aeqp => wstep.AddLoadableEqp(aeqp)); 
    } 
}
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13. GetLoadableEqps : This sets the list of equipment that could be allocated to the 
WorkStep.

14. InitializeWorkEqp : When LoadedEqp is included to WorkStep, it is saved as 
WorkEqp. This is used to initialize WorkEqp.

15. IsRunningLot : This action is used to apply user-defined logic to determine RUN 
WorkLots at the point LoadedEqp is set to WorkStep.

16. GetRunningWorkStep : Returns the WorkStep  where the RUN WIP specified from 
IsRunningLot  is processed.

JobProfileControl Control

This is the Component to write In/Out profile of the WIP to be used as a reference 
when performing JobChange decision making. This Component is called on each 
JobChange decision-making cycle and could be called multiple times in one cycle 
depending on the case.
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1. FilterProfileSteps: Returns the list of WorkSteps to calculate profile. The 
WorkStep to not calculate the profile can be filtered through this FEAction.

2. CompareProfileStep : This FEAction sorts the WorkSteps within the same 
WorkGroup before profile calculation. This FEAction is called when WorkGroup. 
The ordered property value is set as true.

3. PrepareProfileStep : This FEAction is where you implement your logic to finalize 
the properties of all WorkStep s before profiling begins. When a WorkStep has 0 
LoadedEqpCount  after CompareProfileStep  FEAction is called, this WorkStep  parameter 
will no longer be passed to other FEActions within JobProfileControl . So you can 
implement logic to inquire the information of the filtered WorkStep s or to write logs 
regarding them. 

4. OnBeginProfiling : This FEAction is used to apply user-defined logic to handle 
certain tasks before profile calculation(Out Profile) begins.

5. SelectProfileEqp : This action searches an Loaded equipment that will process a 
new input lot for each WorkStep. Among working Equipment at current WorkStep, 
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a logic is implemented to search Equipment in sorting order defined in 
CompareEqp and then returned.

Default Logic Example

public WorkEqp SELECT_PROFILE_EQP_DEF(IEnumerable<WorkEqp> eqps, ref bool handled, W
orkEqp prevReturnValue) 
{ 
    var jobChangeControl = ServiceLocator.Resolve<JobChangeControl>(); 
    WorkEqp min = null; 
    foreach (var eqp in eqps) 
    { 
        if (eqp.IsDone()) 
            continue; 
        if (min == null || jobChangeControl.CompareEqp(min, eqp) > 0) 
            min = eqp; 
    } 
 
    return min; 
}

6. CompareProfileEqp : The default logic sorts Equipment in the order of Equipment 
that a lot can be loaded at the earliest time. If user want to make input lots be 
loaded in a specific order, the corresponding sorting logic should be implemented. 
If the default definition of SelectProfileEqp is not used and redefined by logic 
implementation, CompareProfileEqp is not called.

Default Logic Example

public int COMPARE_PROFILE_EQP_DEF(WorkEqp x, WorkEqp y, ref bool handled, int prevR
eturnValue) 
{ 
    if (object.ReferenceEquals(x, y)) 
        return 0; 
    int cmp = x.AvailableTime.CompareTo(y.AvailableTime); 
 
    return cmp; 
}

7. DoFilter : Selects the lot to be loaded to WorkEqp to create Out Profile.

8. SortProfileLot : Sorts the lot to be loaded to WorkEqp to create Out Profile.

Default Logic Example

public void SORT_PROFILE_LOT_DEF(WorkStep wstep, List<WorkLot> list, ref bool handle
d) 
{ 
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    list.Sort(WorkLotComparer.Default); 
}

9. IsStopLoading : The logic is implemented in this method to return true or false. 
While the current step is the target to cacluate profile and the next step is also the 
target, false is returned or else true will be returned. Default value is true.

10. GetProfileQty : Gets lot quantity to be used for Profile calculation. This FEAction 
is called only when IsStopLoading FEAction returns false.

11. GetTactTime : Returns the processing time of the equipment of the specified 
WorkLot to calculate and write profile. This FEAction is called only when 
IsStopLoading FEAction returns false.

12. GetProfileTimes : Sets the time to use to calculate and write profile. The profile 
will not be created if the type of the start and end time are the same. This FEAction 
is called only when the value of WorkAgent.AddDummyProfile  property is set as 
true.

13. CreateDummyWorkLot : Creates WorkLot to contain information for non-working 
sections such as Idle, PM, Setup. This FEAction is called only when the value of 
WorkAgent.AddDummyProfile property is set as  true.

Default Logic Example

public WorkLot CREATE_DUMMY_WORK_LOT_DEF(WorkStep wstep, WorkEqp weqp, WorkLot wlot, 
WorkLotType type, Time startTime, Time endTime, object stepKey, Step step, ref bool
 handled, WorkLot prevReturnValue) 
{ 
    return WorkLot.Create(null, startTime, stepKey, step, type); 
}

14. Advance : A step subsequent to the current step is configured in WorkLot. This 
FEAction is called only when IsStopLoading FEAction returns false.

15. OnEndProfiling : This FEAction is used to apply user-defined logic to handle 
certain tasks after Profile calculation(Out Profile) is completed.

16. UpdateFindStep : Selects the WorkStep for the state changed lots.

17. GetMappingLot : This FEAction is to map the actual lot object moving from step 
to step with lot object managed from JobChangeAgent in case these two 
information does not match. For instance, when lot is grouped as batch to move 
among steps, in JobChangeAgent, individual lots are set as WorkLot and 
equipment are allocated to each individual lots instead of batches. In this case, this 
FEAction is used to find equipment for the batch which cannot find the equipment 
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to be loaded and to calculate and update the arrival time of each lots in the batch 
group.

18. Update : Lots that are configured as input for JobChange's Target Step, updates 
their arrival time to the target step when their state changes (These lots' 
JobChange is decided through JobChangeAgent). So target Step's In/Out Profile 
can be calculated more precisely. This function returns an updated arrival time to 
target Step for each input lot.

JobTradeControl Control

Overview 
This is the JobChange Main Logic Component to perform JobChange decision making 
and controlling the Queue. If the JobChange decision making(AgentType) of 
WorkAgent is TRADE method, this component is performed. The TRADE type 
JobChange decision making first decides the Up target Step(WorkStep) and then 
allocates equipment that is allocated to other Step or Idle equipment to Up target 
Step(WorkStep). This component is called on each JobChange decision-making cycle.

JobTradeControl

Concept of TRADE method Job Change 
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JobchangeTrade Logic consists of functions to handle logics such as 1) Profile 
evaluation and reassigning equipment, 2) returning equipment from remaining Down 
target.

1. ClassifyOperationType : This evaluates the Profile of WorkStep. The evaluation 
result is classified as UP/Down/Keep/Hold. ClassifyOperation  FEAction is called 
right after profiling is completed from JobProfileControl  and is also called in case 
reprofiling is required for certain WorkSteps during equipment allocation to Up 
classified WorkSteps.

Up : Requires to be assigned with additional equipment.

Down : The WorkStep needs to release one of its assigned equipment. The 
WorkStep is classified as Down when it can accomplish the production target 
even though a piece of equipment is removed.

Keep : Postponed to be classified as Up or Down.

Hold : Maintains the current state of equipment. The currently assigned 
equipment will not be assigned to other WorkStep.

2. OnAfterClassifyOperationType :  This FEAction is called when 
OpertionType (Up,Down,Hold,Keep) for all WorkSteps are classified within the 
WorkAgent execution cycle. For a better explanation, 
OnAfterClassifyOperationType FEAction is always called when 
ClassifyOperationType  is called. So basically this FEAction is called either when 
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profiling is completed from JobTradeControl  or when 
reprofiling( WorkAgent.IsReprofiling=true ) is performed for the WorkGroup. The value 
of the isRecalc  parameter indicates whether OnAfterClassifyOperationType  was 
called during reprofiling. true indicates the FEAction was called during reprofiling 
or not. You can implement logic to inquire information such as the OperationType  
classification result for each WorkStep or compare the classification result among 
other WorkSteps. 

3. CalculatePriority : Decides the priority of Up target WorkStep. The evaluation 
results to classify the OperationType  of the WorkStep is stored in WorkStep.Data . The 
values in WorkStep.Data  is used to evaluate the priority of the WorkStep when 
CaculatePriority  FEAction is called. 

4. SelectUpStep : Selects the Up classified WorkStep placed as the highest priority 
to assign the equipment. If no logics are implemented to SelectUpStep  FEAction, 
the WorkStep will be selected from CompareUpStep  FEAction which is called from the 
default definition of SelectUpStep  FEAction. 

Default Logic Example

public WorkStep SELECT_UP_STEP_DEF(List<WorkStep> upWorkSteps, JobChangeContext context
{ 
    if (upWorkSteps.IsNullOrEmpty()) 
    return null; 
    var jobChangeControl = ServiceLocator.Resolve<JobTradeControl>(); 
    upWorkSteps.QuickSort(jobChangeControl.CompareUpStep); 
    return upWorkSteps.FirstOrDefault(); 
}

5. CompareUpStep : Compares the priority among WorkSteps.

Default Logic Example

public int COMPARE_UP_STEP_PRIORITY_DEF(WorkStep x, WorkStep y, ref bool handled, in
t prevReturnValue) 
{ 
    return y.Priority.CompareTo(x.Priority); 
}

6. DoFilterAssignEqp : Filters equipment that could not be assigned to Up target 
WorkStep.

7. SelectAssignEqp : Select equipment to assign to Up target WorkStep from the 
equipment list.



MOZART IDE (ENG) 277

Default Logic Example

public List<AssignEqp> SELECT_ASSIGN_EQP_DEF(WorkStep upWorkStep, List<AssignEqp> as
signEqps, JobChangeContext context, ref bool handled, List<AssignEqp> prevReturnValu
e) 
{ 
    if(assignEqps.IsNullOrEmpty()) 
    return null; 
    var jobChangeControl = ServiceLocator.Resolve<JobTradeControl>(); 
    assignEqps.QuickSort(jobChangeControl.CompareAssignEqp); 
    return new List<AssignEqp>() { assignEqps[0] }; 
}

8. CompareAssignEqp : Compares the priority among allocable equipment.

9. CanAssignMore : Determines whether to assign more equipment to Up target 
WorkStep after the equipment is assigned.

10. DownEqp : After equipment is assigned to all Up classified WorkSteps, this 
selects the equipment to be returned from the Down target WorkStep. This is 
performed only when IsReleaseDowneqp (of Agent) property is set as true.

11. SelectDownEqp : Selects equipment list to return from Down target WorkStep. 
The selected equipment state will change to Idle state.

Default Logic Example

public IEnumerable<AoEquipment> SELECT_DOWN_EQP_T_DEF(WorkStep wstep, ref bool handled,
 IEnumerable<AoEquipment> prevReturnValue) 
{ 
    var t = wstep.LoadedEqps.FirstOrDefault(); 
    return t != null ? new AoEquipment[] { t.Target } : null; 
}

JobChangeControl Control

Overveiw 
This is the JobChange Main Logic Component to perform JobChange decision making 
and controlling the Queue. If the JobChange decision making(AgentType) of 
WorkAgent is CHANGE method, this component is performed. The CHANGE type 
JobChange decision making first decides the Down target Step(WorkStep) and then 
allocates Down or Idle equipment to Up target Step(WorkStep). This component is 
called on each JobChange decision-making cycle.
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JobChangeControl 
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AgentControl logic consists of functions for executing three main logics and additional 
functions for controlling simulation objects related to Agent. The three main logics are 
1) calculating Profile,  2) deciding target Step/Equipment to classify its OperationType 
as Down, 3) selecting target product to update.

Decide Down Step/Equipment : With calculated Profile for each WorkStep as Input, 
this function decides a WorkStep for Down according to a certain criterion and select a 
specific equipment for a Job Change at the corresponding WorkStep.

1. IsNeedDownStep : This action decides whether job change is required for 
Equipment processing at target Step based on input quantity and OutProfile. At 
this moment, basic logic uses parameters configured at WorkStep and these 
parameters can be selected by user-defined logic if necessary.

Default Logic Example

public bool IS_NEED_DOWN_STEP_DEF(WorkStep ws, ref bool handled, bool prevReturnValu
e) 
{ 
    if (ws.LoadedEqpCount <= 1) 
        return false; 
 
    var now = ws.Agent.Now; 
    var wlot = ws.FindOver(ws.DownInterval, ws.AllowedArrivalGap); 
    if (wlot == null) 
        return true; 
 
    return wlot.InTime < now + ws.DownInterval; 
}

2. SelectDownEqp : This action selects the active equipement avaliable for job 
change to replace WorkStep in the equipment that is down.

Default Logic Example

public IEnumerable<AoEquipment> SELECT_DOWN_EQP_DEF(WorkStep wstep, ref bool handle
d, IEnumerable<AoEquipment> prevReturnValue) 
{ 
    var t = wstep.LoadedEqps.FirstOrDefault(); 
    return t != null ? new AoEquipment[] { t.Target } : null; 
}

Decide UP Step/Equipment : Search a Step that needs more euqipment (Up) based 
on input quantity and Out Profile. Then, equipment that is down selects a target step 
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for Job change.

1. IsNeedUpStep : This action decides whether additional equipment should be 
assigned to a target WorkStep based on input quantity for the step and output 
profile of Equipment in processing.

Default Logic Example

public bool IS_NEED_UP_STEP_DEF(WorkStep ws, ref bool handled, bool prevReturnValue) 
{ 
    if (ws.LoadableEqps.Count == 0) 
        return false; 
 
    if (!ws.UpableEqps().Any()) 
        return false; 
 
    if (ws.LoadedEqpCount == 0 && ws.HasLoadableBeforeNextIteration()) 
        return true; 
 
    var now = ws.Agent.Now; 
    var wlot = ws.FindOver(ws.UpInterval, ws.AllowedArrivalGap); 
 
    if (wlot == null) 
        return false; 
 
    return wlot.InTime >= now + ws.UpInterval; 
}

2. IsNeedSetup : This action decides whether a equipment that is down needs Job 
change into UpStep (This step can be processed by the equipment. If not, the step 
is not a target of consideration for Job change.)

3. SoutUpEqps : This action sorts equipment (WorkEqp) in priority order to decide 
which of the replaceable equipment can select lot.

4. SortUpSteps : This action sort WorkSteps in the order of WorkStep priority among 
candidate WorkSteps for a specific equipment's job change. The equipment is 
assigned to a WorkStep (or Product) with the highest priority.

5. CanUp : Checks if the target WorkStep can make the equipment go up.

Default Logic Example

public bool CAN_UP_DEF(AoEquipment aeqp, WorkStep wstep) 
{ 
    bool ret = false; 
    try 
    { 
        wstep.AddLoadedEqp(aeqp); 
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        wstep.Group.CalculateProfile(wstep); 
 
        var now = wstep.Agent.Now; 
        var wlot = wstep.FindOver(wstep.NewUpInterval, wstep.AllowedArrivalGap); 
 
        ret = wlot != null && wlot.InTime >= now + wstep.NewUpInterval; 
 
     } 
     finally 
     { 
        wstep.RemoveLoadedEqp(aeqp); 
        if (!ret) 
            wstep.Group.CalculateProfile(wstep); 
     } 
 
     return ret; 
}

6. CanUPMore : Decides whether to allocate more available equipment for Step to 
go up.

JobChangeEvents Control

JobChangeEvents is set of functions to handle events triggered when 
JobChangeAgent Model is executed. User sepcified logic can be implemented at this 
point.
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1. OnAddWip : This event is triggered after input target WIP is added to a WorkStep.

2. OnStartWorkAgent : This event is triggered  just before Agent executes the first 
logic. Any initialization logic can be added if a logic is insufficient.

3. OnBeforeRun : This event is triggered before AgentControl's logic is executed.

4. OnCalculate : This event is triggered just after AgentControl's Profile is calculated.

5. OnAfterUnassignEqp: This FEAction is used in TRADE type Agent only. This 
event is triggered after an equipment is removed from the specified WorkStep. 
Implement logics in case additional hanlding needs to be done for the removed 
equipment.

6. OnAfterAssignEqp : This event is triggered after assigning Equipment to Up 
target WorkStep from TRADE type Agent.

7. OnAfterRun : This event is triggered just after AgentControl's logic has been 
executed.

Weight Factor Method Development

If Weight Factor-based Dispatcher provided by Simulation library is used, a method for 
evaluating Weight Factor can be created in order to reflect the Dispatching method of 
the corresponding implemented system. Weight factor method is a function that is 
used to implement a logic to calculate score for weight factor. When a simulation 
Model is implemented, a dispatching method is decided and Weight Present for each 
equipment is configured in the corresponding Model. Then, when dispatching is 
executed, lots' priority is evaluated by checking the configured preset and using 
information of Weight Factors that comprises the preset and Factor Method. For more 
details, refer to SeePlan Dispatcher Concept , How to implement Weight Preset-
base Dispatcher.

Execute the following steps to add a Weight Factor Method.

1. Select Simulation/Weight node from Model Explorer, right click on Weights and 
click Add Item from the pop-up menu.

https://www.notion.so/f0baf526ddf0490fb4832ca979564d58#af85077de5b14a3d95f1f9f5460fec48
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2. Enter a name for new Weight Factor Method. Configure Weight Factor's name with 
the same name as the factor of Preset that is defined as Input.

3. Method is automatically registered as Weights Category.

4. When all information required for Method is filled in, a Weights class is created in 
[Solution Explorer>Logics] menu. Weight class is created only when it does not 
exist. If the class already exists, only method will be created.

5. If Method's original form is automatically created, a '.cs' file including the 
corresponding Method opens in Source Editor and cursor is located at the place of 
the corresponding function. The function's Return value is WeightValue type that 
consists of actual calculation result and description of the Value. Value is used 
when data is sorted in Library and Description is used when Dispatching log is 
analyzed. If the Value in Dispatching log doesn't give enough information, you can 
use Description of WeightValue in  
Dispatching>DispatcherControl>AddDispatchWipLog function instead of the 
Value.
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Weight Method Code Sample

public WeightValue HOT_PRIORITY(ISimEntity entity, DateTime now, AoEquipment eqp, We
ightFactor factor, IDispatchContext ctx) 
{ 
    var lot = entity as SimpleMfgSemiconLot; 
    float value = DisptchHelper.GetHotValue(lot.HotType) ; 
    return new WeightValue(value, lot.HotType.ToString() ); 
}

6. If modification of functions are completed, it is ready to use Weight Factor. Then, 
the corresponding Factor can be added to Preset information for actual test.

How to Implement Weight Preset Based Dispatcher

Weight Preset-base Dispatcher is defined by the following procedure.

1. Generate Input data from WeightPreset information. The input data schema is 
described as follows.

PRESET_ID : Preset identifier. This is also used for mapping the preset 
information of Equipment.

FACTOR_ID : This is ID for Weight Factor and should have the same Factor 
Method name that is used when any simulation function creates Weights(Refer 
to Weight Factor Method Development)

FACTOR_TYPE : This is to configure the calculation unit for FACTOR VALUE 
in order to prevent double counting when FACTOR VALUE is calculated. 
+ FIXED = Factor value is calculated with the same value with respect to all 
lots regardless of LOT or STEP when Dispatching is executed 
+ LOTTYPE = FACTOR calculates score for each LOT (example ; DUE, 
DATE, .....) 
+ STEPTYPE = FACTOR calculates score for each STEP (example : 
achievement rate of STEP TARGET, ...)
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ORDER_TYPE : Property used by WeightSorted Dispatcher. This indicates 
how to sort Factor 
+ ASC = Ascending order 
+ DESC = Descending order

SEQUENCE : Property used by WeightSorted Dispatcher. This indicates the 
sorting priority of Factor. (Sorting is executed based on Factor Value according 
to Factor order. If there exists lots having the same score, they are sorted by 
the value of the next rank Factor.)

FACTOR_WEIGHT : Property used by WeightSum Dispatcher. This is Factor's 
weight that is used when weighted sum of Factor Values is calculated.

FACTOR_NAME : Name or Description of Factor.

[Example of Implementation]

[Example of Data]
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2. Configure equipment's Dispatching method and Preset in the equipment 
information. The following shows an example of configuration

3. Configure with the above information when equipment information is uploaded.

Loading Equipment Information Sample Code

// 1. Loading Equipment Information 
public bool OnAfterLoad_Equipment(Equipment entity) 
{ 
    SimpleMfgSemiconEqp eqp = entity.ToSimpleMfgSemiconEqp();  
  
    LocationInfo loc = new LocationInfo(); 
    loc.LineID = entity.LINE_ID; 
  
    eqp.Init(entity.EQP_ID, 
    DateTime.MinValue, 
    DateTime.MaxValue, 
    entity.SIM_TYPE, 
    loc 
    );  
  
    eqp.DispatchingRule = entity.DISPATCHER_TYPE; 
    eqp.Untilization = 1.0f;  
  
    WeightPreset preset ; 
    if (InputMart.Instance.PresetList.TryGetValue(entity.PRESET, out preset)) 
    { 
        eqp.Preset = preset; 
    } 
  
    eqp.EqpDispatchInfo = new EqpDispatchLogInfo(eqp); 
    InputMart.Instance.SimpleMfgSemiconEqp.Add(eqp.EqpID, eqp); 
  
    return true; 
} 
// 2. Loading Preset Information 
public void OnAction_Preset(IPersistContext context) 
{ 
    InputMart.Instance.PresetInfo.DefaultView.Sort = "PRESET_ID ASC, FACTOR_ID ASC
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 "; 
  
    WeightPreset preset; 
    foreach (PresetInfo wp in InputMart.Instance.PresetInfo.DefaultView) 
    { 
        if (InputMart.Instance.PresetList.TryGetValue(wp.PRESET_ID, out preset) == f
alse) 
            InputMart.Instance.PresetList.Add(wp.PRESET_ID, preset = new WeightPrese
t(wp.PRESET_ID)); 
  
        WeightFactor factor = new WeightFactor(wp.FACTOR_ID, wp.FACTOR_WEIGHT, wp.SE
QUENCE, 
                    (FactorType)Enum.Parse(typeof(FactorType), wp.FACTOR_TYPE), 
                    (OrderType)Enum.Parse(typeof(OrderType), wp.ORDER_TYPE)); 
  
        preset.FactorList.Add(factor); 
    } 
}

4. Write an initialization code for equipment and Preset. When GetDispatcherType 
FEAction is implemented, possible result keys are "Fifo", "WeightSum", and 
"WeightSorted". If FifoDispatcher is configured, no Preset configuration is required. 
Lots are processed in the order that they join a Queue.

Sample Code: Initialization Code

// 1. Initialize Equipment  (logic of Factory>EqpInit>GetDispatcherType) 
// Dispatcher Type Key = {"Fifo", "WeightSum", "WeightSorted"} 
public string GETDISPATCHERTYPE_0(Resource eqp, ref bool handled, string prevReturnV
alue) 
{ 
    SimpleMfgSemiconEqp mEqp = eqp as SimpleMfgSemiconEqp; 
    return mEqp.DispatchingRule; 
} 
// 2. Initialize Preset (logic of Factory>FactoryInit>GetWeightPreset) 
public IEnumerable<Mozart.SeePlan.DataModel.WeightPreset> GETWEIGHTPRESETS_0(ref boo
l handled, IEnumerable<Mozart.SeePlan.DataModel.WeightPreset> prevReturnValue) 
{ 
    return InputMart.Instance.PresetList.Values.ToList(); 
}

5. Include Weights used for calculating Factor Value . (Refer to Weight Factor 
Method Development)

Concept of Preset Based Dispatcher
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MOZART SeePlan Library provides two types of Dispatchers using Weight Factor and 
Preset of Factor. The definition of each term used in Dispatching is stated below.

Weight Factor
An evaluation factor to evaluate priority order for each lot. If lot is dispatched through 
FIFO mechanism, Weight Factor can be specified to compare arrival times at Steps in 
a lot unit. Normally in manufacturing site of high-tech industry have at least 3~4 or up 
tp 10~20 evaluation factors to evaluate lot priority.

Weight Preset
Weight Preset is a set of Weight Factor used during Dispatching. In MOZART, this is a 
data set including priority among Factors or information of Factor property in 
accordance with Dispatcher Type. Since dispatching can be processed differently 
according to equipment, Preset in actual site can have 1 to several elements since 
different Preset value can be assigned for each equipment type. In addition, Preset 
and Dispatcher to be used by equipment needs to be configured for basis information 
of the equipment.

Factor Method
A function to calculate evaluation result of Weight Factor. In order to calculate a value 
of Factor, several informations related to lot, equipment, and property of Factor in 
Preset are required. When a Dispatcher is applied, a Factor method for Weight Factors 
that comprise Preset must be implemented in advance and Simulation module in 
MOZART Library can define a Factor method through Weights function.

Dispatcher
Dispatcher has a role to select a lot for processing by calculating evaluation score for 
all waiting lots with respect to each Factor included in Weight Preset of equipment and 
evaluating the lots' priority. MOZART supports two Dispatcher types, 
WeightSumDispatcher and WeightSortDispatcher. The following figure illustrates the 
concept of the two types.
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Custom Event Implementation

If user has to trigger an event other than one of simulation core Model at a specific 
moment with a specific cycle and execute a user-defined logic, Custom Event can be 
defined. In order to define Custom Event, follow the procedures described below.

1. Select [Simulation>CustomEvents] node and press right-mouse-button. Then 
click [Add] from pop-up menu.

2. Enter event property on "Add Custom Event" dialog window.
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Event Name : Name of event.

Description : Description of event

Event Type : This configures the order of events that occur at the same time.

+ AtBegin : This configures the corresponding event as the first one to be 
processed 
+ AtEnd : This configures the corresponding event as the last one to be processed

Fire at Start : This decides whether to execute the first event in the beginning 
of Simulation. If this option is disabled, the first event will be triggered after an 
Event Cycle time from the beginning of Simulation.

Event Cycle Time : Event execution cycle. Cycle time can be configured in a 
unit of day, hour, or minute.

Event Priority : Decides the priority when there are multiple Custom Events 
with same Event Type. The priority is sorted in ascending orders which makes 
the lowest number the highest priority. It is possible to configure negative 
numbers as well.

Enable : Activates event. If the Enable checkbox is disabled, the event won't 
be triggered.
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3. Click [OK] after entering Event property. Then a new event with the entered name 
is created in CustomEvents node.

4. Function to initialize Custom Event and Event handling can be implemented.

Initialize : This is called in the beginning of simulation. A logic implemented 
here is used to configure initial information for developing Event processing 
logic.

Run : Implement a logic processing the defined Event.

💡 Note 
Return type of Run function is Boolean and means whether this event 
occurs consistently. That is, if return value of Run function is false no 
further events will be triggered even though Event Cycle is configured.

Done : This is called at the end of simulation. Logs are generated are 
processes logic when Simulation is completed in Event handling perspective.

5. In order to implement each function, double-click the name of function or click 
[Edit] from right-click pop-up menu. 'Add Handler' dialog will be loaded and the 
description of the function can be included here.
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Category Name : Name of Event Class. This is automatically generated so 
user cannot modify this.

Method Name : Name of method. This could be changed by user.

Description : Description of Method

6. After all information is filled through handler function, click [OK]. A class file for the 
event will be created under [Logic>Simulation] from Solution Explorer. Double 
click on the filename to open the source code editor to edit the Method.

public bool RUN(MOZART.SeePlan.Simulation.ICalendarEvent evt, ICalendarEventManager
 cm) 
{ 
    // Logic for event processing    
    // .... 
          
    // Return true in order to create a repetitive event 
    return true; 
}

7. After the function is edited, all procedures for Custom Event Development are 
completed.

Developing Filter Method
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When entities required to be filtered according to the dispatching constraints of the 
Resource/Entity perspective, methods to define filtering conditions can be created and 
added to the Filters category. In case there are numerous filtering conditions to be 
considered, filters can be formed as Filter Sets by specifying the Key for the filters. 
This section describes the procedures to create and use filtering.

Creating Filter Key and Filter Set
At first, filter key and the corresponding filters should be added to FilterManager object 
during Simulation initialization. This can be done through 
Simulation/Factory/FactoryInit/FilterManager. In this example, Filter input data is 
prepared  and Filter ID which is the key value of the filters are included to the 
Equipment input table to be used as reference.

<<Filter Input>>

<<Equipment Input>>

Sample Code

 public void INITIALIZE_FILTER_MANAGER0(IFilterManager filterManager, ref bool handled) 
        { 
            string Key = null; 
            List<string> value = new List<string>(); 
 
            var filterType = InputMart.Instance.Filters.Rows.GroupBy(x => x.FILTER_ID).S
elect(group => new { Key = group.Key, value = group.ToList() }); 
            foreach (var item in filterType) 
            { 
                // Add Key and Filter Factor to FilterManager. 
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                filterManager.CreateMethods(item.Key, item.value.Select(x => x.FILTER_FU
NC)); 
            } 
        }

Get and Return Filter Set Key through FilterControl 
Component
Once the filter key and filter set is included to the FilterManager from 
Simulation/Factory/FactoryInit/InitializaeManager, A code to fetch and returning the 
filter key needs to be written through Simulation/FilterControl/GetFilterSetKey 
FEAction. Filters in the FilterSet are called from DoFilter FEAction. In this example, 
Filter ID set in Equipment input table will be returned.

Sample Code

/// <summary> 
        /// </summary> 
        /// <param name="eqp"/> 
        /// <param name="hb"/> 
        /// <param name="ctx"/> 
        /// <param name="handled"/> 
        /// <param name="prevReturnValue"/> 
        /// <returns/> 
        public string GET_FILTER_SET_KEY0(Mozart.SeePlan.Simulation.AoEquipment eqp, IHa
ndlingBatch hb, IDispatchContext ctx, ref bool handled, string prevReturnValue) 
        { 
         
            VmsEqp resource = eqp.Target as VmsEqp; 
            return resource.FilterID; 
        }

Developing Filter Method
This part explains how to add Filter method through MOZART Explorer. The method 
will be called by DoFilter when GetFilterSetKey is developed. If no key is returned from 
GetFilterSetKey FEAction, the methods will not be called.

1. Select Simulation/Filters node from Mozart Explorer and click Add item button.
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2. Type in the name of the Filter Method. Factor Name should be the same as the 
filter name value used to add to FilterManager.

3. Press [OK] button to complete the creation. The created Filter method will be 
automatically added to the Filters Category list.

4. Once the Filter Method is added to the Filters Category, Filters class will be 
generated through Solution Explorer. In case the class already exists, only the 
method will be created to Filtres Category.

5. Once the form of the method is created users can move to the screen of the 
corresponding '.cs' file where the logics for the method could be included. The 
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return type of each method is boolean and when returned true, the target entity fill 
be filtered not to be dispatched.

Simulation Statistics Aggregation

MOZART Simulation Library provides the following default statistics information by 
taking the objective of simulation for manufacturing industry into consideration. User 
can adjust some of the options.

Move Statistics : Production performance statistics of step or Equipment at a 
specific time.

WIP Statistics : WIP status information is periodically collected and provided at a 
specific time.

Equipment Loading History and Utilization Statistics : Information about each 
equipment's lot loading history and share for equipment's each state is provided.

Move Statistics

WIP Statistics

Eqp Statistics

How to Collect User-defined Statistics

Move Statistics

StepMove is used to collect Step's output statistics as simulation result. A method to 
collect statistics is based on Entity and this includes information on both Step input and 
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Step output. Step's In/Out is counted at Track-In, Track-Out. Key for Move result can 
be designated differently according to the point of view on the result, that is, 
equipment's perspective or step's perspective.

The following shows how to add Move Type Statistics that is provided in System.

0. Add Statistics
Configure Type as "Moving" through Statistics>AddItem menu. Like the following 
figure, select a Type and input a Name. Click "OK" to create the node in Tree and an 
input window used to configure output and input items opens.

1. Configure Output Schema
As basic user-defined statistics are defined, select output data item where final Output 
data is saved. The corresponding Output should have Keys configured in advance.  
The corresponding Key is used for searching data and it should be defined as 
unique data value.

2. Configure Column's Collect Type
When Move Type statistics is configured, Collect Type = {"NONE", "IN", "OUT"} is 
provided. The following explains each type's processing method.
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NONE : No special processing is considered.

IN : Statistics is collected by adding lot quantity based on Target value at Track-In 
of a lot. This includes basic rule that should be processed at Track-In

OUT : Statistics is collected by adding lot quantity based on Target value at Track-
Out of a lot.

3. Configure Target Value
Target Value is a Mapping information between Output data's column and a variable 
that can be used when the corresponding data is collected. Simple Expression can be 
used. The following figure shows Target Value when production output is collected with 
respect to Step, Eqp. Target Value for column that correponds to Key is mapped with 
properties like entity and equipment procesing equipment and a Collect Type is 
configured for the result of collection and additional quantity in Unit or Lot is 
designated.

However, a property expressing practical output unit, the aggregation cycle time 
should be carefully configured. The following shows an example how to configure to 
aggregate time based outputs.

When variable configuration and expression are used, pre-defined variables that can 
be used are displayed in Expression editor for editing Target Value. If user is 
accustomed to use library, user can write a code directly in Expression editor.



MOZART IDE (ENG) 299

4. Fix Rolling Cycle and Event Type when basic statistics are 
collected
The above configuration can make it possible to collect statistics. A cycle to write data 
for Move Type statistics is fixed to 1 day and Rolling Event is fixed to occur at the end 
of the same time period.

5. Customizing method for collecting Moving type statistic
Basic Move-based statistics can be collected through procedure 1,2,3. However, if 
user wants to process and save additional information while Move statistics is 
collected or to process differently from auto-created code, Event Handler that is 
created in statisitcs item can be implemented for customizing. The following explains 
when to call and how to use for each Event Handler.
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InitializeStat : This is required to initialize statistics data. For example, the total of 
the actual ouputs of certain period have to be recorded using the simulation results 
and in case the simulation starts in the middle of the certain period, the actual 
ouputs before the simulation started can be revised through this function.

InitialzeRow : If no Row information is found by GetRow function or Key value, a 
new data is created. At this moment, InitializeRow is used to configure properties 
except Collect Type = IN, Out. Basically a value set to Target Value is assigned to 
Property. However, user can implement this function in order to apply user own 
method.

Filter : If there is a data that should be excluded while collecting output for lot or its 
loading information, the corresponding data can be filtered through this function. 
For example, if there in no information about the loaded equipment in entity when 
equipment's loading result is only aggregated, Filter discerns this and returns 
"true". Then, the corresponding data is excluded.

GetRow : When TrackIn, TrackOut of an lot occurs, a code that searches and 
returns a Row with the same Key is automatically created. The configured key is 
used for this. However, if a method to search the same data from the existing 
Output should be changed, this function should be implemented. In order to record 
Move output for the current entity from existing data, a logic that searches the 
same Row should be implemented.

OnTrackIn : This is called after a code that is automatically created at Track-In of a 
lot in Lot Monitor is processed. User can process additional information at Track-In 
of a lot.

OnTrackOut : This is called after a code that is automatically created at Track-Out 
of a lot in Lot Monitor is processed. User can process additional information at 
Track-Out of a lot.

Wip Statistics

WIP type statistics data is a function to collect information of WIP quantity at a specific 
point of time. Unlike Move data, WIP data is not the accumulative quantities of lots 
collected during the entire aggregation period, but is designed to aggregate quantities 
during a certain point when lot state is changed . Therefore it is designed to collect 
data whenever a lot changes its state. The corresponding point of time is like the 
following. The lot state is defined as EntityState and has five different states such as 
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{"HOLD", "MOVE", "WAIT", "RUN", "OUT_WAIT"}. So lot state is changed when the 
following event occurs.

TransferIn : Increase lots in "MOVE" state

TransferOut : Decrease lots in "MOVE" state

HoldIn : Increase lots in "HOLD" state

HoldOut : Decrease lots in "HOLD" state

DispatchIn : Increase lots in "WAIT" state

DispatchOut : Decrease lots in "WAIT" state

CancelWait : Decrease lots in "WAIT" state

TrackIn : Increase lots in "RUN" state

TrackOut : Decrease lots in "RUN" state

OutWaitIn : Increase lots in "OUT_WAIT" state

OutWaitOut ; Decrease lots in "OUT_WAIT" state

WIP type statistics is designed to change WIP quantity automatically according to Key 
when lot state is changed as described above. So users can collect statistics only by 
designating properties for Output. The following shows how to add WIP Type statistics.

0. Add WIP Type Statistics
Select Statistics>AddItem from the menu and set Type to "Wip". When a name is 
entered after Type is selected in "Create new statistics" dialog and "OK" button is 
clicked, a node with the corresponding name is created in the tree and an input 
window is opened so that Output and input items can be configured.

1. Output Schema Configuration
Like defining basic user-defined statistics, select an Output data item that saves the 
final Output data. At this moment, the corresponding Data item should have Keys 
configured. The Key is used to find data so that each Key's value should be unique.
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2. Column's Collect Type Configuration
When Move type statistics is configured, the following types are provided. The 
following shows how each type is worked.

NONE : no specific processing is done.

HOLD : Balances the quantities automatically with user specified value for 
HoldIn/HoldOut events.

MOVE : Balances the quantities automatically with user specified value for 
TransferIn/TransferOut events.

WAIT : Balances the quantities automatically with user specified value for 
DispatchIn/DispatchOut events.

RUN : Balances the quantities automatically with user specified value for 
TrackIn/TrackOut events.

OUT_WAIT : Balances the quantities automatically with user specified value for 
OutWaitIn/OutWaitOut events.

ROLLING : This is configured to the property correspondent to Time Key of WIP. A 
property configured as Rolling is updated with a value configured in Target Value 
at a specific moment according to a cycle that is configured as Time unit. The 
Target Value set int the property of Rolling updates the previous value in the 
corresponding property of Record in a certain cycle set in Time Unit. Through this 
procedure, EOH of the previous point becomes BOH of the next point and WIP 
quantities for each state in the same data is updated before being changed to the 
next Rolling cycle.

The following figure shows an example of WIP Type statistics configuration. Through 
this example, statistics only for WAIT and RUN WIP is collected, Rolling cycle is set for 
8 hours, and EOH WIP of each shift is collected. The Target Value in the property 
configured through Rolling has to be exactly the same as the time set in Time Unit. 
Otherwise, the data will be duplicated. The following example shows that 
TARGET_DATE is set to the start time of SHIFT (ShotCalendar.ShiftStartTime(now)) 
and Time unit is set to 8 hours to synchronize the cycle.
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3. Target Value Configuration
Considering the Collect Type and Key of the column, Target Value should be set using 
preset variables. It provides editor to use Expression and variables related to lots.

4. Rolling cycle and Event Timing Configuration
Time unit is used to configure a cycle to write data into Output data item and delete 
statistics data. Unlike Move type, WIP type statistics can configure this and this cycle 
should have the same value as Target Value of any item having "ROLLING" as Collect 
Type of its Output column. If WIP information should be recorded every hour, Time unit 
should be set to 1 hour and Target Value for "ROLLING" type's column can be set as 
Target Value = now.ToSTring("yyyyMMhh HH0000").

The default value of Event Timing is AtEnd. This option enables to perform Rolling at 
the last in case if there is an Event starting at the same time as Rolling Event. In case 
user wants to perform Rolling first instead, AtBegin can be used. Since statistics are 
usually affected by other events occurred at the same time, AtEnd is used as default.

5. Customization in Designing WIP Type Statistics
Event Handler is created when WIP statistics are included. The basic components in 
Event Handler of WIP type have in common with the functions in Moving type. These 
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are the four components.

InitializeStat : This is required to initialize statistics data. For example, the total of 
the actual ouputs of certain period have to be recorded using the simulation results 
and in case the simulation starts in the middle of the certain period, the actual 
ouputs before the simulation started can be revised through this function.

InitialzeRow : A new data is created when information cannot be searched using 
GetRow or through Key value. Basically its property is set to a value configured in 
Target Value. But user can implement this function in order to apply user own 
method.

Filter : If any data should be excluded while WIP data is being collected, this 
function is used to filter those data. If "true" is returned, the corresponding data will 
be excluded.

GetRow : At TrackIn, TrackOut of a lot, searching a Row with the same Key is 
processed by an auto-created code. At this moment, a configured Key is used. 
However, if user wants to change method to search data from existing Output, this 
function can be implemented. In order to write move result of the current lot into 
the existing data, a logic searching the same Row is implemented.

In order to collect additional statistics at the moment of WIP state change, Event 
Handler, which is called just after each Event occurs, can be defined. This is created 
by adding a prefix "On" to each Event. For example, a handler that is called after 
TrackIn is processed has a name "OnTrackIn", a handler called after DispatchOut is 
processed has a name "OnDispatchOut". If it can be processed by basic statistics, no 
function is defined in the corresponding handler.

Eqp Statistics

Equipment Statistics (Eqp Statistics) is collected at the moment of equipment state 
change. Mozart defines equipment state as LoadingState = {"SETUP", "BUSY", 
"IDLERUN", "IDLE", "PM", "DOWN", "WAIT_SETUP"} and provides 3 types of 
statistics collecting functions.
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1. Equipment Loading History

2. Equipment Utilization Statistics

3. Equipment Plan (Eqp Plan)

Equipment Loading History

This is the basic equipment statistics that records the history of equipment's state 
change. State change occurs usually when a lot is loaded. So configuration window is 
designed to set information of a lot that is loaded at the time the state changed to 
"BUSY". The following figure shows the statistics configuration window that extracts 
LoadingHistory among Equipment statistics. In order to add a new statistic, select 
"LoadHist" type.

Configuration Procedure

1. Output Schema Configuration
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Selects the Output data item to be written as final Output. The corresponding Output 
should have Keys configured in advance. If no Keys are configured, GetRow function 
should be implemented.

2. Collect Type Designation for Each Column
There is only one Collect Type, "LOAD_INFO". LOAD_INFO is basically defined 
according to the following format.

Format : State;Starting time;{Packing Load Information}{TAB} State;Starting time;
{Packing Load Information}{TAB}....

Example : BUSY;142540;L004;PROD01;PROC01;S200 
BUSY;182540;L205;PROD01;PROC01;S200

3. Target Value Configuration for Each Column
If Collect Type is not available, Target Value that is mapped on each column is defined 
with Expression and pre-defined variables.

4. Packing Load Information Configuration
If equipment is "BUSY" in data defined as "LOAD_INFO" of the above 2, information of 
loaded lot is displayed. At this moment, the information to be incorporated to loading 
information should be defined. The configured items are divided by ";".  As in the 
example shown above, the packing data that are formed as  
LotID;ProductID;ProcessID;StepID. If user want to record Recipe information used at 
loading or property information that is defined as extra in PlanInfo together with 
Loading information, this can be defined in this configuration window.

5. Fix Rolling Cycle and Event Timing
Data of LoadHist type has a daily Rolling. After it is written into Output data, it is 
deleted from memory. Also Rolling Event is configured as the last one to be executed 
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among events having the same execution time. This could not be configured.

Model Reference
Ouput Data Schema Template : LoadingHistory schema

LoadingHistory Schema
Schema template category : Outputs

Schema template name : LoadingHistory

Schema description : Output about history of equipment's status change

Schema

Column
name

Data
type

Description Modeling guide

VERSION_NO string
Plan
version

Unique ID created when each plan is made

LINE_ID string Line ID Line ID that equipment belongs to

EQP_ID string
Equipment
ID

Target Equipment ID to write loading state change

TARGET_DATE string
The date
when data
is gathered

String in the form of YYYYMMDD. Normally Equipment
status change is recorded as a compressed data in
daily base.

INFO_GZIP string

Status
change
record
string 1

Status change information has big data size so status,
change moment, and simple loading information are
written. If length of string is too long, it can be divided
into string 2 & string 3. When the result is used later,
string should be used through parsing according to the
format that loading information of BUSY status is
written.

INFO_GZIP2 string
String 2 to
write status
change

String 2 to write status change

https://www.notion.so/VERSION_NO-4465c25b32b54e36b2a152914cd8f710
https://www.notion.so/LINE_ID-abd3dda049b5400c9d11bbfa859eccdc
https://www.notion.so/EQP_ID-0968f11c64b5492db66e2faddd6b6682
https://www.notion.so/TARGET_DATE-8632574c985444a391166a7234be8003
https://www.notion.so/INFO_GZIP-7ec9706a50fd463692b3121524c55cf2
https://www.notion.so/INFO_GZIP2-e5d2f87961634d6db0499fa6e2148657
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Column
name

Data
type

Description Modeling guide

INFO_GZIP3 string
String 3 to
write status
change

String 3 to write status change

Schema template file : LoadingHistory.vditem

Equipment Utilization Statistics

This is statistics report showing the occupied rate and time for each equipment. 
MOZART manages the equipment in seven states(LoadingState), {"SETUP", "BUSY", 
"IDLERUN", "IDLE", "PM", "DOWN", "WAIT_SETUP"}. It is possible to aggregate 
equipment utilization rate for each state/aggregation period. The following shows the 
page to configure statistics for each state. In order to add a new statistic, select 
"LoadStat" type.

1. Output Schema Configuration

https://www.notion.so/INFO_GZIP3-edabceefa41e4acdb60eef69067cd196
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Selects the Output data item to be written as final output. The corresponding Output 
should have Keys configured in advance. If no Keys are configured, GetRow function 
should be implemented.

2. Collect Type Designation for each Column
Collect Type is designed to select each state types in LoadingState. However, 
WAIT_SETUP is collected as SETUP state. Unless Collect Type is not "NONE", the 
equipment utilization rate data of the equipment state is written to the corresponding 
column.

3. Target Value Configuration for each Column
If Collect Type exists, the value of the column is automatically set as the equipment 
utilization rate of the state in Collect Type . Otherwise, the value configured in Target 
Value is assigned. Among these, a property related to a cycle (period) collecting a 
state portion data is required and this should sync with the cycle of Collect 
Interval.

For example, if Collect interval is set to 2 hours, column correspond to Time Key 
should be also configured with 2 hour unit. In the above example, 2 hour unit Time Key 
should be configured like "da.NowDT.Date.AddHours(da.NowDT.Hour - 
(da.NowDT.Hour % 2)).DbToString()"

4. Lock Rolling Cycle and Event Timing
Eqp Plan type's data is collected in daily-base, written into Output data, and deleted 
from memory (Rolling event). This Rolling event is configured as the last one to be 
executed among events having the same execution time and could not be modified by 
user.

Eqp Plan



MOZART IDE (ENG) 310

This is the history information about lots loaded into an equipment. The history is 
written at the moment of Track In and Track Out of a lot. The following figure is a 
configuration example for generating EqpPlan statistics. Select "EqpPlan" to add 
statistics. Although this is the statistics for equipment, collecting this statistics is based 
on state change event of lot. The components of EqpPlan and Moving statistics have a 
lot in common.

1. Output Schema Configuration
Select Output data item that writes the final Output. The corresponding Output should 
have Keys configured in advance. If no Keys are configured, GetRow function should 
be implemented.

2. Collect Type Designation for Each Column
Collect Type can be set to "IN" or "OUT". Usually it records the time of TrackIn, 
TrackOut or otherwise property is configured with Target Value. Refer to the above 
example.
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3. Target Value Configuration for Each Column
If no Collect Type exists, Target Value mapped on each column is defined with 
Expression and pre-defined variables. Variables provided as defaults are three types 
like lot, now, and hb. Lot is used to refer to an object of unit lot defined in Project and 
hb is used to refer to lot information when a batch is created. Now is a variable used to 
refer to the current time information.

4. Fix Rolling Cycle and Event Timing
Rolling cycle of EqpPlan type is a day. So the corresponding data is collected, written 
into Output data, and deleted from memory every day. In addition, Rolling event is 
configured as the last one to be executed among events having the same execution 
time. This change of this configuration is not allowed.

User Custom Statistics

There are two basic methods to collect statistics as simulation results. One method is 
to collect statistics based on Equipment's state and the other one is to collect statistics 
at the moment of lot state change. The following describes the state in two 
perspectives, the moment when the state changes, and how statistics are collected.

Concept of Collecting Statistics based on Equipment State 
Equipment's state is changed according to events such as lot's loading/unloading, PM, 
and breakdown, etc. as shown in the following figure. Equipment statistics is collected 
at the moment of equipment state change by the method to process and save the 
result according to the format of the collected data. For example, in order to record a 
history of equipment state change, the time when the change has occured is written as 
seen in the following figure. In addition, to collect the occupied rate for each state of a 
specific period, the data can be collected by recording the occupied time for each state 
from the beginning of the period. MOZART IDE's Simulation module provides Statistics 
Type to make it easy writing these kinds of equipment statistics. However, if user 
wants to collect more complicated and various output, user can create Statistics from 
Custom Type and collect it by triggering a specific event.
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Equipment's state change event can be processed by implementing "StateChanged" 
among Event Handlers created at the bottom of Custom statistics.

Concept of Collecting Lot-base Statistics
Lot-based Statistics is collected when a lot changes its state and MOZART provides 
functions related to these kinds of statistics that make it easy to collect lot-based 
statistics. The following figure shows moments when a lot changes its state as it 
moves step by step conceptually. When a statistics is defined through Statistics 
function, the required tasks are processed at the moments described below.
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As function of lot-based statistics, various statistics such as Step move amount, Step 
TAT, Step WIP quantity, and Move amount for specific steps(Fab out, Fab In) can be 
collected.

How to Write Custom Statistics
1. Select Simulation/Statistics node and click Add Item from the pop-up menu.

2. Select "Custom" as Type and enter a name for collected data.

3. A statistic with the entered name is created in Statistics node and an input window 
opens. Then enter the value into every input item.
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Name : Name of statistic

Description : Description of statistic

Output Schema : Select a target Schema from ComboBox from the list of 
schemas that are registered in Model/Output. If a new schema is required, 
retry this after a new Output DataItem is added.

Time Unit : This is a cycle for reset of statistics in memory. Before reset is 
activated, data is saved to Output file. Also statistics in aggregate column is 
updated according to the cycle.

Event Timing : This decides the execution order of Rolling events that occurs 
according to the cycle of Time Unit. 
+ AtBegin : designate this event as the first one to be executed among events 
occurring at the same time. 
+ AtEnd : designate this event as the last one to be executed among events 
occurring at the same time.

Keep rows at rolling : The default setting of rolling event saves data into data 
item of configured Output schema and delete it from memory. However, if 
Keep rows at rolling is enabled, data is not deleted from memory.

DataView : From a table collecting data based on schema defined in Columns, 
designate Key of data view columns that are required in a logic. Key for a view 
can be designated by using [+][-] button at the top of Data View grid.
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Comlumns : Columns within Output Schema are displayed and new column 
can be added. However, the added column is not displayed in Output but is 
used in user code during simulation as a reference.

💡 Note 
When column's property is configured, tasks like the following can be 
processed. Data Item's key configured in Output Schema is used as Key 
column and could not be changed.

Type configuration : Configures the data type of property

Aggregate Property configuration : Specific column can be configured with 
statistics value such as MIN, MAX, or Average of a value that changes over 
time based on data key. In this case, the corresponding column's value is 
configured through update function of StatSheetCfg. Primary key column can't 
configure Aggregate property.

4. After basic statistics property is entered, expand the corresponding statistics item 
node in Model Explorer. Then, Event processing point for each moment when a lot 
statistics is collected is displayed.

Event Description

Common Event

InitializeStat : This is used to initialize statistics data. For example, when an 
actual output through a specific period is written as a simulation result, 
InitializeStat can be used to adjust the actual output if a simulation starts in the 
middle of the period.

OnRolling :

OnWriteOutput :

OnWrap :

InitialzeRow : If no Row information is found by GetRow function or Key value, 
a new data is created. At this moment, InitializeRow is used to configure 
properties except Collect Type = IN, Out. Basically a value set to Target Value 
is assigned to Property. However, user can implement this function in order to 
apply user own method.

Events for collecting Lot Statistics
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TransferIn/Out : This event is called when a lot starts to be transferred or has 
completed transferring.

HoldIn/Out : This event is callled when a lot's state is changes to "Hold" or 
lifted.

DispatchIn/Out : This event is called when a lot starts to go on standby in a 
Step and ends standby when selected.

CancelWait : This event is called when DispatchIn is cancelled.

TrackIn/Out : This event is called when a lot is tracked In (TrackIn) or is 
tracked out (TrackOut).

OutWaitIn/Out : This event is called when a lot goes/ends standby to move to 
the next step from the current step.

Events for collecting Equipment Statistics

StateChanged : This event is called when an equipment's state is changed.

5. Select an Event and right click, then click Edit from the pop-up menu. An editor will 
be opened to write the logic for event processing.

6. Write codes to aggregate statistics using functions of StatSheetCfg and StatSheet 
class. (Refer to Class Reference)

Example of Collecting Move
This is a sample code to collect the ouptut of In/Out Move of lots from TrackIn/Out 
event.

public void TRACKIN(StatSheet<StepMove> sheet, ISimEntity entity) 
{ 
    if (entity is SiteLotBatch) 
    { 
        UpdateStepMove(sheet, (entity as SiteLotBatch).Contents, true); 
    } 
    else 
    { 
        UpdateStepMove(sheet, new List<ISimEntity>() { entity }, true); 
    } 
      
} 
public void TRACKOUT(StatSheet<StepMove> sheet, ISimEntity entity) 
{ 



MOZART IDE (ENG) 317

    if (entity is SiteLotBatch) 
    { 
        UpdateStepMove(sheet, (entity as SiteLotBatch).Contents, false); 
    } 
    else 
    { 
        UpdateStepMove(sheet, new List<ISimEntity>() { entity }, false); 
    } 
} 
private void UpdateStepMove(StatSheet<StepMove> sheet, IList<ISimEntity> entities, b
ool isTrackIn) 
{ 
    foreach (SiteLot lot in entities) 
    { 
        StepMove target = GetStepMove(sheet, lot); 
        if (isTrackIn) 
        { 
             target.IN_LOT_QTY++; 
             target.IN_UNIT_QTY += lot.NumOfUnits; 
        } 
        else 
        { 
            target.OUT_LOT_QTY++; 
            target.OUT_UNIT_QTY += lot.NumOfUnits; 
        } 
    } 
} 
private StepMove GetStepMove(StatSheet<StepMove> sheet, SiteLot lot) 
{ 
    string line = lot.LineID; 
    string product = lot.Product.ProductID; 
    string process = lot.Process.ProcessID; 
    string step = lot.CurrentStep.StepID; 
    string eqp = string.Empty; 
    if (lot.CurrentPlan.LoadedResource == null) 
    { 
        eqp = "-"; 
    } 
    else 
    { 
        eqp = lot.CurrentPlan.LoadedResource.ResID; 
    } 
    string targetDate = DateUtility.DbToString(ShopCalendar.ShiftStartTimeOfDayEndT
(sheet.NowDT)); 
    StepMove item = sheet.GetRow(line, targetDate, product, process, step, eqp); 
    return item; 
} 

PEGGING MODULE
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Pegging Module Overview

MOZART engine basically generates Step Target and make the Plan & Scheduling for 
meeting the Target as the 1st prcedure for Planning & Schedule procedure. Basic Step 
Target generation logic is to progress each Demand backward, to process Lot's 
pegging for each Step, and to generate In/Out Target for each Step with residual 
quanity of Demand.

For the implementation of Pegging Logic, Pegging Module provides MOZART SeePlan 
Pegging Library and Pegging FEComponent. SeePlan Pegging Library is based on 
MOZART Rule Flow engine and provides a toolset which is appropriate for Pegging 
logic development. Its functions are majorly classified into 3 parts: 1. Composition of 
Pegging Model, 2. Execution Control of Pegging Model, 2. Creation and Management 
of Rule, Stage for easy and flexible implementation of Pegging Logic.

Pegging Model Design Function using FEAction : Expose FEAction through 
Pegging FEComponent of MOZART SeePlan & Semicon Library and manage 
FEDefinition (Implemented logic). Refer to Pegging FEModel.

Pegging Model Design Function using Digram : A function in Pegging Logic 
development tool to draw Models requried to perform Pegging in a diagram form.
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Function for editing Pegging Rule : Can register/modify/delete Rule which is a 
unit of execution for Pegging logic.

Function for editing Pegging Stage : Can register/modify/delete Stage which is 
a unit processing Rule Set in Rule Flow engine.

Rule Edit

Rule is included in a Stage and is the smallest execution unit of logic processed when 
a Stage is executed. SeePlan Pegging Library provides basic Rules for Pegging and 
user can add/modify/remove a Rule through Rule Editing function if necessary.

How to Edit Rule

1. Select [Pegging>Rules] node in MOZART Explorer.  

2. Select [Add Item] on the right-mouse-button menu.

3. Enter a name and description of Rule in Pegging Rule Creation dialog and click 
[OK].

4. Enter logic for Rules through the Rule source code window.

💡 Note
Both Input Parameters and Return value are StageTargetGroup that is used 
through typecast of a Data Class inherited and re-defined in the 
development site. In Pegging Project for Manufacturing industry, 
StageTargetGroup is Demand information for each product.

Rule Implementation Sample Code

// Sample of Rule to apply Yield  
public IStageTargetGroup ApplyYield(IStageTargetGroup target) 
{ 
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    PlanPart pp = target as PlanPart ; 
    float yield = GetYield(pp.CurrentStage); 
 
    foreach (MoStep ms in pp.TargetList) 
    { 
        ms.CalcQty = ms.CalcQty / yield; 
    } 
    return target; 
}

Stage Edit

Stage is one of the main components in Rule Flow Engine Model and also considered 
as the basic unit of logic execution and the entire Flow. User can re-define Model 
relationship among Stages through Main/Control FEComponent. Stage type, each 
type's execution rule, and rule execution order can be defined through Stage editor. 
For more details, check How to Implement Step Stage's Rule.

How to edit Stage
1. Select [Pegging>Stages] node from Model Explorer.

2. Select [Add Item] from the right-mouse-button menu.

3. Enter a name for a new Stage.

4. When Stage Editing window appears, enter description for the Stage and check 
the List of Pegging Rules by pressing [+] button located at the right top of “Rule 
Call Sequence” pane. Then, select a Rule that is applied to the Stage.

💡 Note 
Pegging Rule List displays not only basic rules defined in SeePlan 
Library and Domain Library but also all rules newly defined by users in 
the project.
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5. After all Rules, which should be executed in Stage, are selected, ⬆ ⬇ button can 
be used to adjust the order of Rules.

6. Save the information after editing for Stage is completed.

7. Once saved, a Stage node is created in Stages node of MOZART Explorer. When 
the corresponding Stage is expanded, all Rules in the Stage are displayed in their 
execution order.

💡 Note 
The source code of user-added Rule( [버튼이름] ) in Project can be 
edited through the corresponding Rule of the Stage node. However, it is 
not allowed editing Rule([버튼이름]) provided from Library.

8. Stage's Run/Wait status can be defined by configuring Property of Properties pane 
in Stage Editing window. Open a pop-up window to define property by pressing 
[…] button from Properties pane. Run and Wait Phase Property is basically 
included. Set the property name as "IsRun" for Run phase.
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After the property is included, return true for Run Phase and false for Wait Phase

Pegging Control Library

Overview
Pegging FEModel consists of two components. These can be used to re-define Core 
Model of SeePlan Pegging Library.

ModelBuild FEComponent 
Set of FEActions for customizing Pegging Model according to site's characteristics.

ModelRun FEComponent
Set of FEActions for controlling not only individual Rule but also Pegging Model 
when Pegging Model is executed.

Rules 
It provides basic logic that is generally used during Pegging. User can customize 
logic through FEAction exposed by pre-defined Rule.

ModelBuild Control

This is a set of FEActions that defines the composition of Pegging Model for Pegging 
execution. Like the following figure, pegging logic can be implemented dependent on 
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actual manufacturing line. That is, Pegging Model can be designed in different ways 
and logic are implemented to reflect the Modeling result.

1. GetModelNames : This function is used to add codes to return PeggerModel 
names comprising the entire Pegging Model. This code can be implemented after 
analyzing the corresponding manufacturing system and defining how to comprise 
PeggerModel. For example, Pegging for Semiconductor Fab can be processed 
with a single Pegger Model since FAb doesn't require any explicit or conceptual 



MOZART IDE (ENG) 324

Stock in Line. However, if there exists an explicit or conceptual Stock between 
production lines and lots have to be stored in the Stock for a specific period or 
according to some conditions before they are moved to next step, Pegging Model 
can be designed with more than one Pegger Models.

Sample Code

public List<string> GETModelNAMES(ref bool handled, List<string> prevReturnValue) 
{ 
    // if a signle Pegger Model is used as Semiconductor Fab  
    return new List<string>() { "Fab" }; 
} 
public List<string> GETModelNAMES(ref bool handled, List<string> prevReturnValue) 
{ 
    // if a Pegging Model is designed for a manufacturing line  
    // that has two seperate line groups and a Stock in the middler of them, 
    // the execution order is the same as the order that PeggerModels are listed in.  
    return new List<string>() { "Area", "Stock", "Area2" }; 
}

2. GetPreflowStageNames : It returns a list of names of Stages that compose 
Preflow of the designated Pegger Model in the execution order.

Sample Code

public List<string> GETModelNAMES(ref bool handled, List<string> prevReturnValue) 
{ 
    // if a signle Pegger Model is used as Semiconductor Fab  
    return new List<string>() { "Fab" }; 
} 
public List<string> GETModelNAMES(ref bool handled, List<string> prevReturnValue) 
{ 
    // if a Pegging Model is designed for a manufacturing line  
    // that has two seperate line groups and a Stock in the middler of them, 
    // the execution order is the same as the order that PeggerModels are listed in.  
    return new List<string>() { "Area", "Stock", "Area2" }; 
}

3. GetPostflowStageNames : It returns a list of Stage names in execution order that 
compose Postflow for each Model. The Stage should be included in advance to 
return Stage name or else the logic does not work properly. Through Stage node, 
define Rules called on Stage execution and execution order of the Rules.

4. GetStageTemplate : Unlike Preflow and PostFlow which are executed in the 
designated order of Stages, Main Flow of the Model proceeds according to the 
order of the steps for each product's progression. In general, Pegging Rules for 
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each step have a similar format. However, multiple Pegging could be applied in 
case Pegging requires to be done differently for same step status(Run, Wait).

💡 Note 
During Run or Wait Pegging, WIPs are pegged to Demand with the 
same Product ID and if there are residual WIPs, these WIPs could be 
pegged to Demand of other Product with the same representative 
Product.

In this case, one Step can be processed with multiple Stages. So this Action 
decides how many Stages are required for a Step and returns the name of Stages 
included in the Step in consecutive order. A sample code is given as follows.

Sample Code

// Before this same code is written, Stage of the corresponding Stage name should be 
created. 
public string[] GETSTAGETEMPLATE(Step step, ref bool handled, string[] prevReturnVal
ue) 
{ 
    return new string[] { "Run1", "Run2", "Run3", "Wait1", "Wait2", "Wait3" }; 
}

ModelRun Control

ModelRun Control is a set of FEAction required in controlling execution of Pegging 
Model as a mean other than individual Rule. This includes controls for Stage sequence 
of Main Flow in Pegger Model, Pegging priority for PegPart & PegTarget, and Merge or 
Split of PegPart (Demand).
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GetLastPeggingStep : It returns the first Pegging Step for each Product Target 
(Demand) on execution of Pegging Model. Usually the last Step of Flow (Process) 
becomes the first Pegging Step. So this Action's name reflects this and basic logic 
in SemiconFab Library also reflects this. In case of Main Flow in that Pegging for 
each step is processed, a logic for searching Stage corresponding to each product 
can be separately implemented.

Sample Code

public virtual Step GET_SEMI_LAST_PEGGING_STEP(PegPart pegPart, ref bool handled, St
ep prevReturnValue) 
{ 
    // Stages are created in Backward diretion from the last     
    // just return the fist Step of Flow. 
     SemiconPegPart pp = (SemiconPegPart)pegPart; 
     SemiconProcess proc = (SemiconProcess)pp.Product.Process; 
     SemiconStep first = (SemiconStep)proc.LastStep; 
  
     return first; 
 }

GetPrevPeggingStep : This action returns the information of the next Pegging 
Step of current one. For Preflow & Postflow that composes Pegger Model, the 
order of Stages is configured when Model is built and basic logic reflects this. 
However, in case of Main flow in that Pegging for each Step is executed, Stage for 
a resultant Step by the current Action is executed. If Process consists of a lot of 
Steps as seen in Semiconductor Fab, this Action can be used to implement a logic 
that skips Pegging for a specific Step according to condition. Since Pegging is 
processed in backward direction, next Pegging Step is previous Step in Flow.
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ComparePegPart : When Pegging for each PegPart is processed in backward 
direction of Flow, this Action can be used to decide priority of the Pegging process 
for each PegPart at the current Stage. For example, if a Product is divided into two 
at a specific Step in Forward direction, Demands for two PegPart are merged at 
the Step in Backward direction. However, if the dividend Products have the 
different numbers of Steps between the corresponding Step and Out Step, 
Pegging should not be executed at this Step until all divided Products’ current 
stages become the same Step (where Product is divided). In order to implement 
this logic, a logic for evaluating each PegPart's priority should be implemented.

💡 Note 
The above figure shows a Process structure of a Product that is divided 
into PRODUCT1 and PRODUCT2 at the 3. In this figure, if there are 
demands for each of PRODUCT1 and PRODUCT2, pegging for 
PRODUCT1 and PRODUCT2 begins at Step 6 and Step 8 respectively 
and moves one Step backward at a time. In this case, PegPart of 
PRODUCT1 arrives at Step 3 before PegPart of PRODUCT2 does. So if 
CurrentStage of PRODUCT1 PegPart is Step 3, the corresponding 
PegPart should not be pegged until Pegging for PegPart of PRODUCT2 
are completed at Step 4’, 5’ because pegging should be executed after 
PRODUCT1 and PRODUCT2 are merged at Step 3.

Sample code

public int COMPAREPEGPART(MOZART.SeePlan.Pegging.PegPart x, PegPart y, ref bool hand
led, int prevReturnValue) 
{ 
    // When all products are divided at Step 3 as in the above Figure, 
    // the following logic can be implemented according to Current Stage of two inpu
ts which are PegPart x, y, 
    // retrun 1 if x has higher priority, return -1 if x has lower priority, otherwi
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se return 0. 
    if (x.CurrentStage.StageID == "3") 
        return -1; 
    if (y.CurrentStage.StageID == "3") 
        return 1; 
    return 0; 
}

ComparePegTarget : In this Action, a comparison logic is implemented in order to 
decide pegging priority among PegTargets in the same PegPart on execution of 
pegging at a specific Step.

OnBeginFlow : This action is used to do additional settings for certain 
Stage/Block at the beginning of the Flow such as Enable/Disable execution of 
certain Stage/Block under certain conditions.

OnEndFlow : This action is used to do additional settings for certain Stage/Block 
at the end of the Flow such as Enable/Disable execution of certain Stage/Block 
under certain conditions. For instance, if a certain Stage/Block was disabled due to 
a condition specified from OnBeginFlow, the corresponding Stage/Block can be 
enabled through OnEndFlow.

MergePegParts : If Stage logic is processed not for each demand (PegPart) but 
for a bundle of PegParts merged by a specific logic (criterion) in the beginning of 
Flow execution, a logic is implemented to merge PegParts by MergedPegPart 
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Type. For example, since Pegger Model's Pre & Post flow do not require different 
logic for each Demand, all PegParts can be processed together as one PegPart.

SplitPegParts : If a merged PegPart exists at the moment when Flow ends, a 
logic can be implemented to divide the Pegpart into individual PegParts or smaller 
PegPart groups dependent on user's purpose.

MergePegPartsInStage : If PegParts need to be merged and pegged before a 
specific Stage is executed, this Action is used to implement a logic to merge 
PegParts. For example, if WIPs for Product A can be pegged to demand for 
Product B or C in order at a specific Stage when there is no demand for Product A, 
this Action is used to implement a logic that Product A, B, and C are merged at this 
Stage and pegged together.

SplitPegPartsInStage : This Action is used to implement a logic that a merged 
PegPart is kept or divided according to a specific rule just before the execution of 
the next stage after a specific Stage was executed.

GetAlignKey : This is called after a certain Stage of PegPart is finished. In case 
that a PegPart, which has just completed the correspondig Stage, has to be 
merged with another PegPart at the next Stage, it should be on standby until the 
another PegPart arrives. This could be done by setting Keys to the product code to 
be merged and the corresponding PegPart is queued until its next order. Using 
GetRealeseKey will have keys returned from the PegParts to proceed again in 
case there are no target PegParts to be merged.

GetReleaseKey : This is called if there are no target PegParts to proceed but 
PegPart exists in queue to Align(merging PegPart). GetReleaseKey decides which 
of the PegPart in queue to proceed by returning the Key allocated for Align. The 
released Key of the PegPart will be merged in case that the same PegPart exists 
by implementing MergePegPartInStage.

FEAction of Model Control will be Pegged in the following order
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Rules

Rules are provided in the pre-defined from in SeepPlan Library and can be used to 
define the execution order of Rules. For the pre-defined Rule, user can define Logic 
like providing data required to process Rule or processing Output. Here are described 
each Rule's Logic design and user-defined logic implementation point (FEAction).



MOZART IDE (ENG) 331

Stage is used to apply Rule for Pegging. The figure above shows that a Step can be 
comprised with multiple Stages for each Phase of a Step. The following figure shows 
different Stages design for each Step according to the user group Pegging 
requirements.

The design at the top of figure consists of two Stages with one for Run and another for 
Wait and is applying Rules to each stage. The other design at the bottom consists of 
multiple Stages that make it possible to execute Run, Wait pegging multiple times. 
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Theoretically, Stage can be divided into n Stages according to user group's pegging 
logic.

WRITE_TARGET
This Rule is to write Target information for each Demand at a specific Step. Since 
Step's Target Data format can be different depending on user group, user can use 
FEAction to define Output handling according to user own way.

WriteTarget : The FEAction to implement logic to write the process step target to 
the output DataItem.

Sample Code

public void WRITETARGET(MOZART.SeePlan.Pegging.PegPart pegPart, bool isOut, ref bool 
handled) 
{ 
    SemiconPegPart pp = pegPart as SemiconPegPart; 
    
    foreach (SemiconPegTarget ms in pp.PegTargetList) 
    { 
    WriteTarget(ms, pp.CurrentStage, pp.Product.ProductID, isOut); 
    } 
} 
private void WriteTarget(SemiconPegTarget ms, PegStage stage, string prodID, bool is
Out) 
{ 
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    if (OutputMart.Instance.StepTarget == null) 
    return; 
  
    DateTime shiftDt = DateTime.MinValue; 
    shiftDt = ShopCalendar.ShiftStartTimeOfDayT(ms.CalcDate); 
  
    MfgStep step = stage.Tag as MfgStep; 
    MfgProcess proc = step.Process as MfgProcess; 
  
    StepTarget st = new StepTarget(); 
  
    st.TARGET_DATE = shiftDt; 
    st.IN_TARGET_QTY = 0; 
    st.OUT_TARGET_QTY = 0; 
  
    OutputMart.Instance.StepTarget.Add(st); 
  
    st.LINE_ID = proc.LineID; 
    st.PRODUCT_ID = prodID; 
    st.PROCESS_ID = step.Process.ProcessID; 
    st.STEP_ID = step.StepID; 
  
    if (isOut) 
    { 
        st.OUT_TARGET_QTY += ms.CalcQty; 
    } 
    else 
    { 
        st.IN_TARGET_QTY += ms.CalcQty; 
    } 
  
    st.MO_DEMAND_ID = ms.Mo.DemandID; 
    st.MO_DUE_DATE = ms.Mo.DueDate; 
    st.MO_PRIORITY = 1; 
    st.MO_PRODUCT_ID = ms.Mo.ProductID; 
}

GetStepPlanKey : This is used when Foward Pegging function is used during 
Simulation run after Backward Pegging has executed. When StepTarget in 
StepPlan is written from PegTarget, this returns a Key for identifying StepPlan in 
the same Step. If null is returned, the corresponding StepTarget is not written. 
Generally product code is used as StepPlanKey in most cases.

CreateStepTarget : This generates StepTarget for Foward Pegging based on 
PegTarget information and Key. The following code is an example to prepare 
Forward Pegging through GetStepPlanKey and CreateStepTarget.

Generating Forward Pegging SetPlan

// GetStepPlanKey function implementation 
public object GETSTEPPLANKEY(PegPart pegPart, ref bool handled, object prevReturnValue) 
{ 
    // Use Product object as Key 
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    return (pegPart as SitePegPart).Product; 
} 
// CreateStepTarget function implementation 
public StepTarget CREATESTEPTARGET(PegTarget pegTarget, object stepPlanKey, Step step, b
ool isRun, ref bool handled, StepTarget prevReturnValue) 
{ 
    // Library's basic class is created  
    var pt = pegTarget as SitePegTarget; 
    var st = new StepTarget(stepPlanKey, step, pt.Qty, pt.DueDate, isRun); 
    return st; 
}

PEG_WIP
PEG_WIP is Rule that pegs target WIP to the Demand of a specific step. The following 
diagram shows the logic(FEAction) of PEG_WIP Rule that should be defined by users.

GetWips : Logic is written to return information of WIPs that can be pegged to the 
corresponding Demand. This returns a list of target WIPs according to condition for 
Pegging and state of Stage. Constraint for Pegging constraints can be reflected as 
well.

Sample Code
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public IList<MOZART.SeePlan.Pegging.IMaterial> MAP_WIP(MOZART.SeePlan.Pegging.PegPar
t pegPart, bool isRun, ref bool handled, IList<IMaterial> prevReturnValue) 
{ 
    SemiconPegPart pp = PegHelper.GetPlanPart(pegPart); 
    MfgStep step = PegHelper.GetCurrentStep(pegPart); 
    HashSet<PlanWip> wips; 
  
    List<IMaterial> result = new List<IMaterial>(); 
  
    if (InputMart.Instance.PlanWips.TryGetValue(step, out wips) && wips.Count > 0) 
    { 
        foreach (PlanWip wip in wips) 
        { 
            if (isRun != (wip.State == "RUN")) 
            continue; 
  
            if (wip.Wip.Product.ProductID == pp.Product.ProductID) 
            { 
                wip.MapCount++; 
                result.Add(wip); 
            } 
        } 
    } 
  
    return result; 
}

SortWip : WIPS returned by GetWips are sorted in the order of Pegging priority. If 
not implemented, WIPs are pegged in random order.

CanPegMore : A logic needs to be added whether to decide individual WIP can be 
pegged to Demand or not. This logic can reflect components that restrict pegging 
according to WIP property and Demand status.

AvailPegQty : When a specific lot is pegged to a PegTarget, it is possible to peg 
only part of the lot instead of whole lot. In this case, a logic is implemented to 
return the number of units that can be pegged in the lot.

UpdatePegInfo : UpdatePegInfo is used when the property of PegTarget or 
PegPart needs to be changed at the moment of Pegging. PegTarget is basically 
updated with the residual quantities. In cases when user needs to manipulate 
specified data property using information such as pegged lot quantity and lot 
information, this could be done throuh UpdatePegInfo. For example, if user wants 
to manipulate the residual quantity information with no yield value reflected to 
PegTarget, user can update this property through this function after defining the 
property of PegTarget.

WritePeg : When each WIP is pegged, the Pegging result is written into user 
group specified Pegging Output.
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Sample Code

public void WRITEPEG(PegTarget target, IMaterial material, float qty, ref bool handl
ed) 
{         
    if (OutputMart.Instance.PegHistory == null) 
        return; 
  
    SemiconPegTarget ms = target as SemiconPegTarget; 
    PlanWip wip = material as PlanWip; 
  
    DateTime shiftDt = ShopCalendar.StartTimeOfDayT(ms.CalcDate); 
    MfgStep step = PegHelper.GetCurrentStep(target.PegPart); 
    MfgProcess proc = step.Process as MfgProcess; 
  
    PegHistory history = new PegHistory() 
    { 
        LINE_ID = (wip.Wip as WipInfo).LineID, 
        LOT_ID = wip.Wip.LotID, 
        PRODUCT_ID = wip.Wip.Product.ProductID, 
        STEP_ID = (wip.Wip as WipInfo).Step.StepID, 
        LOT_QTY = wip.Wip.UnitQty, 
        PEG_QTY = qty, 
        MO_DEMAND_ID = ms.Mo.DemandID, 
        MO_DUEDATE = ms.Mo.DueDate, 
        MO_PRODUCT_ID = ms.ProductID, 
        LPST = ms.CalcDate 
    }; 
  
    OutputMart.Instance.PegHistory.Add(history); 
}

IsRemoveEmptyTarget : This function removes PegTarget from PegPart list if 
there is no redisual Target left after Pegging. Default value is false so PegTarget is 
not deleted.

SHIFT_TAT
This executes a logic that shifts the time of Target by Step TAT. If this logic considers 
Run and Wait phase for a Step, the logic is also implemented to return the 
corresponding TATs. Rule for applying TAT can be vary depending on the site. For 
instance, only Run TAT or Wait TAT can be considered. Or sequence and location 
could be changed in relation to TAT.
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GetTat : User can write a code that returns TAT about CurrentStage, which is a 
target Step for pegging to PegPart

Sample Code

public TimeSpan GETTAT(MOZART.SeePlan.Pegging.PegPart pegPart, bool isRun, ref bool
 handled, TimeSpan prevReturnValue) 
{ 
    SemiconPegPart pp = pegPart as SemiconPegPart; 
    MfgStep step = pp.CurrentStage.Tag as MfgStep; 
    StepTat tat = InputMart.Instance.StepTat.Rows.Find(new object[] { pp.Product.Lin
eID, pp.Product.ProductID, step.StepID }); 
    double t = double.MinValue; 
    if (tat != null) 
    { 
        if (isRun) 
            t = tat.RUN_TAT; 
        else 
            t = tat.WAIT_TAT; 
    } 
    else 
        t = 3600d; //Default TAT value 1Hr 
    return TimeSpan.FromSeconds(t); 
}

GetTargetTat : TAT for the same Product at the same Step can be applied 
different according to time. In this case, TAT can be separately configured for each 
PegTarget in this function. If there is a return value implemented to this function, 
the value is applied instead of GetTAT return value.

UpdateTatInfo : Action called right after TAT is updated. DueDate of the Target is 
updated automatically from the library when TAT is returned. Other than DueDate, 
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user specified property can be changed or logic could be implemented through this 
function.

APPLY_YIELD
APPLY_YIELD handles the logic that reflects yield value to Step. If Yield is 90% and 
Out target is 100, then Target should be created considering In Target= 100/0.9 = 111 
and apply the rule to the corresponding logic. Generally, if Demand is adjusted with a 
mean value of  yield, yield for each step is not reflected unless it is required to be 
considered.

GetYield : This returns a yield value that is applied at a Step. This is implemented 
only if different yield value for each Step is used. Unless the default value is 1, the 
result is like developing a Model that doesn't reflect Yield.

Sample Code

public float GETYIELD(MOZART.SeePlan.Pegging.PegPart pegPart, ref bool handled, floa
t prevReturnValue) 
{ 
    SemiconPegPart pp = PegHelper.GetPlanPart(pegPart); 
    MfgStep current = PegHelper.GetCurrentStep(pegPart); 
    Yield y = InputMart.Instance.Yield.Rows.Find(new object[] { pp.Product.LineID, p
p.Product.ProductID, current.StepID }); 
    if (y != null) 
        return (float)y.STEP_YIELD; 
    return 1.0f; 
}
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GetTargetYield : If Yield value varies according to period, different Yield value can 
be applied for each Target. In this case, this function can be implemented. For 
example, if 95% Yield is applied to Target with DueDate = 'April' and 98% Yield is 
applied to Target with DueDate = 'May', a logic can be implemented to check 
DueDate of the Target in order to return different Yield value.

RoundResult : This function returns the rounded output value with yield rate 
applied.

UpdateYieldInfo : An Action to update information based on data with yield rate 
applied.

CHANGE_PART
If a Product can be changed due to Product Route, user should implement a logic that 
returns information of (To) Product at the Step where product change takes place 
before the next Step's Pegging is triggered. Product change occurs mainly in the 
following cases : 1) when a Product is changed by BOM structure of Product, 2) 
when a common Product is divided and changed into other Products according 
to Product's quality or customer. This Rule is used only when Modeling for Product 
change is required.

(1) Product Change by BOM - If Product is changed by BOM, Demand for Product AA 
results in Demands for Product A0, A1, and A2 at Step M. (2) Part Change caused by 
Product division - If a product is divided into several product, demands for Product BA, 
BB, BC should be merged as a demand for Product B at Step S and then pegging is 
executed for Product B. That is, by considering the property of Pegging, 
CHANGED_PART Rule can be used to design a product change Model through two 
FEAction as shown below.
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GetPartChangeInfo : It returns information of Product, which is the result of 
Product change after the current Step of PegPart.

Sample Code

public List<object> GETPARTCHANGEINFOS(PegPart pegPart, ref bool handled, List<objec
t> prevReturnValue) 
{ 
    SemiconPegPart pp = (SemiconPegPart)pegPart; 
  
    string currentLineID = pp.Product.LineID; 
    string currentProdID = pp.Product.ProductID; 
    string currentProcID = pp.Product.Process.ProcessID; 
    string currentStepID = (pp.CurrentStage.Tag as MfgStep).StepID; 
  
    var infos = InputMart.Instance.ProductRoute.Rows.Where(p => (p.LINE_ID == curren
tLineID && 
        p.TO_PROD_ID == currentProdID && 
        p.TO_PROC_ID == currentProcID && 
        p.TO_STEP_ID == currentStepID) 
        ); 
  
    var list = infos.ToList<object>(); 
    return infos.ToList<object>();    
}

ApplyPartChangeInfo : Sets the informatio of Product and Step according to the 
PegPart generated by changed product information.

Sample Code

public PegPart APPLYPARTCHANGEINFO(PegPart pegPart, object partChangeInfo, ref bool
 handled, PegPart prevReturnValue) 
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{ 
    ProductRoute route = (ProductRoute)partChangeInfo; 
  
    MfgProduct changeProd = InputMart.Instance.ProductList[route.FR_PROD_ID]; 
    MfgProcess changeProc = InputMart.Instance.ProcessList[route.FR_PROC_ID]; 
    MfgStep changeStep = (MfgStep)changeProc.FindStep(route.FR_STEP_ID); 
    PegStage changeStage = pegPart.CurrentStage.Model.GetStage(changeStep); 
  
    SemiconPegPart pp = (SemiconPegPart)pegPart; 
    pp.Product = changeProd; 
    pp.CurrentStage = changeStage; 
  
    return pp; 
}

APPLY_ACT
This Rule is used to subtract actual outputs from initial Demand. At the time of Pegging 
execution, it figures out how many outputs were produced with respect to each 
Demand of Product within plan period. So it provides what quantity should be 
produced in the future.

GetActs : It returns the information of actual outputs to be deducted. The 
information to returned implements IMaterial Interface.

CanActPegMore : It implements a logic that decides whether target actual outputs 
can be pegged to current Demand (PegPart) or not.

WriteActPeg : When the target actual outputs are pegged to current Demand 
(PegPart), this Rule writes the result of Pegging in the Output format defined by 
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user group.

MANIPULATE_DEMAND
When Demand is divided into daily demands with the same level of quantity for 
Pegging or needs to be adjusted based on deadline, the corresponding logic is 
implemented in this Rule. Generally this Rule is included in a Stage comprising 
Preflow of Pegger Model.

ManipulateDemand : This is used to implement a logic to convert a given 
Demand into Input Demand for Pegging.

PREPARE_TARGET 
This rule creates PegTarget information based on Demand information. Generally a 
PegPart is created for each Product mapped to Out Demand.

PrepareTarget : It creates and returns PegTarget based on Demand information 
for pegging.

Sample Code

public PegPart PREPARETARGET(PegPart pegPart, ref bool handled, PegPart prevReturnVa
lue) 
{ 
    MergedPegPart mg = pegPart as MergedPegPart; 
  
    foreach (SemiconMoMaster mm in InputMart.Instance.Demands.Values) 
    { 
        SemiconPegPart pp = new SemiconPegPart(mm, mm.Product); 
  
        foreach (SemiconMoPlan mp in pp.MoMaster.MoPlanList) 
        { 
            SemiconPegTarget ms = new SemiconPegTarget(pp, mp); 
            pp.AddPegTarget(ms); 
        } 
  
        mg.Merge(pp); 
    } 
  
    return (mg as PegPart); 
}
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PREPARE_WIP
This generates information of PlanWip for Pegging with initial WIP data. At this 
moment, WIP information can be validated and initial WIP's Step location can be 
adjusted.

PrepareWip : This creates and initializes WIP information for Pegging.

Sample Code

public PegPart PREPAREWIP(PegPart pegPart, ref bool handled, PegPart prevReturnValu
e) 
{ 
    HashSet<PlanWip> wipSets = null; 
  
    foreach (WipInfo info in InputMart.Instance.WipList.Values) 
    { 
        PlanWip wip = new PlanWip(info); 
        if ((wip.Wip as WipInfo).Process == null) 
        { 
            // there are no process info 
            PegHelper.WriteUnpegHistory(wip, wip.Wip.UnitQty, "STD", "No Process Inf
o"); 
            continue; 
        } 
  
        if ((wip.Wip as WipInfo).Step == null) 
        { 
            // there are no step info 
            PegHelper.WriteUnpegHistory(wip, wip.Wip.UnitQty, "STD", "No Step Inf
o"); 
            continue; 
        } 
  
        if (InputMart.Instance.PlanWips.TryGetValue(info.Step, out wipSets) == fals
e) 
        { 
            wipSets = new HashedSet<PlanWip>(); 
            InputMart.Instance.PlanWips.Add(info.Step, wipSets); 
        } 
  
        wipSets.Add(wip); 
    } 
  
    return pegPart; 
}

BUILD_INPLAN
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This establishes an Input Plan for the residual Demands after Pegging is completed. 
Generally this Rule is used to comprise Post flow of Pegger Model and input values 
are PegPart and MergedPegPart. This Input Plan is used as final Output or used as 
basic Input for creating input Lot when Forward Simulation is executed.

BuildInPlan : This is used to implement logic to deploy residual Targets of the 
PegPart by regrouping and create input plan by considering the user group 
specified rules.

WRITE_UNPEG
For WIPs not pegged after Pegging has completed, this rule writes each WIP's 
unpegged reason to Output according to the requirement level of user organization. 
Normally, most common cases WIP not pegged after pegging is complete is either 
there are no Demands for WIP's product or WIP has been inserted too much 
compared to the Demand.  In these cases, it is possible to develop a logic for 
analyzing more detailed reason according to user group's requirement.

WriteUnpeg : This writes the reason of unpegged WIPs to Output through 
remaining WIP status.

Sample Code

public void WRITEUNPEG(MOZART.SeePlan.Pegging.PegPart pegPart, ref bool handled) 
{ 
    foreach (HashSet<PlanWip> wipList in InputMart.Instance.PlanWips.Values) 
    { 
        foreach (PlanWip wip in wipList) 
        { 
            if (wip.Qty == 0) 
            continue; 
  
            if (wip.MapCount == 0) 
            { 
                PegHelper.WriteUnpegHistory(wip, wip.Qty, "PEG", "NO TARGET"); 
            } 
            else if (wip.Qty > 0) 
            { 
                PegHelper.WriteUnpegHistory(wip, wip.Qty, "PEG", "EXCESS"); 
            } 
        } 
    } 
}
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FILTER_TARGET 
FILTER_TARGET can be used in order to not execute Pegging for some PegPart or 
PegTarget included in PegPart. The corresponding Rule first decides whether PegPart 
should be filtered or not. If PegPart is not filtered, this logic decides whether filtering 
should be applied for each PegTarget or not. If this Rule is applied, the following 
Actions are exposed to allow user to process filtering logic.

FilterPegPart : Distinguishes the subject PegPart whether to be pegged with lots 
at the current Step or not.

FilterPegTarget : Distinguishes the subject PegTarget whether to be pegged with 
lots at the current Step or not. For example, if there is a condition not to peg lots to 
a certain product Demand of a specific step at a specific date, this function can be 
implemented to filter the corresponding Target.

SMOOTH_DEMAND
This Rule is to process Demand information for Pegging. Demand information usually 
consists weekly/monthly Demand quantity for each Product. In order to execute 
Pegging, this Demand information is normally converted to daily production 
requirements in quantity for each Product. SMOOTH_DEMAND Rule is included in 
Library for the process to convert the source Demand into daily production targets by 
considering the production capacity and the deadline of delivery for Demand. To 
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execute the corresponding Rule, it should be implemented with Smoother Class 
provided by Library.

Basically smoother adds up all Demands for each product and determines daily 
production Capacity under the premise that same amount of products will be 
manufactured everyday during the plan period and fills the Capacity Buckets with each 
product Demands and calculates the daily production target. The following sample 
figures show the concept of Demand Smoothing. In this example, Cut-Off is a property 
to configure how many days before the last day of the week a weekly plan quantity 
should be produced. For instance, Cut-Off = 2 means that target quantity should be 
produced until the end of Friday if a Week starts on Monday and ends on Sunday.

In step 1, the target amount of A1 in Week W0 is 500  and Cut-Off = 2, so the Product 
should be produced for 5 days. In other words, 100 units (= 500/5) for Product A1 
should be produced per day. For Product A2, the target amount in Week W0 is 700 
and Cut-Off is 0 which means Product A2 has to be produced for 7 days and daily 
production target for Product A2 is 100 units (=700/7) per day. If both Products are 
required to be produced according to the fixed plan for D0, D1, daily production plan 
should be made with the quantity of residual Demand after excluding the quantity in 
the fixed plan and in result the fixed plan will be seen as Figure 2. Confirmed Plan 
Mapping.  If daily Capacity is configured from the summation of each product group's 
residual quantity, the result can be shown like the figure below.
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The following shows Items that should be implemented by user when using 
SMOOTH_DEMAND Rule.

GetSmoother : This creates, initializes, and returns an object of Smoother Class 
that will be used in SMOOTH_DEMAND rule. Refer to Library Reference for more 
details to learn how to use Smoother class. When a Smoother object is created, 
the followings are the main Inputs.

MoPlanList : This is list of MoPlan, Demand before smoothing.

MoPlanComparerForSmoothing : it is a comparer for deciding the order to 
fill Capacity Bucket configured during Demand Smoothing.

MoPlanComparerForPrioritizing : it is a comparer for deciding the order of 
priority among individual Demands.

fixDays : it is the number of days that should reflect the fixed plan in the 
original plan. For example, if it is configured as 2, MoPlans for D0, D1 are 
fixed and filling Buckets is processed for the rest of plan days.

allowEarllyProcess : It is configured whether plan quantity included in 
Demand can be produced in advaance than the plan or not. Default value is 
false. If the value is set to true, Demand can be distributed in advance.

batchSize : it is the basic unit for subtracting Capacity when Bucket is filled 
with Demand(MoPlan). For example, if batchSize is 200, Bucket should be 
summed up by 200 units.

GetInnerBucketKey : A Demand group having the same deadline of delivery in 
the same Product group is called InnerBucket. This Action decides which 
InnerBucket should be used for a specific Demand and returns a Key for the 
InnerBucket.

GetOuterBucketKey : Groups multiple product groups and returns Key for the 
group to allocate Capacity.

CreateInnerBucket : Creates InnerBucket and returns it
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CreateOuterBucket : Creates OuterBucket and returns it

GetWeekNo : This returns week information of target MoPlan. As criteria in 
managing a week are different for each Site, this reflects the differences.

SaveMoPlans : This updates MoPlan with the final result modified by Smoothing.

Pegging Modeler

Overview
MOZART Pegging Library provides set of tools appropriate to Pegging Logic 
development based on MOZART Rule Flow engine. One of Pegging Logic 
development tools is Pegging Modeler that provides a function to create models for 
Pegging tasks by drawing Diagram. Due to diagram, Pegging Modeler gives better 
understanding of the relationship and call sequence among Actions when it is 
compared to logic development through Pegging Module. Pegger have unclear 
executaion order of Actions unlike Simulation so that it is not determined which Stage 
is executed. Therefore, users can decide the sequence of Stages and implement 
Pegging Logic through Pegging Modeler. Pegging Modeler provides the following 
functions: function for Editing Model to define Area, Stock, and sequence and 
relationship of Flows executed in Area, function for Editing Flow to define the 
relationship and sequence among Stages and Functions executed in Flow, finally 
function for Running the implemented Model.

Model Editing : This defines the basic flow of the Pegging Model. Area, Stock, 
and sequence and relationship among Flows executed in Area are also defined 
through this function.

Flow Editing : This defines the relationship and sequence among Stage and 
Functions executed in the Flow. Pegging Logic can be expressed through 
functions like Stage, Switch, and Align, etc.

Model Execution Configuration : This function provides to edit configuration for 
the execution of the Pegging Model developed by editing Model and Flow. If there 
are more than one Pegging Models, the execution sequence can also be changed.
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The Pegging Modeler's Editing Panes consists of as follows : Model Editing Pane and 
Flow Editing Pane. From each editor pane, items can be added by using Drag & Drop 
from the tool bar on the top.

Model Edit

Pegging Modeler provides Model Editing function, which is used to define Area and 
Stock of Pegging Model and defines the sequence and relationship among Flows 
executed in Area, and Flow Editing function, which is used to define the relationship 
and the sequence of Stage and Function to be executed from Flow. Among these, 
Model Editing function is responsible to define the general flow of Pegging Model. This 
section explains what Items are required for Model Editing and how to use these Items 
for defining Model Flow.

Model Editor Items
1. Default Node
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This block is provided as default in Model Editing Pane. Area and Stock can be 
included between 'S' Node and 'E' Node. Because Pegging is based on Backward 
Planning, the flow starts from 'S(Start)' to 'E(End)' in the backward direction.

2. Area

This block can be added to the highest level of Model. Area has a role to bind 
Flows(Normal Flow and Process Flow) in Pegging Model ahd should have at least 
one Flow. When a Flow is added in Area, the Flows are executed by starting from 
the closest one to 'S' node in order. And Flow can be included only in Area.

3. Stock

This block could be added to the highest level of the Model. Stock simply process 
Stages in a sequential order. Flow cannot be included under Stock.

4. Normal Flow

This is a kind of Flow and can be included in Area only. Normal Flow simply 
processes Stages in a sequential order like Stock. Only Stage can be included in 
Normal Flow.

5. Process Flow
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This is a kind of Flow and can be included in Area only. Process Flow is Flow in 
that Pegging is actually executed. In Process Flow, not only Stage but also 
Functions such as Switch, Align, etc. can be included so that Pegging Logic can 
be represented through these functions

How to Edit Model
Pegging Model basically processes Area and Stock which are registered in Diagram. 
The following shows the procedure to define flow in Model by adding Area and Stock 
through Model Editing Pane.

Adding 'Model' Item Block

1. Select and expand Pegging > Model node from MOZART Explorer.

2. Right click on Models and select [Add Item] from the pop-up menu.

3. Create a name for the Model from Create new pegging Model Dialog and click 
[OK] button.

4. Once the Model Editing Pane is activated, drag & drop an Item Block from the 
toolbar on top of the pane and define Model Flow.
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5. A window to input Item Block name will appear if Item Block is placed on Default 
Node.

6. Add a name for the Item Block and click [Ok] button.

7. Then, an Item Block will be included like in the following figure. 'Stock'. 'Normal 
Flow' and 'Process Flow' blocks can be included in the same way.

8. If you want to change any Item Block's location, select the Item Block and change 
its location by drag & drop.

9. In general, Area and Stock are serially connected but it is possible to connect in 
parallel. If Area and Stock is serially connected, the Flow nearest to 'S' node will 
start and the next nearest Flow follows. If Area and Stock are connected in 
parallel, merge the result after processing as the same PegPart.

10. Except for 'Area', you can open Flow Editing Pane by double-clicking 'Stock', 
'Normal Flow' and 'Process Flow' block. In Flow Editing Pane, the relationship and 
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execution sequence among Stage and Function could be defined. Go to Flow 
Editing to find more details.

Modifying and Deleting 'Model' Item Block

Registered Item Block can be either modified or deleted. This section will explain how 
to modify and delete Item Block.

1. Select an 'Item Block' whose name is going be changed and right click on the 
mouse. Then, the Item Block's state is changed to be able to modify its name.

2.  Change the name and click any point outside the selected Block. Then, save the 
progress by clicking [Save All].
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3. To delete an 'Item Block', select the Item Block and press [Delete] button of the 
keyboard.

Flow Edit

There are two types of Flows, Normal Flow and Process Flow. Normal Flow is similar 
to Stock which simply proceeds Stages in a sequential order. In Normal Flow, PegPart 
starts from 'S' node and proceeds all Stage and Rules and then ends the Flow by 
reaching 'E' node. Process Flow is a Flow that actually executes Pegging. Stage and 
other functions like Switch, Align, etc. are used to express Pegging Logic. This section 
explains the Items required for editing Flow and how to express Pegging Logic using 
these Items.

Flow Editing Items
1. Default Node

This Block and Definition is provided as default in Flow Editing Pane. 
GetLastPeggingStep, one of Definitions, is the first one that is executed when 
PegPart enters Process Flow. The return value of GetLastPeggingStep is stored in 
CurrentStep Property of PegPart. GetPrevPeggingStep is called when the step 
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moves to the previous one after all Stages of a Step have been executed. When 
PegPart's CurrentStep is changed to previous Step, PegPart will start again from 
Node following GetLastPeggingStep in Process Flow.

2. Stage

This Block can be included to Stock, Normal Flow and Process Flow. Stage is one 
of the main elements that comprise Model in Rule Flow engine and is used as a 
basic unit for logic processing and entire Flow composition. To add Stage to a Flow 
in Pegging Modeler, Stage Item needs to be added under Pegging Module. Check 
Editing Stage to find more details.

3. Switch

This block can be included only inside Process Flow. Switch is used to control the 
Flow of PegPart according to conditions. PegPart flow is decided by comparing the 
return value of Switch Expression to the value of Switch Case.

4. Align

This block can be included only inside Process Flow. Align is used to exclude a 
PegPart corresponding to a specific condition from a PegPart to be processed. 
Align is also used to process the case that PegPart with the low priority at a 
specific Stage should be merged into other PegPart.

5. MergePegParts

This is a Definition that can be included only inside Process Flow. MergePegParts 
is used when PegParts, which has been excluded by Align, are returned and need 
to be merged for processing of the next logic. MergePegParts can be processed 
only after Align.
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6. SplitPegPart

This is a Definition that can be included only inside Process Flow. SplitPegPart is 
used when a PegPart is required to be split into two or more. SplitPegPart can be 
used at any place between GetLastPeggingStep and GetPrevePEggingStep.

7. SelectResumePegParts

This is a Definition that can be included only inside Process Flow. When all 
PegParts are excluded from target of processing and no PegParts are left to 
proceed, this is called to select PegPart that is going to be considered as a target 
of processing again. The returned PegPart is selected by referring to Align name 
and Key value that is configured in Align logic.

1. ComparePegPart

This is a Definition that can be included only inside Process Flow. 
ComparePegPart compares PegParts in Flow and decides their processing 
priority. For example, if there is PegPart 'x' and PegPart 'y', ComparePegPart will 
compare these two PegParts and check the return value. If the integer value is 
negative(-), PegPart 'x' will have higher prioirty, else if the value is positive(+), 
PegPart 'y' will have higher priority. If the returned value is '0', both PegParts will 
have the same priority.

How to edit Flow

Adding 'Flow' Item Block

1. Double click 'Model' Item Block from Model editor window.

2. If the Flow editor window is activated, drag & drop the Item Block from the toolbar 
on top of the screen to define Flow.
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3. A window to input Item Block name will appear if Item Block is placed on Default 
Node.

4. Add a name for the Item Block and click [Ok] button.

5. An Item Block will be included in the Default Node.

Adding 'Stage' Item Block
Pegging Modeler uses Stage defined in Pegging Module. (Check Editing Stage) 
Thus, to include 'Stage' Item Block from Flow editor, only the Stages defined in 
Pegging Module can be selected and added as Blocks.

1. 'Creating Pegging Stage pop-up menu will appear if a 'Stage' Item Block is 
dragged & dropped to Default Node.

2. Select Stage from the the combo box 'Select  Stage.
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Display Name : Name of Stage seen through Flow editor page of Pegging 
Modeler. The Stage is activated when it is selected from Base Template Field.

Base Template : The list of Stages defined in Pegging Module. It is the 'Base' 
for registering 'Stage' Item Block from Pegging Modeler.

Stage Name : Name of the copied Stage. 'Copy' is activated when it is 
checked from Base Template. If the selected Stage is copied, all the rules and 
property information will be copied as well and the Stage will be included 
under Pegging Module>Stages node using the name created through Stage 
Name.

3. Click [OK] after Stage is selected and 'Stage' Item Block will be included.

4. As same as Pegging Module>Stages, double click on 'Stage' Item Block to open 
Stage Editor pop-up window. Rules and properties can be configured through 
Stage Editor pop-up.

Adding 'Switch' Item Block

Switch can control PegPart flow according to Switch Expression and Switch Case. 
Thus, when 'Switch' Item Block is included, Switch Expression and Switch Case needs 
to be specified.
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1. Drag & drop 'Switch' Item Block to the Default Node, add 'Item Block' name and 
click [OK] button.

2. A Switch Editor pop-up window will appear. Define Switch Expression and Switch 
Case through this window.

Define Switch Expression
Selecting Expression : A combo box with list of preset Load Expressions.

Adding Expression : Creates the Switch function and codes to control 
PegPart flow by pressing ➕ button. The name of the file with the created 
function is Main.cs, created in Logic>Pegging folder.

Editing Expression : You can move to the source code page to edit the 
Expression selected from Select Expression by pressing [버튼이름] button.

Editing Expression name  : Press [버튼이름] button to change the function 
name of Expression.

Define Switch Case
Adding Case : Press ➕ button to add new Case.
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Deleting Case  : Press ➖ button to delete case. Please note that default case 
cannot be deleted.

3. Click [OK] button to add 'Switch' Item Block after configuring Switch Expression 
and Switch Case.

4. You can always modify Switch Expression and Switch Case of 'Switch' Item Block 
through Switch Editor pop-up window by double-clicking the 'Switch' Item Block.

Adding 'Flow' Definition

In Pegging Model, Definition can be included to the Block that controls PegPart flow. 
The following 'Flow' Item Blocks can have Definition: 'GetLastPeggingStep', 
'GetPrevPeggingStep', 'Align', 'MergePegParts', 'SplitPegPart', 
'SelectResumePegParts' and 'ComparePegPArt'. The following section shows how to 
include Definition to an Item Block.

1. Double-click on the Item Block to include Definition and open Add FE Method.

2. Add Method name and description and press [OK] button.

3. Then a prototype code will be generated into Main.cs
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public partial class Main 
{ 
    /// <summary> 
    /// </summary> 
    /// <param name="pegPart"/> 
    /// <returns/> 
    public Step GETLASTPEGGINGSTEP(MOZART.SeePlan.Pegging.PegPart pegPart) 
    { 
        return default(Step); 
    } 
}

4. Add Pegging Logic code to the created function.

Example: Implementing and Using Definition

public Step GETLASTPEGGINGSTEP(MOZART.SeePlan.Pegging.PegPart pegPart) 
{ 
    var pp = (SimpleMfgSemiconPegPart)pegPart; 
    var proc = (SimpleMfgSemiconProcess)pp.Product.Process; 
    var last = proc.LastStep;  
 
    return last; 
}

Execute Model

When Pegging Model is included to Pegging Modeler, the Model is registered in 
inactive state. In order to run Pegging Moodel, it should be selected whether Pegging 
Model is executed or not. Also if there are two or more Pegging Models, their 
execution sequence can be adjusted.

1. In MOZART Explorer, right click on Pegging Model and select [Active] to activate 
Model.
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2. When Pegging Model is activated, the icon's color will be changed to blue and the 
corresponding Pegging Model is executed.

3. When [Active] is unchecked, the corresponding Pegging Model will not proceed 
and the icon's color will turn into gray. If all Pegging Models are deactivated, 
Pegging Logic defined in the existing Pegger will be executed.

4. Pegging Model is processed in the order of Nodes registered through MOZART 
Explorer. The sequence can be changed if two or more Pegging Models exist. To 
change the order, select the Pegging Model to be changed, drag the Model to the 
designated location and drop it.
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CBS MODULE

Capacity Bucket Simulation 개념 및 개요

Capacity Bucketing Simulation 은 생산자원을 capacity bucket 으로 모델링하고 
Simulation 의 시간진행을 Bucket Rolling 주기에 맞도록 진행시켜가면서 주어진 Demand 
(PO:purchase order, WO:work order)의 우선순위와 제약을 고려하여 capacity bucket 에 
할당하는 방식의 시뮬레이션 엔진입니다.
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CBS 의 경우 장비단위의 로딩 시뮬레이션보다 심플하게 모델링이 가능한 장점을 가지고 있습
니다. 라인을 한개 혹은 몇개의 주요 자원집합으로 모델링하고 해당 자원집합에 Demand 를 
시간 순서에 따라 배치를 하는 방식으로 장비단위의 스케줄보다는 좀더 상위 레벨의 투입계획
이나 생산계획을 수립할때 사용하기 적당한 방식입니다. 또한, CBS 엔진은 Bucketing 을 통
한 Demand-자원 배정의 Heuristic 한 로직 개발방식과 Simulation 기법을 통합하여 시간의 
흐름에 따라 Demand 와 Capacity Bucket, 제약의 속성을 동적으로 변경하면서 Bucketing 
을 할 수 있음으로 기존의 Heuristic 방식만을 사용한 Planning 솔루션에 비해 모델링의 확장
성이 높다는 장점이 있습니다.

CBS 모델의 적용 가능 예

1. 투입계획 수립모델

문제 정의 : 라인별 제품의 일별 투입량을 결정해주어야 하는 문제

제약 :

각 제품별로는 기간별 투입 한계수량 제약이 있음

특정 제품의 경우 투입시 별도의 자재가 있어야 생산이 가능한 경우가 존재함

특정 제품의 경우 생산이 불가한 기간을 지정할 수 있음

2. Bucketing 을 통한 생산 스케줄 수립 모델 (Simple 한 Loading Simulation 과 같은 방식
으로 모델링 가능)

문제 정의 : 생산제품이 다수의 공정을 거쳐 생산되며, 생산공정별로 서로 다른 장비
(Resource)그룹에서 작업수행이 되는 공장에서 장비그룹별 생산계획을 수립하는 문
제

제약 :

각 제품별/공정에 기간별 생산한계수량 제약이 있을 수 있음

 제품의 특정 공정은 처리가 가능한 장비그룹정보가 없이 진행할 수 있음

제품별/공정별로 별도의 자재가 있어야 생산이 가능한 경우가 존재함

제품/공정별 생산 불가 기간을 지정할 수 있음

특정 공정 처리 전/후 작업물이 Split 될 수 있음

CBS 모듈 클래스 설명
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CBS 모듈을 사용하기 위한 클래스 구조는 아래의 그림과 같습니다.

CbsSolver

CBS 모듈의 Main Class 입니다. 시뮬레이션 시작부터 종료될때 까지의 전체 로직 제어
를 담당하며 생산라인에 대한 모델정보와 제약정보를 속성으로 가집니다.

CbsAllocator

Bucket Rolling 시에 생성되어 제품의 Allocation 전체를 제어하는 클래스입니다. 
Allocator 는 Rolling 시점마다 생성이 되며 해당 시점의 정보로 초기화 됩니다.

CbsAllocator 의 클래스 설명
CbsConstraintManager

Allocation 시에 사용될 각종 제약정보를 관리하는 클래스입니다. Constraint 의 정보를 
기반으로 초기화 및 Rolling 시점에 상태변경관리를 하거나 ConstraintSet 을 cache 에 
저장하여 검색속도를 개선하는 역할을 수행합니다.

CbsConstraintSet

동일한 제품유형에 적용되거나 유사한 특성을 가진 Constraint 의 묶음 클래스입니다.
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ICbsConstraint

제약 정보를 처리하기 위한 Interface 입니다.

CbsCapacityConstraint

일반적인 제약에 대한 기본 클래스로 주로 최대 생산가능 조건에 대한 제약입니다. 예를 
들어 특정 제품이나 제품그룹의 제품을 Bucket Cycle Time 동안 정해진 제약수량 이상 
생산/투입할 수 없도록 하는 제약 유형을 모델링할 때 사용할 수 있습니다.

CbsDateConstraint

특정 기간동안만 생산이 가능하나 해당 기간에 생산을 하지 못하도록 처리하기 위한 제약
입니다.

Cbs2thResourceConstraint

해당 제품의 생산을 위해 추가적으로 필요한 자원에 대한 제약입니다.

CbsLine

하나의 공장에 대한 데이터 모델입니다. Bucketing 을 독립적으로 실행하기 위한 최상위 
모델 클래스입니다. 초기화시에 CbsResource 의 Line 속성을 설정하면 자동으로 생성되
며, InitControl 을 통해 초기화시 커스터마이징을 할 수 있습니다. 라인별 제품의 혼류 생
산이 가능한 경우에는 실제 생산라인을 CbsLine 으로 모델링 하지 않고 Bucket 으로 처
리할 수 있습니다. CbsLine 은 한개 혹은 복수개의 CbsBucketStep 으로 구성될 수 있습
니다.

CbsBucketStep

Bucket 을 구성하는 공정그룹에 대한 모델입니다. 생산자원인 Capacity Bucket 인 
CbsBucket 정보를 가지고 Allocator 에 의해 Allocation 이 이루어지는 시점에 실제로 개
별 CbsBucketStep 단위로 Allocation 이 수행됩니다. Allocation 시점에 Preset 을 사용
하는 경우에는 WeightPreset 속성을 설정해야 하며 그렇지 않은 경우에는 Control 의 
Batch Sorting Action 의 로직에 따라 대상 Batch 가 소팅됩니다.

CbsBucket

Capacity 를 정의할 수 있는 Bucket 데이터 클래스입니다. 물리적인 생산자원을 모델링
하기 위한 클래스로 장비,장비그룹,생산라인 등을 하나의 Bucket 으로 모델링 할 수 있습
니다. 모델링 방식은 문제의 종류에 따라 다르게 적용할 수 있습니다. CbsResource 정보
에서 자동으로 생성됩니다.

CbsResource

CbsBucket 으로 구성하기 위한 자원의 정적 속성정보를 저장하고 CBS 모듈의 초기화를 
위한 데이터모델입니다. 주요속성은 아래와 같습니다. 초기화시에 사용자가 직접 생성해
주어야 합니다.
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Line : Bucket 을 포함하는 라인(CbsLine) 의 명칭입니다. 초기화시에 
CbsResource 리스트의 설정된 라인 이름으로 CbsLine 을 자동 생성합니다.

Name : Mapping 되는 CbsBucket 의 명칭입니다. CbsResource 에 설정된 Name 
속성으로 CbsBucket 을 자동 생성합니다.

Group : Bucket Group 의 명칭입니다. BucketGroup 단위로 Allocation 이 수행됩
니다. 실제로는 CbsBucketStep 과 Mapping 되는 속성입니다.

Step : CbsBucketStep 의 ID 로 사용됩니다. CbsBucketStep 은 Bucket 을 포함하
는 BucketGroup 이 됩니다.

CbsPlan

Allocation 대상이 되는 Demand 정보로 보통 work order (W/O) 혹은 purchase order 
(P/O) 단위의 정보로 생성합니다. CBS 모듈의 기본 Input 정보 입니다. Demand 를 위해 
Release 되는 Batch 를 포함합니다. 초기화시에 사용자가 직접 생성해주어야 합니다.

CbsBatch

CBS 모듈의 Entity Class 로 일반적으로 생산라인의 Lot 대응되는 시뮬레이션 모델입니
다. 초기화시에 CbsPlan 을 생성할때 함께 생성합니다. 사용자가 생성해야 합니다. 
CbsPlan 에 기본적인 Batch 생성함수를 제공하며, 필요시 사용자 환경에 맞도록 생성해
서 사용합니다.

CbsLoadInfo

작업물인 CbsBatch 의 작업계획 정보입니다. 가장 최근(마지막)의 계획정보는 LastPlan 
속성으로 참조할 수 있습니다.

CbsStep

제품(Product)의 Routing 을 구성하는 공정 데이터모델입니다. Simulation Engine 의 
Step 을 상속받아 구현된 모델로 BOP 를 구성하는 요소이며 Route 속성으로 해당 
Route 정보를 참조할 수 있습니다. 초기화시점에 사용자가 생성해주어야 합니다.

Route

제품의 Routing 정보 클래스입니다. CbsStep 의 집합을 속성으로 가집니다. 제품 생산을 
위해 여러 공정을 거치도록 모델링을 할 경우에는 Route 를 정보를 구성해야만 합니다. 
CbsBatch 는 Route 의 구성된 Step 순서에 따라 Step change 하면서 Simulation 을 수
행합니다. 초기 CbsPlan 을 생성할 때 Route 정보를 설정하면 CbsBatch 는 해당 Plan 
의 Route 속성을 가지도록 초기화 됩니다. 초기화시점에 Route 정보는 사용자가 생성해
주어야 합니다.
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CbsAgentManager

Cbs모듈에서 사용되는 CbsAgent를 관리하기 위한 클래스입니다. 사용자가 Agent 를 사
용할때는 Solver 의 AgentManager를 통해 배치를 등록해서 사용할 수 있습니다.

CbsAgent

Rolling 시점별로 실행될 Agent 로직을 처리하기 위한 클래스입니다. 사용자가 추가한 
Batch 들을 Agent 의 Stock 에 적재하고 있다가 Rolling 주기에 Stock 을 평가해서 
Release 할 Batch 를 결정하여 처리합니다. Agent 를 통해서 공정간 재고지점, 투입로직
의 처리, 출하를 위한 로직등을 처리할 수 있습니다.

StockInfo

Agent 에 적재되어 있는 재공(Batch) 를 Key 별로 저장하기 위한 클래스입니다.

CBS Solver

Cbs 모듈의 초기화 및 주요 모델이 되는 Bucket, Batch 및 Allocator 의 주요 로직을 커스터
마이징하기 위한 Control, Event 처리를 위한 FEComponent 의 집합입니다.
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Init

Cbs 모듈을 구성하는 Resource(Bucket) 와 Batch(CbsPlan) 을 생성합니다. 또한 
BucketGroup(BucketStep) 및 Bucket 등의 주요 객체의 초기화를 수행하며 Preset 정보를 
생성하여 등록합니다.

Bucket

Bucket Rolling 및 Allocation 가능한 시간에 대한 제어를 수행하기 위한 FEComponent 입니
다.

Batch

CbsBatch 및 BatchGroup을 제어하기 위한 FEComponent 입니다.

Control

Cbs Module 의 전체 제어를 수행하기 위한 FEComponent 입니다. Cbs 모듈에서 Allocation 
을 실행하는 것은 Allocator 객체에서 수행하게 되는데 Allocator 객체의 초기화 시점부터 
Rolling 이 시작, 종료까지의 모든 로직의 제어를 할 수 있도록 구성되어 있습니다.

Events
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Cbs Module 실행시 발생하는 Global 한 Event 시점(Day Change, Shift Change, ..)에 사용
자 정의 코드를 작성할 수 있도록 FEAction 을 제공합니다.

Cbs init 컨트롤

CBS 모듈의 구동을 위한 초기화 작업을 수행할 수 있는 FEComponent 입니다.

1. InitializeConstraints 
Module 에서 사용될 Constraint(ICbsConstraint) 들을 CbsConstraintManager 에 등록
합니다.

2. GetWeightPresets 
Module 에서 Weight Preset 을 사용하여 Batch 우선순위를 평가하는 경우 사용될 
Preset 정보를 만들어서 반환합니다.

3. GetBucketSteps 
Capacity 자원의 집합인 BucketStep을 직접 등록할 때 사용합니다. BucketStep을 생성
해서 반환하면 엔진에서 이를 등록합니다. 구현하지 않고 GetResoourceList 호출 시 장
비에 Group 명칭으로 등록하는 경우 자동 생성됩니다.
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4. GetResourceList 
필수 구현이 필요한 초기화 Action 입니다. CbsResource 를 생성해서 반환하면 
CbsResource 의 설정 값에 따라 CbsLine, CbsBucket, CbsBucketStep 등의 모델 객
체를 생성하고 초기화합니다.

5. InitializeBucket 
CbsBucket 이 생성된 직후 사용자가 초기화 로직을 추가할 수 있는 FEAction 입니다.

6. SelectBucketStepPreset 
BucketStep 의 Allocation 시 Batch Sorting 에 사용될 Preset 정보가 복수개인 경우 이
중에 사용할 Preset 을 선택하도록 합니다. BucketStep 의 사용가능한 Preset 은 
BucketStep 초기화 시점에 직접 할당된 Preset 혹은 Bucket(CbsResource) 에 할당된 
Preset 입니다.

7. InitializeBucketStep 
CbsBucketStep 이 생성된 직후 사용자가 초기화 로직을 추가할 수 있는 FEAction 입니
다.

8. GetPlanList 
필수 구현이 필요한 초기화 Action 입니다. Cbs 모듈의 Input 이 되는 Demand 리스트를 
반환해야 합니다. Demand List 를 넘겨주면 라이브러리에서 CbsPlan 과 CbsBatch 를 
생성하여 Allocation을 할 수 있도록 초기화합니다.

9. InitializeLine 
CbsLine 의 추가적인 초기화 로직을 추가할 수 있는 FEAction 입니다.

10. GetLoadableBucketGroupList 
필수 구현이 필요한 초기화 Action 입니다. 각 Plan 의 Route 상에서 Allocate 되어야 할 
모든 BucketStep(BucketGroup)의 명칭 리스트를 반환하는 FEAction 입니다.

11. OnNotFoundResource 
GetLoadableBucketGroupList 에서 반환된 BucketGroup 중 등록되지 않은 
BucketGroup(자원그룹)이 있는 경우 호출됩니다. Argument 는 미등록된 BucketGroup 
의 명칭입니다. 이 함수가 호출되는 경우에는 해당 BucketGroup을 사용하도록 설정된 
Plan 의 경우 할당이 완료될 수 없습니다.

12. OnCompensate 
시뮬레이션 초기 시점이 Bucket Rolling 시점과 일치하지 않는 경우 호출됩니다. 초기화
시에 Constraint 별 잔여 Capacity 를 시간 비율에 따라 보정합니다. 예를 들어 Plan 시작 
시점이 Rolling 구간의 80% 지난 시간일 경우 Capacity의 80% 를 사용한 것으로 자동으
로 처리하고, 이 시점에 본 함수가 호출됩니다. 사용자는 Compensation 로직을 커스텀으
로 수정할 수 있습니다. 모든 Constraint 의 정보를 가진 CbsConstraintManager 가 있으
며, 현재시각, 차감 비율을 받아 사용자가 필요한 데이터를 업데이트합니다.
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CbsBucket 컨트롤

Bucket Rolling 및 Allocation 가능한 시간에 대한 제어를 위한 FEComponent 입니다.

1. GetNonWorkingTimes : CbsBucket 의 초기화 시점에 Plan 전 주기동안 자원에서 제
약으로 처리할 비가동시간 정보를 설정합니다.

2. OnBeginRolling : Bucket 에서 Rolling은 Bucket Capacity가 Reset되는 걸 의미합니
다. OnBeginRolling 이벤트는 Reset 시작 시점에 호출됩니다.

3. AdjustNonWorkingTimeBeforeAllocation : 매번 Rolling 시점별로 모든 Bucket의 
가용시간을 업데이트 합니다. 본 함수는 Bucket의 가용시간 업데이트 전 해당 Rolling 구
간에서 반영되어야 할 비가동 시간을 설정하기 위해 사용합니다. 즉, 특정 Bucket에 대해 
매일 Rolling을 한다고 할 때, 할당을 시작하기 전에 해당 일의 비가동시간을 사용자가 지
정하여 반환합니다. CbsPeriodSection 리스트에 해당 주기의 값을 추가하는 방식으로 구
현합니다.

4. WriteNonWorkingTime : NonWorkingTime 발생 시점에 호출되며 필요시 
NonWorkingTime 에 대한 사유 등의 로그를 기록할 수 있습니다.

5. OnEndRolling : Bucket 의 Rolling 을 모두 마친 시점에 호출됩니다.
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6. AdjustNonWorkingTimesDuringAllocation : Bucket 의 NonWorkingTime과 작업
대상의 작업시간이 겹쳐지는 경우 호출됩니다. 사용자는 이 Action 을 통해 
NonWorkingTime 과 Setup 및 작업시간이 중첩되는 경우 이를 Custom 로직으로 수정
할 수 있습니다. 작업을 수행할 때 Setup 이 발생하면 Setup End 시각과 Non working 
time 이 겹칠 때 Setup 을 Non working time 에 포함시켜 처리하거나 Setup 시간에 Non 
working time 을 포함해서 처리하는 등의 작업을 수행할 수 있습니다.

7. WriteSetupLog : Setup이 발생되는 시점에 호출되며, Setup 로그를 기록할 수 있습니
다.

Cbs Control 컨트롤

Cbs Module 의 모든 제어로직을 구현할 수 있도록 구성된 FEComponent 입니다.

1. GetBucketCycleTime : 다음 Rolling Event 시간을 설정합니다. Bucketing Rolling 주
기를 동적으로 변경할 때 사용하며, 기본적으로는 Cbs Configuration 에서 설정된 
Bucket Cycle Time 을 사용합니다.

Default Code Sample
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 public Time GET_BUCKET_CYCLE_TIME_DEF(DateTime now, Time cycleTime, ref bool handle
d, Time prevReturnValue) 
 { 
     return cycleTime; 
 }

2. GetNextWorkingStartTime : GetBucketCycleTime과 유사한 기능으로 다음 Rolling 
시작지점을 지정할 수 있습니다.

3. ConstraintRolling : Rolling 이 시작될때 ConstraintManager 에 등록된 모든 
Constraint 의 Capacity 등 설정값의 변경을 수행하기 위한 FEAction 입니다.

Default Code Sample

 public void CONSTRAINT_ROLLING_DEF(CbsCapacityConstraint cb, DateTime now, bool atB
oundary, bool atDayChanged, ref bool handled) 
 { 
     if (cb is CbsDummyConstraint) 
         return; 
     if (atBoundary) 
     { 
         //cb.PreviousQty = 0; 
         cb.CumulatedQty = 0; 
         cb.MoveQty = 0; 
     } 
     else 
     { 
         cb.PreviousQty = cb.MoveQty; 
         cb.CumulatedQty += cb.MoveQty; 
         cb.MoveQty = 0; 
     } 
 }

4. CanOperation : CbsLine 에 포함된 BucketStep 별로 대상 Allocation 주기에 
Allocation 여부를 판별합니다. 기본값은 true 이며, false 값을 반환하는 경우 해당 
BucketStep 이 해당 주기에 Allocation 을 하지 않습니다.

5. CompareBucketStep : 여러개의 Bucket Setp 이 등록된 경우 Allocation 순서를 설정
하기 위한 Comparer 를 구현합니다. 기본으로 CbsBucketStep 생성시에 설정된 Priority 
의 오름차순에 따라 Allocation 을 실행합니다.

Default Code Sample

 public int COMPARE_BUCKET_STEP_DEF(CbsBucketStep x, CbsBucketStep y, ref bool handl
ed, int prevReturnValue) 
 { 
     if (object.ReferenceEquals(x, y)) 
         return 0; 
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     int cmp = x.Priority.CompareTo(y.Priority); 
     if (cmp == 0) 
         cmp = x.Name.CompareTo(y.Name); 
     return cmp; 
 }

6. PrepareAllocation : 특정 BucketStep 의 Allocation 이 시작되기 직전에 호출됩니다.

7. CanAllocation : 특정 Batch 가 특정 시점에 Allocation 가능 한지 여부를 판별합니다. 
Rolling 시점에 Allocator 에서 Allocate 대상 Batch 를 집계하는데 사용됩니다.

8. InitAllocation : Allocation 시작 전 초기화 수행이 필요한 로직을 개발하기 위해 사용되
는 FEAction 입니다.

9. ShoudSplitBatchAfterAllocation : 모든 BucketStep 들의 Allocation 이 끝나고 남은 
Batch (작업물)이 분리가 되어야 하는지 여부를 판별합니다. 특정 공정이 끝나고 작업물을
분리할 필요가 있는 경우 이 Action 을 사용하여 로직을 구현합니다.

10. SplitBatchAfterAllocation : ShoudSplitBatchAferAllocation 의 값이 true 인 기존의 
Batch 의 속성을 변경하고 분리된 신규 Batch 를 생성해서 반환하도록 로직을 구현합니
다.

Main Control logic 에서 CbsBucketStep 이 결정되고 해당 Step을 처리해야 하는 Batch 가 
추출된 상태에서 아래의 두가지 Routine 에 따라 선별적으로 작업물을 할당 할 수 있습니다. 
CbsBucketStep.BucketFirstSelection 속성 값에 따라 실행 방법이 변경되며, 기본 Routine 
은 Alloc 입니다.

Alloc
작업물의 우선순위를 먼저 평가한 후 Bucket 순서에 따라 가용한 Bucket 에 Allocate 하는 방
식입니다. 작업물이 Resource 를 선택하는 방식(Push)으로 Plan을 생성합니다.
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AllocBfs
Bucket 을 먼저 선택한 후 해당 Bucket 에 로딩이 가능한 Batch 중에 우선순위와 제약을 고려
하여 순차적으로 할당하는 방식입니다. Resource(장비)입장에서 작업물을 선택하는(Pull) 방
식으로 Plan 을 생성합니다.
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CompareBucket : Allocation 대상 Bucket 의 우선순위를 결정하기 위해 Comparer 를 
구현합니다.

Default Code Sample

  public int COMPARE_BUCKET_DEF(CbsCompareInfo info, CbsBucket x, CbsBucket y, ref b
ool handled, int prevReturnValue) 
  { 
      if (object.ReferenceEquals(x, y)) 
          return 0; 
     
      return CompareBucketDef(x, y); 
  }

CompareBatch : Allocation 대상 Batch(재공)의 Allocation 우선순위를 결정하기 위해 
Comparer 를 구현합니다.

Default Code Sample

  public int COMPARE_BATCH_DEF(CbsCompareInfo info, CbsBatch x, CbsBatch y, ref bool 
handled, int prevReturnValue) 
  { 
      if (object.ReferenceEquals(x, y)) 
          return 0; 
      if (info!= null && info.WeightEval != null) 
          return CompareByWeightSum(x, y); 



MOZART IDE (ENG) 378

      return CompareBatchDef(x, y); 
  }

BerforeAllocation : Allocation 직전에 호출되는 FEAction 입니다.

FilterBatch : 평가대상 Batch 를 Allocation 대상에서 제외할 지 평가합니다. false 인경
우 해당 배치는 Allocation 되지 않습니다. Bucket 에 상관없이 Filtering 됩니다.

RequireSortedBucketByBatch : 기본적인 Bucket 간의 우선순위를 사용하지 않고, 
Batch 별로 할당할 Bucket 의 우선순위를 결정할 필요가 있는 경우 true 를 반환합니다. 
true 를 반환하는 경우 등록된 CompareBucket Action 을 통해 Bucket 리스트가 재정렬
됩니다.

FilterBucketByBatch : 특정 Batch에서 사용할 수 있는 Bucket 을 다시 반환합니다. 별
도의 구현이 없는 경우 Allocation 가능한 모든 Bucket 을 반환합니다.

PreAllocable : 특정 Bucket 에서 대상 Batch 를 Allocation 할수 있는지 여부를 판별합
니다. Resource 의 시간별 제약이나 Second Resource 와 같은 제약에 의해 Allocation 
이 가능한지 여부를 판별하도록 로직을 구성할 수 있습니다.

Default Code Sample

  public bool PRE_ALLOCABLE_DEF(CbsAllocator allocator, CbsBucket bucket, CbsBatch b
atch, DateTime nowDt, ref bool handled, bool prevReturnValue) 
  { 
      return bucket.CurrentTime >= batch.LastStepTime; 
  }

NeedsTobeSetup : Setup 필요여부를 판별하기 위해 사용되는 FEAction입니다.

GetCapacityUsage : Batch를 구성하는 작업물 한 Unit 이 점유하는 Capacity 의 량을 
지정합니다.

Default Code Sample

  public double GET_CAPACITY_USAGE_DEF(CbsBatch batch, CbsBucket bucket, ref bool ha
ndled, double prevReturnValue) 
  { 
      return batch.CurrentStep.DefaultCapacityUsage; 
  }

GetConstraintSetKey : Batch 에 적용되는 제약집합의 Key 를 반환하도록 구현합니
다. 이미 등록된 Set 의 경우 Constraints 를 매번 검색하지 않고 Cache 에 저장해두고 사
용하여 속도를 개선할 수 있습니다.

GetConstraints : Batch 에 적용되는 제약집합을 반환합니다.
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CanConstraintMove : 평가 대상 Batch 가 개별 제약을 만족하는지 여부를 판별합니다. 
기본적으로 Constraint 의 유형에 기본 로직이 구현되어 있으나 추가적인 로직이나 사용
자가 정의한 Constraint 에 대해 이를 구현할 수 있습니다.

Default Code Sample

  public bool CAN_CONSTRAINT_MOVE_DEF(CbsCapacityConstraint constraint, CbsBatch hb, 
ref double qty, DateTime now, CbsBucket bucket, ref DateTime? releaseTime, ref bool
 handled, bool prevReturnValue) 
  { 
      if (constraint is CbsDummyConstraint) 
          return true; 
      return constraint.CanMove(now, ref qty); 
  }

WriteCheckConstraintLog : 평가 대상 Batch 가 제약을 모두 평가한 이후에 호출됩니
다. 평가결과 Allocation 실패한 경우 실패사유를 기록하거나 성공한 경우에도 로그를 남
기기 위해 사용할 수 있는 FEAction 입니다.

AdjustAllocateQty : 평가대상 Batch 가 Bucket Capacity 및 제약을 모두 만족하는 경
우에도 실제 Allocation 가능한 수량을 결정할 필요가 있는 경우 이러한 로직을 구현하기 
위한 FEAction 입니다. 예를 들어 Batch 가 500개의 Unit 작업물로 구성된 경우에 한 
Batch 에서는 특정 Bucket 에 100개이상을 Allocation 할 수 없다는 제약과 같이 동일 
Batch 내에서 Allocation 수량을 결정하는 Rule 이 있는 경우 이러한 Rule 을 구현할 수 
있습니다.

PostAllocate : Batch 가 Allocation 될 것으로 결정된 직후에 호출되는 FEAction 입니
다.

NeedsTobeSetup : Batch 가 할당될 때 Setup 이 필요한지 여부를 반환하며, Setup 이 
필요한 경우 Setup 시간을 고려해서 Setup 완료시간을 설정해야 합니다.

GetFlowTime : Batch 가 실제 Bucket 에 Allocation 될때 해당 Bucket 에서 
Processing 되는 시간 정보를 반환합니다. 구현을 하지 않으면 Bucket Cycle Time / 
Bucket Capacity 만큼의 시간이 자동 반환됩니다. 한 제품이 여러개의 Step 을 통해 작업
이 완료되는 경우에 공정별 계획을 수립할때 공정의 선후조건과 계획시간을 업데이트하기 
위해 필요합니다.

GetNextBucketAllocableTime : 특정 Batch가 할당되는 시점에 할당된 Bucket의 다
음 할당 가능한 시점을 설정합니다. 해당 FEAction에서 반환된 시간으로 Bucket의 
CurrentTime 정보가 재설정됩니다.

Default Code Sample

  public DateTime GET_NEXT_BUCKET_ALLOCABLE_TIME_DEF(CbsBucket bucket, CbsBatch batc
h, DateTime startTime, double qty, double usage, ref bool handled, DateTime prevRetu
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rnValue) 
  { 
      return startTime.AddSeconds(bucket.TimeUnit * qty * usage); 
  }

GetNextBatchAllocableTime : 특정 Batch가 할당되는 시점에 할당 대상 Batch가 다
음 공정 할당 가능한 시각을 설정하기 위해 사용되는 FEAction입니다. 해당 FEAction에
서 반환된 시간은 Batch의 LastStepTime을 재설정합니다.

Default Code Sample

  public DateTime GET_NEXT_BATCH_ALLOCABLE_TIME_DEF(CbsBucket bucket, CbsBatch batc
h, DateTime startTime, DateTime nextBucketAllocableTime, double qty, double usage, T
ime flowTime, ref bool handled, DateTime prevReturnValue) 
  { 
      return nextBucketAllocableTime.AddSeconds(flowTime.TotalSeconds); 
  }

OnBatchAllocated : 대상 Batch 가 특정 Bucket 에 할당되고 Batch 의 PlanInfo 와 
Bucket 의 상태가 모두 업데이트된 시점에 호출됩니다. 일반적으로 이 시점에 Bucket 의 
Allocation 이력을 기록하는 로직을 개발합니다.

AddConstraintMove : Batch 가 할당된 경우 해당 Batch 의 소요량만큼 모든 제약의 설
정된 Capacity 를 차감해야 합니다. 기본로직에서는 할당된 Unit 수량 * CapacityUsage 
에서 설정된 양의 Capacity 를 차감하도록 구현되어 있습니다. Constraint 별 속성을 다르
게 업데이트할 필요가 있을 경우 사용자 로직을 구현합니다.

Default Code Sample

  public void ADD_CONSTRAINT_MOVE_DEF(CbsCapacityConstraint constraint, CbsBatch hb, 
double qty, CbsBucket bucket, ref bool handled) 
  { 
      if (constraint is CbsDummyConstraint) 
          return; 
      constraint.AddMove(qty); 
  }

SplitBatchDuringAllocation : Allocation 이 끝난 이후 잔여량이나 특정 Rule 에 따라 
Batch 를 Split 해야 하는 경우 Split 된 Batch 를 생성하여 반환합니다.

ShouldSortBatchAfterAllocation : 만일 한 Batch 를 할당 한 후 각 Batch, Plan, 
Bucket 의 상태에 따라 할당 대상이 되는 Batch 들의 우선순위 재평가가 필요한 경우에는 
본 FEAction 에 true 를 반환합니다. 이경우에 대상 Batch List 는 등록된 
CompareBatchMethod 나 Preset 에 따라 다시 소팅됩니다.
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StopTheAllocationStepAtFail : 특정 Batch 가 Allocation 에 실패한 경우 순서상 이후 
Batch 에 대해 더이상 Allocation 을 진행하지 않고 종료할지 여부를 판단합니다. true 를 
반환하는 경우 Allocator 의 Batch 중 해당 Batch 이후 우선순위를 가지는 Batch는 
Allocation 하지 않습니다.

AfterAllocation : 모든 Batch 의 Allocation 이 끝난 후 호출됩니다. Bucket 에 더이상 
Allocation 된 Batch 가 없을 때 Allocation 이 종료됩니다.

Cbs Batch 컨트롤

CbsBatch 및 BatchGroup을 제어하기 위한 FEComponent 입니다.           

1. GetBatchGroupKey : 동일 작업조건(동일제품)의 Batch 가 수량이 많아 비교대상 배치
수량 증가로 속도에 영향을 미치는 경우 동일 작업조건의 작업물을 하나의 BatchGroup 
으로 묶어 BatchGroup 단위의 평가를 통해 수행속도를 개선할 수 있습니다. 본 Action 은 
Batch 가 BucketStep 에 추가되는 시점에 함께 묶일 BatchGroup 의 Key 를 반환하는 
함수입니다. 결과값을 반환하면 동일한 Key 값을 가지는 Batch 들을 해당 Key 값을 가지
는 BatchGroup 으로 묶어서 하나의 Batch 처럼 처리합니다. Key 값을 반환하지 않으면 
BatchGroup 으로 묶지 않습니다.
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2. GetGroupInPreset : BatchGroup 이 생성되는 시점에 해당 BatchGroup 내에서 사용
될 Batch 간 평가를 위한 Preset ID 를 반환합니다. 결과값을 반환하지 않는 경우에는 
Group 내의 Batch 들은 CompareBatchGroupIn 에서 구현된 함수에 따라 소팅합니다. 
실제 사용을 위해서는 Preset 이 사전에 등록되어 있어야 함(Preset 은 
Init/GetWeightPresets Action 을 통해 등록합니다. )

3. GetGropuInSelectionType : BatchGroup 내의 Batch 들 간의 우선순위를 어떻게 평
가할 것인지에 대한 타입 값입니다. 반환 타입은 Mozart.Seeplan.Cbsim.SelectionType 
= {Custom, WeightSorted, WeightSum} 값입니다. Custom 을 선택하는 경우 
CompareBatchGroupIn 함수를 사용합니다. WeightSorted, WeightSum 을 선택하는 
경우 GetGroupInPreset 에서 사용할 Preset ID 를 반환해야 합니다. WeightSorted 는 
Preset 을 사용하여 순차 소팅 방식으로 Batch 를 평가하여 소팅합니다. WeightSum 을 
선택하는 경우 설정된 Preset을 사용하여 가중합 방식으로 정렬합니다.

4. CompareBatchGroupIn : Group의 SelectionType = Custom 인 경우에 사용되는 소
팅 로직을 구현합니다.

Default Code Sample

 public int COMPARE_BATCH_GROUPIN_DEF(CbsBatchGroup bgroup, ICbsBatch x, ICbsBatch
 y, ref bool handled, int prevReturnValue) 
 { 
     if (object.ReferenceEquals(x, y)) 
         return 0; 
     int cmp = x.Sample.LastStepTime.CompareTo(y.Sample.LastStepTime); 
     if (cmp == 0) 
         cmp = x.Sample.LotID.CompareTo(y.Sample.LotID); 
     return cmp; 
 }

5. GetBatchGroupAllocateQty : BatchGroup 내에서 특정 Rolling 시점에 Allocation 가
능한 수량을 지정합니다. Batch가 추가될 때마다 호출되어 수량을 다시 지정할 수 있습니
다. 해당 그룹에서 1회 Rolling 시점에 Allocation 가능한 최대 수량입니다. 만일 
IsStopAllocateGroupIn 함수에서 true 값을 반환하지 않고 Bucket 의 Capacity 가 충분
한 경우 해당 그룹에서는 설정된 수량만큼 Allocation 됩니다.

6. IsStopAllocateGropuIn : 동일 BatchGroup 내의 우선순위 Batch 가 Allocation 된 직
후 호출됩니다. true 값을 반환하면 GetBatchGroupAllocateQty 에서 설정된 수량 이하
로 할당된 경우라도 해당 Group 에서 더 이상 Allocation 할 Batch 를 선택하지 않고 해당 
BatchGroup 의 할당을 종료합니다.

7. OnBatchEndStep : Batch 가 특정 Step 을 완료하는 시점에 호출되는 Event 함수입니
다.
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8. IsProcessMoveNext : Batch 가 특정 Step 을 끝낸 후 다음 Step 으로 진행할지 여부를 
반환합니다. 기본 값은 true 입니다. 만일 false를 반환하는 경우 Batch 는 다음 공정으로 
이동하지 않고 동일한 Step 을 반복적으로 Allocation 하게 됩니다. Flow 상의 여러 공정
이 실제 해당 공정들을 처리하는 장비그룹(BucketStep)이 같은 경우 공정처리를 반복적
으로 할 수 있습니다.

9. GetNextStep : Batch 의 현재 Step 이후 처리해야 할 공정을 반환합니다. 이 함수를 통
해 제품별로 Skip 로직을 처리할 수 있습니다.

Default Code Sample

 public CbsStep GET_NEXT_STEP_DEF(ICbsBatch batch, CbsLoadInfo loadInfo, CbsStep ste
p, ref bool handled, CbsStep prevReturnValue) 
 { 
     var next = (CbsStep)step.GetDefaultNextStep(); 
     return next; 
 }

10. IsBatchFinished : Batch 의 현재 공정이 완료공정인지 여부를 반환합니다. 현공정의 완
료 시점에 판단하여 Batch 를 최종 완료 처리합니다.

11. GetBucketStepKey : 제품의 생산 Flow 상의 공정과 공정을 처리하는 
BucketStep(BucketGroup)의 명칭이 다른 경우 특정 Step 을 처리할 자원그룹
(BucketStep)의 명칭(Key)을 반환하여 해당 공정으로 이동할 수 있도록 처리합니다.

12. OnBatchNextStep : GetNextStep 에서 반환된 Step 정보로 이동한 직후 호출되는 
Event 함수입니다.

13. OnBatchFinished : Batch 가 모든 공정을 완료 처리한 시점에 호출되는 Event 함수입
니다.

«Batch와 BatchGroup의 관계»
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«BatchGroup의 할당 절차»
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Cbs Events 컨트롤

Cbs Module 실행시 발생하는 Global 한 Event 시점(Day Change, Shift Change, ..)에 사용
자 정의 코드를 작성할 수 있도록 FEAction 을 제공합니다.

OnBegineInitialize : Cbs Module 의 초기화 로직 시작전에 호출됩니다.

OnEndInitialize : Cbs Module 의 초기화 로직이 모두 처리된 직후에 호출됩니다.

OnStart : Cbs 엔진이 시작하는 시점에 호출됩니다. 초기화는 모두 끝난 상태입니다.

OnBeginLineAllocation : Line 별 Allocation 시작시점에 호출되는 Event 함수입니다. 
대부분의 경우 CbsLine을 1개로 설정하게 됨으로 전체 Allocation이 시작되는 시점에 한
번 호출되는 것이 일반적입니다. 만일 복수개의 CbsLine으로 구성을 하는 경우 Line 별 
Allocation 시작시점에 호출됩니다. Allocation은 Rolling 횟수만큼 수행됩니다. 즉 일단위 
Cycle로 7일을 수행하면 Line 단위 Allocation이 총 7번 실행됨으로 본 함수는 매일 
Allocation 시작되는 시점에 7번 호출되게 됩니다.

OnBeginBucketStepAllocation : BucketStep의 매 할당 시작전에 호출되는 Event 함
수입니다.
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OnEndBucketStepAllocation : BucketStep의 매 할당 종료시점에 호출되는 Event 
함수입니다.

OnEndLineAllocation : Line 별 Allocation 종료시점에 호출되는 Event 함수입니다.

OnBeginRolling : Rolling 시작시점에 호출되는 Event 함수입니다. Rolling의 의미는 
한 Bucket 구간의 할당이 모두 끝난 후 Bucket과 Constraint의 Capacity를 Reset 하는 
작업을 의미합니다.

OnEndRolling : Rolling 종료시점에 호출되는 Event 함수입니다.

OnDone : Cbs 엔진이 수행을 모두 마치고 종료하는 시점에 호출됩니다.

CompareSameTimeEvent : 같은 시간에 발생하는 이벤트들이 있을 때 우선순위를 설
정하기 위한 FEAction입니다. 매 이벤트가 선택되는 시점마다 호출이됩니다.

«이벤트 순서»

CBS Agent
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CbsAgent 의 제어를 위한 FEComponent 그룹입니다.

AgentInit

CbsModule 에서 사용할 Agent 를 생성하고 초기화하기 위한 FEComponent 입니다.

AgentRun

Agent 의 실행을 제어하기 위한 FEComponent 입니다.

Cbs Agent Init 컨트롤

CbsModule 에서 사용할 Agent 를 생성하고 초기화하기 위한 FEComponent 입니다.

1. GetAgentIDList : Cbs 모듈에서 사용할 Agent 의 ID 리스트를 반환합니다. 리스트의 항
목별로 Agent 를 생성합니다. Agent 의 생성부터 실행에 대한 제어는 CbsAgentControl 
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을 통해 수행가능합니다.

2. InitializeAgent : Agent 생성 직후 호출됩니다. Agent 에 설정할 기본적인 속성을 정의
할 수 있습니다.

3. OnInitialzedAgent : Agent 생성 이후 모듈에서 Allocation 대상이 되는 작업물(Batch)
를 초기화 한 이후에 호출됩니다. 이때에는 Agent 에 초기 Batch 가 추가된 상태입니다.

Cbs Agent Run 컨트롤

Cbs 모듈을 실행시 자원그룹인 BucketStep 의 전, 후에 공정(CbsStep, BucketStep)과 독립
적으로 재공(Batch)를 적재하고 Release 할 수 있도록 구성된 Agent 로직을 제어하기 위한 
Component 입니다.

1. GetAgentID : CbsAgentManager 에 배치를 등록하는 시점에 배치를 저장하기 위한 
Agent ID 반환하는 FEAction 입니다. 배치를 Agent 에 추가하는 것은 사용자가 
CbsModule 의 초기화 시점에 직접 처리해야 합니다. 일반적으로 Batch를 초기화하는 시
점에 특별한 작업을 하지 않는 경우 모든 Batch는 초기 Step 을 처리하기 위한 
BucketStep 에 등록이 되지만, Agent 를 사용해서 투입의사결정이나 공정간의 재고를 모
델링하기 위해서는 Agent 에 추가하는 방식을 사용합니다.
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2. GetBatchKey : Agent 에 등록되는 Batch 가 등록되는 시점에 batch 를 그룹핑하여 저
장하기 위한 Key 입니다. Agent 에 Key 별로 Stock 을 구성해서 batch 를 저장하고 있습
니다.

3. CanAgentRun : Rolling 시점에 등록된 Agent 별로 실행 여부를 반환합니다. false 를 
반환하는 경우 해당 Rolling 구간에서 지정된 Agent 로직은 수행하지 않습니다.

4. OnStartAgent : Agent 가 최초 Run 을 수행하는 시점에 한번 호출 됩니다.

5. OnBeforeRun : Agent 수행시점(Rolling)마다 호출되며, Agent의 주요 로직 실행 전에 
호출됩니다.

6. OnRun : Agent 수행 Main 로직을 구현하기 위한 FEAction 입니다. 본 Action 에 구현부
가 없는 경우 Agent 는 아무일도 수행하지 않습니다.

7. OnAfterRun : Agent 로직 수행 직후에 호출됩니다.




